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Інструкція для виконання лабораторної роботи №1 
 

Тема: Основи роботи в AdobeIllustrator 

1 Мета: Знайомство з основними геометричними примітивами 

(прямокутник, овал, зірка, багатокутник і т.д.), представленими в 

AdobeIllustrator, їх основними властивостями. Виконання різних дій над ними 

(трансформація, поворот, угруповання і т.д.), а також застосування різних 

ефектів. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма AdobeIllustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

 

Завдання №1 СЕРВЕТКА 

1. Створіть новий документ (Файл - Новий). 

2. Перейдіть лінії сітки (Перегляд - Показати сітку). 

3. Виберіть на панелі інструментів  (Прямокутник). 

4. Клацніть лівою кнопкою миші по робочому полю і, не відпускаючи кнопку 

миші, намалюйте прямокутник довільного розміру (продовжуйте утримувати 

кнопку миші!), Натисніть <~> і проведіть мишкою по діагоналі вліво вгору, 

так, щоб у Вас вийшов приблизно такий же малюнок як на Рис.1. 

 

 
Рис. 1 

5. Зніміть виділення. Для цього виберіть інструмент (Вибір) і клацніть в 

будь-якому вільному місці робочого простору. 

6. Тепер перед Вами фігура, що складається з великої кількості 

прямокутників - кожен з яких можна переміщати, видаляти, змінювати 

параметри і т.д. Для того, щоб всі ці прямокутники можна було змінювати 

одночасно, необхідно їх згрупувати. Для цього (при активному інструменті 

(Вибір)) клацніть лівою кнопкою миші по вільному місцю близько 

прямокутника і сформуйте область виділення навколо фігури - у вас повинно 

вийти зображення, як на рис.1. Клацніть на виділеній фігурі правою кнопкою 

миші і з контекстного меню виберіть (Групувати). 

7. Скопіюйте отриману фігуру (Редагування - Копіювати). 

8. Вставте вміст буфера обміну (Редагування - Вставити). 



9. Повернемо нашу фігуру горизонтально. Для цього клацнемо на виділеній 

фігурі правою кнопкою миші і виберіть (Трансформувати - Поворот - 

Горизонтально). Натисніть кнопку ОК. (Рис. 2). 

 

 

 

 

 

 

 

Рис. 2 

10. Перемістіть фігуру так, щоб вийшов наступний малюнок. 

 
Рис. 3 

11. Виділіть за допомогою інструмента (Вибір) обидві фігури. Скопіюйте їх 

(Редагування - Копіювати). Вставте з буфера обміну (Редагування - 

Вставити). Не знімаючи виділення, відобразіть отримані фігури вертикально 

(Трансформувати - Поворот - Вертикально). Перемістіть фігури так, як 

показано на Рис.4. 

 

 

 

 

 

 

 

Рис. 4 

12. Розмалюємо серветку різними кольорами: для цього скористаємося 

панеллю (Параметри) (Рис.5) (не забувайте виділяти той об'єкт, параметри 

якого хочете змінити!). 

 
 

Рис. 5 

13. Не забувайте! Для отримання додаткових палітр кольорів необхідно 

натиснути на кнопку меню (на прикладі кольору меж) (рис.6). 

 
Рис.6 
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14. У результаті у Вас повинно вийти приблизно так: 

 
Рис.7 

15. Збережіть зображення Salfetki.ai. 

16. Для отримання «дизайнерської серветки» виконайте наступні дії: 

• Виділіть всі 4 елементи за допомогою інструмента (Вибір). 

• розгрупуйте їх. Клацніть правою кнопкою миші по виділеному і виберіть 

(Розгрупувати). 

• Виберіть пункт меню (Ефект - Перетворити фігуру - Еліпс) (. Рис 8). 

 

 
Рис.8 

17. Збережіть зміни під ім'ям Серветка 1.аі. 

Завдання №2 БАБОЧКА 

1. Створіть новий документ (Файл -Новий). 

2. Перейдіть лінії сітки (Перегляд - Показати сітку). 

3. Виберіть на панелі інструментів  (Прямокутник) і намалюйте квадрат 

(утримуючи клавішу <Shift>). 

4. Виберіть інструмент (Прямий вибір)  

Обведіть правий нижній вузол і пересуньте його так, як показано на Рис.9. 

 
Рис.9 

5. Виберіть команду меню (ЕФЕКТ - Спотворення і трансформація - 

Втягування і роздуття). Встановіть значення рівне 98% (Рис. 10). 

 



 
Рис.10 

6. Залійте крило метелика кольоровим градієнтом.  

7. Скопіюйте Вийшла крило (Редагування - Копіювати). 

8. Вставте вміст буфера обміну (Редагування - Вставити). 

9. Не знімаючівіділення, відобразіть крило горизонтально. Для цього 

клацніть правою кнопкою міші и віберіть (Трансформуваті - Поворот - 

Горизонтально) (рис.11). 

 
Рис.11 

10. Активуйте інструмент (Прямий вибір) . За допомогою маркерів 

перемістіть і розгорніть фігуру так як показано на малюнку 12. 

 
Рис.12 

11. Збережіть отримане зображення під ім'ям Бабочка.аі. 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має 

ознайомитись з основними геометричними примітивами (прямокутник, овал, 

зірка, багатокутник і т.д.), представленими в Adobe Illustrator CS2, їх 

основними властивостями. Навчитися виконувати  різні дії над ними 

(трансформація, поворот, угруповання і т.д.), а також застосовувати різні 

ефекти. 

 

 

 

 

 

 

 



6 Контрольні запитання 

6.1 Призначення панелей інструментів, стандартної, властивостей та інших. 

6.2 Налаштовування лінійок, сітки. 

6.3 Режими формування ліній (кривих та прямих). 

6.4 Створення найпростіших об’єктів та робота з ними. 

6.5 Зміна форми об’єктів за допомогою вузлів. 

6.6 Розрізання об’єктів. 

6.7 Витирання об’єктів. 
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Інструкція для виконання лабораторної роботи №2 
 

Тема: Створювання градієнтного переходу 

1 Мета: Здобути   навики   створення   переходів   і   використання   

режимів   їх застосування. 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Illustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

За допомогою інструмента Gradient (градієнт) і панелі градієнтів, яку 

активують командою Window/Gradient (градієнт), можна створювати, 

змінювати та застосовувати градієнти. Градієнтні кольори визначаються 

набором вузлів уздовж повзунка градієнта. Вузол градієнта – це точка, у 

якій градієнт переходить з одного кольору у інший. Вузол визначається 

відтінком кольору квадрата під повзунком градієнта. Для радіального 

градієнта крайній лівий вузол визначає колір заповнення центральної  точки.  

Зі  зміщенням  від  центра  назовні  градієнтний  перехід відбувається  до  

кольору  крайнього  правого  вузла.  За  допомогою  інструмента Gradient 

(градієнт) і панелі градієнтів можна вказати кількість і місце розташування 

вузлів, кут сектора, у якому відображаються кольори, ексцентриситет 

еліптичного градієнта та непрозорість кожного кольору. 

За замовчуванням на панелі відображається смуга початкового та кінцевого 

кольору. Клікаючи у різних точках на повзунку градієнта, можна додавати 

до панелі інші відтінки кольорів. Двічі клікнувши на вузол градієнта, можна 

відкрити панель кольору цього вузла, у якій можна вибрати колір за 

допомогою панелі Color (колір) або Swatches (зразки). 

Можна створювати лінійні, радіальні та еліптичні градієнти. Еліптичний 

градієнт утворюється внаслідок зміни ексцентриситету радіального 

градієнта. 

 

4 Хід роботи: 

Завдання №1 ЗЕЛЕНИЙ ЧОЛОВІЧОК 

1. Створіть новий документ File - New (Файл -Новий). 

2. Зобразіть лінії сітки View - ShowGrid (Вид - Показати сітку). 

3. Оберіть на панелі інструментів RectangleTool (Прямокутник) і 

намалюйте прямокутник. 

4. Залийте його градієнтом. Для цього спочатку потрібно вивести панель 

інструментів Gradient (Градієнт). Window - Gradient (Вікно - Градієнт). 

 
Рис.1 

5. Тепер необхідно зробити настройки: Type (Тип) - Radial (Радіальний); 

Angle (Кут) - 0. Для вибору кольору потрібно спочатку клацнути по маркеру 

(при натисканні кінчик маркера стає чорним рис. 2), 

Маркер 



 
Рис.2 

а потім в палітрі Color (Колір) вибрати необхідну колірну модель (RGB) і за 

допомогою бігунків або Піпетки налаштувати колір (Замість лівого маркера 

виберіть зелений, а замість правого - темно зелений) (див. Рис 3). 

RGB  

Рис.3 
6. Додайте точки: для цього виберіть Object - Path - Add anchor points (2 

рази). 
7. Оберіть команду меню Effect - DistortandTransform -Roughen (Ефект - 

Спотворення і трансформація - Шорсткість). Встановіть такі ж значення, 

як наведено на Рис. 4 (Size 7%, Detail 10%). 

 
Рис.4 

8. Оберіть команду меню Effect - Distort and Transform - Pucker & Bloat 

(Ефект - Спотворення і трансформація - Зморщування і роздуття). 

Встановіть значення в 27% (див. Рис.5). 

 
Рис.5 

9. Оберіть команду меню Effect - Distort and Transform - Twist (Ефект - 

Спотворення і трансформація-Закручування). Встановіть кут в 60 ° 

(Рис.6) 

 
Рис.6 

10. Оберіть команду меню Effect - Warp - Arc (Ефект - Викривлення - 

Арка). Встановіть наступні параметри: Bend 90%, Horizonta -72%, Vertica -

19% (див. Рис.7). 

 

результат 

 

результат 

результат 

результат 



Рис.7 

11. Використовуючи інструмент Ellipse (Еліпс), добийтеся приблизно такого 

ж результату (Рис. 8). 

 
Рис.8 

12. Для того, щоб волосся закривало лоб необхідно виконати наступні дії: 

 • Вибрати інструмент Selection (Вибір) і виділити волосся. 

 • Клацнути правою кнопкою миші по виділеному і вибрати Arrange - 

Bring to front (Положення - Перемістити на передній план). В результаті у 

вас повинно вийти наступне. 

 
Рис.9 

13. Малюємо очі. Для цього виберіть інструмент Ellipse Tool (Еліпс), 

намалюйте еліпс. Оберіть інструмент Direct Selection Tool (Прямий вибір)

. Наведіть вузли так, як показано на Рис. 10.. 

 
Рис.10 

14. Створіть ще один еліпс і залийте його радіальним градієнтом - це буде 

зіниця (Рис.11). 

 



Рис.11 

15.Виділіть за допомогою інструмента SelectionTool (Вибір)  всеоко, 

натисніть правою кнопкою миші по виділеному і виберіть Group 

(Групувати). 

16.Скопіюйте око Edit - Copy (Правка - Копіювати). Вставте вміст буфера 

обміну Edit - Paste (Правка - Вставити). Відобразіть друге око вертикально: 

Клацніть правою кнопкою миші по виділеному оку і виберіть Transform - 

Reflect - Vertical (Трансформувати - Відобразити - Вертикально). 

17. Перемістіть обидва ока на обличчя, використовуючи інструмент Selection 

Tool (Вибір) . (Для зміни порядку розміщення елементів не забувайте 

використовувати команду Arrange). В результаті у Вас повинно вийти 

приблизно наступне: 

 
Рис.12 

18. Залишилося намалювати тулуб. Для цього необхідно: 

  Намалювати прямокутник. Залити зеленим радіальним градієнтом. 

 Вибрати інструмент Add Anchor Point (Додати вузол). На нижньому 

боці прямокутника в середині поставити за допомогою цього інструменту 

точку (Рис.13). 

 
Рис.13 

Оберіть команду меню Effect - Distort and Transform - Pucker & Bloat 

(Ефект - Спотворення і трансформація - Зморщування і роздуття) 
(пересуньте бігунок на 50%, див. Рис.14). 

 
Рис.14 

 Оберіть команду меню Effect - Distort and Transform - Free Distort 

(Ефект - Спотворення і трансформація - Вільне спотворення) 
(деформуйте так само як на малюнку, шляхом пересуву маркерів) (Рис.15). 

результат 



 
Рис.15 

 Оберіть пункт меню Effect - Convert to Shape - Ellipse (Ефект - 

Перетворити фігуру - Еліпс) (див. Рис.16). 

 
Рис.16 

 Самостійно доповніть малюнок до наступного результату: 

 
Рис.17 

Збережіть отримане зображення під ім'ям Zel.ai. 

 

5 Висновки: в процесі виконання лабораторної роботи студент має 

ознайомитись з основними палітрами даного програмного продукту 

(Gradient, Color, Brushes) та навчитися створювати власний градієнт. 

 

6 Контрольні запитання 

6.1 Якими інструментами можна створити градієнти? 

6.2 Способи створення градієнтного заповнення. 

6.3 Як зберегти налаштування градієнта? 

6.4 Які градієнти існують у програмі Adobe Illustrator CS4? 

 

Література 

1 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 2008. -

600 с. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

3 Глинський Я.М. Інформатика Практикум з інформаційних технологій. – 

Тернопіль: Підручники і посібники, 2014 – 304 с. 

 



Інструкція для виконання лабораторної роботи №3 
 

Тема: Графічний редактор AdobeIllustratorCS4 Перетворення і організація 

об’єктів. Взаємне розміщення та упорядкування об’єктів. 

 

1 Мета: Здобути навики у роботі з об’єктами та рівнями об’єктів 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Illustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

 

4 Хід роботи: 

Завдання1 Квіти 

 

1. Створіть новий документ File - New (Файл -Новий). 

2. Відкрийте лінії сітки View - Show Grid (Вид - Показати сітку). 

3. Виберіть на панелі інструментів StarTool (Зірка). 

4.Клацніть лівою кнопкою миші по робочому полю і відпустіть кнопку миші. 

Встановіть такі ж параметри, як на Рис.1(Radius 8,8;Radius17,64;Points 5). 

 
Рис.1 

5. Залейте радиальным градиентом получившуюся звезду. Для этого на 

панели Опций выберите пункт Fill (Заливка) и радиальный градиент (Рис 2). 

 
 

Рис.2 

6.Змініть колір заливки. Для цього (якщо немає у Вас вікна Gradient, 

виведіть його на робоче поле командою Window - Gradient). 

 Клацніть по маркеру (1) - Виберіть зі списку колірну модель RGB (2) - 

виберіть колір (3) (Рис.3). 

 
Колір можна 
вибрати або за 

допомогою 

піпетки, або 
пересуваючи 

бігунки 



 
Рис.3 

7.Виберіть пункт меню Effect - Distort and Transform - Pucker & Bloat 

(Ефект - Спотворення і трансформація - Зморщування і роздуття), 

встановіть такі ж параметри як на Рис. 4 (пересуньте бігунок на 82%). 

 
Рис.4 

У Вас повинно вийти наступне: 

 
Рис.5 

8.Скопіюйте та вставте цей квітка Edit - Copy (Правка - Копіювати), Edit - 

Paste (Правка - Вставити). Знову вийшла квітка розмістіть поверх першого і 

поверніть так, щоб вийшов Рис. 6. 

 
Рис.6 

9.Згрупуйте вийшов об'єкт: Виберіть інструмент Selection Tool (Вибір) , 

обведіть два об'єкти (або по черзі клацніть на кожному, утримуючи клавішу 

<Shift>), потім клацніть правою кнопкою миші по виділеному і зі списку 

виберіть команду Group (Групувати). 

10.Тепер оформимо квітку. Для цього змінимо параметри пункту Brush 

(Кисть)(Якщо цього вікна немає, виберіть пункт меню Window - Brush 

(Вікно - Кисть)) Рис.7. 

 



 
Рис.7 

11.Створіть свій букет і збережіть його під ім'ям Bucket.ai. У Нас вийшло 

наступне: 

 
Рис.8 

 

Завдання №2 ЗМІЯ 
1.Створіть новий документ File - New (Файл -Новий). 

2.Виберіть інструмент Ellipse (Еліпс) і намалюйте два еліпса приблизно так, 

як показано на малюнку. Еліпс, більшого розміру, залийте помаранчевим 

кольором, еліпс меншого бірюзовим (Рис.9). 

 
Рис.9 

3.На панелі інструментів виберіть інструмент Blend (Перетекання)  

Активуйте його. Тепер клацніть 1 раз лівою кнопкою миші по кожному 

еліпсу. 

4.Для зміни параметрів переходу необхідно зробити подвійне клацання по 

піктограмі Blend (Перетекання). Встановіть такі ж параметри, які наведені 

на малюнку: SpecifiedDistance – 41 mm (Якщо у Вас еліпси знаходяться на 

великій відстані, то збільште значення до тих пір, поки ваше зображення не 

буде схоже на Рис. 10); Orientation – 1. 

Клацніть по ярлику Brush і 
виберіть будь-який тип кисті, 

додаткові типи кистей можете 

знайти клацнувши по 

стрілочки в правому 

верхньому кутку і із списку 

вибравши Open Brush Library 

 



 
Рис.10 

5Виберіть інструмент Add anchor Points(Додавання якірних крапок)  

Поставте дві точки, так як показано на рис.11 (Це будуть місця згину, на 

наступних етапах Ви можете на свій смак додавати і видаляти додатково 

нічки, видалення проводиться інструментом ). 

 

 
Рис.11 

6.Виберіть інструмент DirectSelectionTool (Прямий вибір) і перемістіть 

точки так, як показано наРис. 12. 

 
Рис.12 

7.Виберіть інструмент Convert Anchor Point Tool (Зміна вузлів) , і 

клацаючи по точкам, витягайте з них направляючі, за допомогою яких 

змінюється кут вигину (Рис 13). 

Добавление 

2-х точек 



 
Рис.13 

8.Підсумковим результатом у Вас може бути будь-який варіант, ми ж 

зупинимося на наступному: 

 

 
Рис.14 

9.Тулуб готов, приступимо до малювання голови. Активуйте інструмент 

Ellipse (Еліпс). Намалюйте еліпс і залийте приблизно таким же кольором як 

кінчик хвоста (рис.15). 

 
Рис.15 

10.Виділіть свій об'єкт, потім Object - Create gradient mesh (Об'єкт - 

Створення градієнтної сітки). Після цього встановіть потрібні параметри в 

діалоговому вікні (Rows 10, Columns 10). Так само можнасамостійно 

намалювати сітку, вибравши інструмент Mesh (Сітка) Рис.16 

 
Рис.16 

11.Використовуючи інструмент Direct Selection Tool (Прямий вибір) , 

виділіть частину вузлів і перемістити їх так як показано на Рис.17. 



 
Рис.17 

 

12.Не знімаючи виділення, залийте виділену область помаранчевим 

кольором. Колір виберіть в палітрі Color или Swatches(Рис.18). 

 
Рис.18 

 

Таким же чином досягнете наступного результату 

 
Рис.18 

 

13.Використовуючи інструмент Selection (Вибір) перемістіть елементи так, 

щоб вийшло наступне. 

 
Рис.19 

 

14.Тепер доповнимо малюнок додатковими об'єктами: квітами, метеликами, 

травою. Для цього: 

результат 

Використовуючи інструмент еліпс, додаткове 

зображення 

 



 створимо новий шар: Window – Layers (Вікно - 

Шари). 
В даний момент у Вас тільки один шар, для створення 

нового шару клацніть в нижній частині вікна по кнопці 

Great New Layer (Створити новий шар) . 

                    

 

 

Рис.20 

 

 Для початку процесу інструмент Symbol Sprayer (Розпилювач 

символів) . Виберіть на вкладці Symbols ті елементи, які Ви хочете 

розмістити на малюнку (Рис.21). Далі скористайтеся даним інструментом як 

звичайним Розпилювачем, ось тільки розпорошує він символи. 

 
Рис.21 

 

 В результаті у Нас вийшло наступне: 

 
Рис.22 

 бережіть зображення під ім'ям Zmey.ai. 

 

5 Висновки: в процесі виконання лабораторної роботи студент отримує 

навики у роботі з об’єктами та рівнями об’єктів 

 

 

 

 

 

 



6 Контрольні запитання 

 

6.1 Способи переміщення об’єктів. 

6.2 Методи масштабування об’єктів. 

6.3 Способи повертання та нахиляння об’єктів. 

6.4 Копіювання об’єктів. 

6.5 Дублювання об’єктів. 

6.6 Способи об’єднання та групування об’єктів. 

6.7 Розгруповування об’єктів. 

6.8 Злиття об’єктів 

6.9 Вирізання об’єктів. 

6.10 Вирівнювання об’єктів. 

Упорядковування об’єктів. 

6.12 Методика роботи з рівнями. 

Призначення диспетчера об’єктів та його піктограм. 
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Інструкція для виконання лабораторної роботи №4 
 

Тема: Графічний редактор Adobe Illustrator CS4. Робота з текстом. 
 

1 Мета: Здобути    навики    при    роботі    з    текстом,    навчитися    

ефективно опрацьовувати текст. 

 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Illustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Текст можна вводити одним із трьох способів. 

1. Клікнувши  мишею  у  точці  екрану,  вводять  текст  у  горизонтальному  

чи вертикальному  напрямках.  Створення  тексту  у  такий  спосіб  є  

зручним  при додавання кількох слів до рисунка. 

2. Текст вводять у області. Коли текст досягає контура об’єкта, він 

автоматично переноситься у межах визначеної ділянки. Вводити текст у 

такий спосіб зручно, якщо потрібно створити кілька абзаців. 

3. Текст    вводять    за    контуром    об’єкта.    У    цьому    випадку    

символи розташовуються уздовж контура. 

Панель Character (символ) (команда Window/Type/ Character) 

використовується при форматуванні окремих символів у документі. Панель 

Paragraph (абзац) (команда Window/Type/ Paragraph) використовується для 

форматування стовбців та абзаців тексту. Для  форматування виокремлення 

тексту також можна скористатися пікограмами на панелі керування. 

При  введенні  тексту  виникає  необхідність  зміни  розмірів  об’єктів.  

Розміри об’єктів можна змінювати декількома способами. 

1. Виокремлюють  об’єкт  інструментом  Selection Tool  і  перетягують  

маркери рамки, яка його обмежує. 

2. За  необхідності  встановлення  точних   розмірів  об’єкта  

використовують команду Object/Transform/Scale. 

3. Об’єкт можна масштабувати, виконавши команду 

Effect/Distort&Transform/ Transform. Якщо при цьому утримувати 

натиснутою клавішу <Shift>, об’єкт буде масштабуватись пропорційно (це 

буде відображено у полях діалогу W (ширина) і Н (висота) на палітрі 

Transform). 

 

 

 

 

 

 

 

 

 



4 Хід роботи: 

1. Створіть текст у точці: 

 активуйте інструмент Type Tool (текст); 

 у визначеному місці клікніть і наберіть текст; 

 натисніть кнопку <Enter>, щоб розпочати новий рядок тексту у межах 

того ж текстового об’єкта; 

 після закінчення введення тексту виокремте його, 

клікнувши на піктограмі інструмента Selection Tool (виокремлення); 

 відформатуйте текст за допомогою панелі ерування: виберіть шрифт 

Times New Roman, встановіть розмір 24 pt. 

 

2. Створення тексту у області: 

 виберіть інструмент Text Tool; 

 розмістіть курсор у місці, де повинен бути один з кутів рамки; 

 клікніть мишкою і перетягніть курсор, створивши рамку для тексту; 

 введіть текст; 

 виберіть інструмент Selection Tool; 

 змініть за допомогою маркерів розміри рамки; 

 відформатуйте текст за допомогою панелі керування. 

3. Створення стовбчиків тексту: 

 створіть текст у області і виокремте його; 

 виберіть Type (Текст)/Area Type Options (параметри тексту у області); 

 у  розділі  Columns  (стовбчики)  діалогового  вікна  Area  Type  Options 

(параметри тексту у області) встановіть параметр Number (число) – 3; 

 натисніть на кнопку OK. 

4. Створення ефекту тіні: 

 активуйте інструмент Type Tool, наберіть слово ―DNA‖, виокремте 

його інструментом Selection Tool; 

 на панелі керування встановіть гарнітуру Arial, розмір (Font Size) – 

72pt, стиль написання шрифту (Font Style) – Regular; 

 не відміняючи виокремлення тексту скопіюйте його, (команда 

Edit/Copy) і за   допомогою   команди   Edit/Paste   вставте скопійований   

текст   у монтажну область; 

 виокремте скопійований текст інструментом Selection Tool; 

 у  палітрі  інструментів  увімкніть  опцію  Fill  і,  вибравши  у  палітрі 

Swatches колір Yelow (жовтий), зафарбуйте символи; 

 не знімаючи виокремлення з жовтого текстового блоку встановіть його 

поверх чорного текстового блоку, за допомогою кнопок клавіатури 

перемістіть його праворуч і вниз, створивши тим самим ефект тіні. 

5. Створення тексту уздовж замкнутого контура: 

 у  палітрі  Symbols  (команда  Window/Symbols)  клікніть  на  

піктограмі Symbol Libraries Menu; 

 у списку символів виберіть Mad Science – у вікні з’явиться палітра з 

науковими символами – виберіть символ DNA; 

 за допомогою маркерів збільшіть ширину (W) символу до 64 мм; 

 виберіть  інструмент  Pen  Tool  і  створіть  об’єкт  у  формі  замкнутого 

контура навколо символу ДНК (рис. 1); 



 для введення тексту скористайтеся інструментом Type on а Path Tool, 

який прихований за інструментом Турe Tool; 

 клікніть ліворуч у створеному контурі, при появі маркера введіть текст 

―deoxyribonucleic acid‖ – текст буде введено уздовж контура; 

 виокремте текст; 

 за  допомогою  меню  Font  Size,  що  відкриється  на  панелі  

керування, введіть розмір 48 pt, виберіть гарнітуру Times New Roman і 

напівжирне написання шрифту Bold (рис. 2); 

 натисніть клавішу <Enter>. 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1. Створення замкнутого контура      Рис.2. Текст уздовж замкнутого 

контура 

6. Розміщення тексту вздовж спіралі: 

 створіть спіраль; 

 виберіть інструмент Type on а Path Tool; 

 підведіть курсор до спіралі; 

 введіть текст з розміром шрифту 24 pt. 

7. Збережіть файл за допомогою команди File/Save. 

 

5 Висновки: в процесі виконання лабораторної роботи студент має роботі    

з    текстом,    навчитися    ефективно опрацьовувати текст. 
 

6 Контрольні запитання 

6.1 Як створити текст у точці? 

6.2 Як створити текст у області? 

6.3 Як створити стовбчики тексту? 

6.4 Як створити текст уздовж контура? 

6.5 Для чого використовують панель Character (символ)? 

6.6 Для чого використовують панель Paragraph (абзац)? 

6.7 Як змінити розміри об’єкта? 

6.8 Як змінити розміри об’єкта пропорційно? 
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Інструкція для виконання лабораторної роботи №5 
 

Тема: Графічний редактор Adobe IllustratorCS4. Робота з символами 

 

1 Мета: Здобути навики при використанні інструментів для створення 

символів. 

 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Illustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Створення символів. Палітра Symbols (символи) дозволяє 
додавати у документ об’єкти-символи. Крім того, палітру Symbols (символи) 
можна використовувати як базу даних для зберігання рисунків, а також для 
відображення символів на поверхнях 3D-об’єктів. Символ можна вставляти у 
зображення за допомогою інструмента Symbol Sprayer Tool (розпилювач 
символів). Використання символів суттєво зменшує розміри файлу. 
При створенні символів за допомогою інструмента Symbol 

Sprayer Tool (розпилювач символів) необхідно враховувати наступне: 

 усі  об’єкти,  що  створюються  у  процесі  виконання  однієї  

операції розпилювання, є згрупованими, тому їх можна редагувати як єдине 

ціле; 

 для зміни радіуса розпилювання можна використовувати такі 

клавіші: < [ > –  для зменшення радіуса розпилювання, < ] > –  для 

збільшення радіуса розпилювання; 

 утримування натиснутою клавішу <Alt> при використанні 

інструмента Symbol Sprayer Tool  (розпилювач  символів)  приводить  до  

видалення елементів символу. 

Інструменти для роботи з символами. За інструментом Symbol Sprayer 

Tool (розпилювач символів) приховано сім інструментів, призначених для 

роботи з символами (рис. 1. Ці інструменти використують для зміни 

щільності, кольору, місця   розташування,   розміру,   кута   повертання,   

ступеня   прозорості   і   стилю набирання символів. 
 

 
 
 
 
 
 

Рис. 1 Інструменти для роботи з символами 
 

Функції інструментів для роботи з символами. 

  Інструмент  Symbol Shifter Tool  (зсування  символів)  –  пересуває  

елементи символу. Крім того, за допомогою цього інструмента можна 

змінювати відносний 

порядок розташування елементів символу в 
наборі. 



  Інструмент  Symbol Scruncher Tool  (стискання  символів) –  змінює  

взаємне розташування елементів символу. 

  Інструмент  Symbol Sizer Tool  (розмір символів)  –  збільшує  або  

зменшує розмірів елементів символу. 

  Інструмент Symbol Spinner Tool (обертання символів) – змінює 

орієнтацію елементів символу у групі. Елементи символу, розташовані поряд 

з курсором миші, орієнтуються  у  напрямку  його  переміщення.  Під  час  

перетягування  поряд  з курсором з’являється стрілка, що показує напрям 

орієнтації елементів символу. 

  Інструмент    Symbol Stainer Tool    (фарбування    символів) –    

підфарбовує елементи символу. При цьому колір елементів символу 

поступово ―наближається‖ до основного кольору, який було вибрано для 

фарбовування. Цей інструмент не впливає на чорні і білі об’єкти. 

  Інструмент   Symbol Screener Tool   (екранування   символів)   –   

підвищує   і зменшує ступінь прозорості елементів символу. 

  Інструмент Symbol Styler Tool (стилізація символів) – застосовує 

вибраний стиль до елементів символу. 
 

 

4 Хід роботи: 

Створіть новий документ, виконавши команду File/New (файл/новий). 

2. У  полі  Size  вікна  New Document  (новий  документ)  виберіть  формат  

А4  і натисніть кнопку ОК. 
3. У палітрі Symbols (команда Window/Symbols) клікніть на піктограмі 
Symbol Libraries Menu (рис. 3). У списку виберіть піктограму Web icons. У 

вікні з’явиться палітра із зображенням Web-символів (рис. 1). Виберіть 
символ під  назвою Phone. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1 Палітра Symbols 

4. Виберіть інструмент Pen Tool і створіть об’єкт у формі хмари (рис.2). 

На панелі інструментів клікніть на піктограму Stroke і виберіть колір Blaсk 

(чорний). Клікніть на піктограму Fill і встановіть режим None. 

5. Виберіть інструмент Pen Tool і створіть об’єкт у формі краплі води (рис. 

4). На панелі інструментів клікніть на піктограму Stroke і виберіть колір 

Blaсk (чорний). Клікніть на піктограму Fill і встановіть режим None. 
 



 

 
 

 

 

 

 

 

 

Рис. 2 Палітра із зображенням Web-символів 
 
 
 

 
 

Рис. 3 Об’єкт у формі хмари 
 

 
 
 
 
 
 
 
 

Рис. 4 Об’єкт у формі краплі 
 

6. Створіть новий символ. За допомогою інструмента Selection Tool 

виокремте об’єкт (краплю) і, перетягуючи маркер, збільшить її розмір. 

7. Виокремте краплю, яка має більший розмір, а потім, утримуючи 

клавішу <Ctrl>, клікніть на піктограмі New Symbol (новий символ) , яка 

розміщена внизу палітри Symbols і ліворуч від піктограми корзини. У полі 

ім’я символу діалогового вікна введіть назву: ―Крапля велика‖ і натисніть 

кнопку ОК. 

8. Виокремте краплю, яка  має менший  розмір, а потім, утримуючи  

клавішу <Alt>, клікніть на піктограмі New Symbol (новий символ) , яка 

розміщена внизу палітри Symbols і ліворуч від піктограми корзини. У полі 

ім’я символу діалогового вікна введіть назву: ―Крапля мала‖ і натисніть 

кнопку ОК. 

9. Додавання примірників символу. Застосуємо інструмент Symbol Sprayer 
Tool (розпилювач символів) до символу Крапля велика. 

10. Виберіть на панелі інструментів інструмент Symbol Sprayer Tool. 

Клікніть мишею у палітрі Symbols на створеному символі Крапля велика. 
11. Встановіть інструмент Symbol Sprayer (розпилювач символів) під 

хмарою і протягніть його униз, створюючи за допомогою декількох 
елементів крапель дощ. Для видалення елементів символів слід утримувати 

натиснутою клавішу <Alt> і клікнути на об’єкті. 
 

 
 
 
 
 
 
 
 

Рис. 5 Створені краплі різних розмірів 



12. Форматування символів і зміна їх розміру. Активуйте 

інструмент Symbol Sizer Tool (розмір символів)  . 

13. Клікніть мишею або протягніть її вказівник у місці, де необхідно 

збільшити розмір елементів символів. Навпаки, утримуйте натиснутою 

клавішу <Alt> і клікніть мишею або протягніть її вказівник у місці, де 

необхідно зменшити розмір елементів символів (рис. 5). Для збереження 

густини розташування символів під час клікання чи протягування  

вказівника  миші  необхідно утримувати  натиснутою  клавішу <Shift>. 

14. Розмістіть на загальному рисунку усі попередньо створені об’єкти. 
15. Виберіть команду File/Save і збережіть файл. 

 

5 Висновки: в процесі виконання лабораторної роботи студент отримує 

навики при використанні інструментів для створення символів. 
 

6 Контрольні запитання 

6.1 Які переваги використання символів? 

6.2 Як зменшити або збільшити радіус розпилення інструмента Symbol 

Sprayer Tool? 

6.3 Назвіть інструмент роботи з символами, призначений для зміни відтінків 

і тіней символів. 

6.4 Чи можна використовувати символи, створені у інших документах? 

6.5 Як створити новий символ? 
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Інструкція для виконання лабораторної роботи №6 
 

 

Тема: Графічний редактор Adobe Illustrator CS4. Використання 3D-ефектів 
для відображення рисунків 

 

1 Мета: Здобути навики у роботі з 3D-об’єктами. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Illustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

При відображенні рисунків на поверхні 3D-об’єктів слід дотримуватись 

таких правил. 

  Для   переміщення   символу   наведіть   курсор   миші   у   середину   

рамки обмеження і перетягніть об’єкт. Для зміни розмірів символу 

перетягніть бічний або кутовий маркер на рамці. Для повертання об’єкта 

наведіть курсор миші на маркер, що розташований зовні рамки обмеження і 

перетягніть його. 

  Для встановлення відповідності розмірів відображеного рисунка до 

розмірів виокремленої поверхні слід клікнути мишею на кнопці Scale to 

Fit (відповідність розмірів). 

  Для видалення рисунка з однієї поверхні слід виокремити цю 

поверхню у полі Surface (поверхня) і виконати одну з таких дій: 
  виберіть значення None (ні) з меню Symbol (символ); 

  клікніть мишею на кнопці Clear (очистити). 

 Для видалення відображених символів з усіх поверхонь 3D-об’єкта слід 

клікнути мишею на кнопці Clear All (очистити все). 

  Для затемнення рисунка, з можливістю використання цього затемнення до 

відображеного   символу,   слід   встановити  прапорець   Shade Artwork   

(затемнити рисунок). 

  Для перегляду лише відображеного рисунка (коли геометрія 3D-об’єкта є 

прихованою) слід встановити прапорець Invisible Geometry (невидима 

геометрія). 

 

4 Хід роботи: 

Завдання №1 ЯБЛУКО 

 

1.Створіть новий документ File - New (Файл -Новий). 

2.Використовуючи Інструмент Pen (Перо) намалюйте половину контуру 

майбутнього об'єкта. Як заливки виберіть зелений колір (ріс.1). 



 

Рис.1 

3.Тепер, щоб домогтися більшої реалістичності, слід підготувати рум'янець. 

Для цього: 

 Створіть коло (інструмент Ellipse (Еліпс)  + <Shift>) і залийте її 

червоним кольором. 

 Створіть новий шар: в палітрі Layers виберіть Create New Layer 

(Створити новий шар) .  

 Скопіюйте окружність (Ctrl + C) і вставте в новий шар (Ctrl + V) 

(рис.2). 

 
Рис.2 

Пофарбуйте в чорно-білий радіальний градієнт другу окружність (рис.3). 

 
Рис.3 

 Помістіть об'єкти один щодо одного використовуючи команди 

Horizontal Align Center (горизонтальне вирівнювання по центру) і 

Vertical Align Center (Вертикальне вирівнювання по центру) палітри 

Align (рис.3).  

 
Рис.4 

 Тепер за допомогою інструменту Selection (Вибір), виділивши обидві 

окружності, потрібно застосувати до них команду Make Opacity Mask 



(Створити маску прозорості) в меню палітри Transparency (Прозорість) 

(ріс.5). 

 
Рис.5 

 Отриманий елемент слід перетягнути в палітру Symbols (Символи) і 

привласнити йому ім'я Red_1 (рис.6). 

 
Рис.6 

4.Після того, як основні приготування завершені, перейдемо до самого 3D 

ефекту. Для цього виберіть Effect - Revolve (Ефект - Обертання) 

Для отримання очікуваного результату слід використовувати налаштування, 

наведені на малюнку 74 (  -18%,  -26%, 8%). Тільки після цього 

можна буде включити Preview (Перегляд). Тепер можна 

проекспериментувати з положенням і освітленням об'єкта, змінюючи Specify 

rotation around axis (Значення повороту навколо осі) для осей X, Y, Z і 

настройки джерела світла (щоб вони відображалися потрібно натиснути 

кнопку More Option (Більше опцій)) (рис.7) . Таким чином, вдасться 

уникнути додаткового очікування. 

 

Рис.7 

меню палитры 

Transparency 



5.Тепер необхідно злегка яблуко підрум'янити, натиснувши кнопку Map Art 

(Карта поверхні) (рис.8). 

 
Рис.8 

6.Для зручності роботи в вікні Map Art (Карта поверхні) бажано поставити 

прапорець Preview (Перегляд), далі в поле Surface (Поверхня) слід вибрати 

ту поверхню об'єкта, з якої будуть проводитися подальші маніпуляції, в 

даному випадку ця поверхня № 3. Потім в випадаючому списку Symbol 

(Символ) потрібно вибрати те зображення, яке буде накладено на об'єкт, в 

даному випадку це Red_1. Як тільки символ буде обраний, він відобразиться 

в робочому просторі плагіна. Переміщаючи і масштабуючи символ, можна 

домогтися найбільш вдалого результату. Важливо врахувати, що видима 

частина поверхні в вікні Map Art (Карта поверхонь) пофарбована в білий 

колір, сірим же відзначена задня сторона об'єкта. 

Після того, як потрібний ефект буде досягнутий, натисніть кнопку OK. 

7.Залишається створити тільки черешок, який Ви зробите самостійно за 

допомогою вже відомої команди Перетікання (докладніше дана команда 

розглянута в завданні Змій). 

8.Збережіть отримане зображення під ім'ям Apple.ai (Рис.9). 

 
Рис.9 



 

 

5 Висновки: в процесі виконання лабораторної роботи студент засвоює 

інструменти для створення 3D графіки. 
 

6 Контрольні запитання 

6.1 Для чого використовують символи? 

6.2 Які  існують  способи  для  створення  3D-об’єктів  у  програмі  Adobe 

Illustrator CS4? 

6.3 Як змінити напрямок освітлення 3D-об’єкта? 

6.4 Як відобразити символи на поверхнях 3D-об’єкта? 

6.5 Як видалити рисунок з поверхні 3D-об’єкта? 
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Інструкція для виконання лабораторної роботи №7-8 
 

Тема: Створення блокнота, візитної картки та настінного календаря 

 

1 Мета: Завдання данної лабораторної роботи спрямовані на закріплення 

навичок роботи з основними інструментами Adobe Illustrator. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Illustrator 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

 

4 Хід роботи: 

Завдання №1 БЛОКНОТ 

 

1.Спочатку слід намалювати прямокутник - майбутню сторінку блокнота, для 

цього слід скористатися інструментом Rectangle (Прямокутник). Необхідно, 

клацнувши їм по робочій області, активувати вікно налаштувань цього 

інструменту і в поля Width (Ширина) і Height (Висота) ввести 90 мм і 60 мм 

відповідно. Розміри прямокутника можуть бути і іншими. 

2.Наступним кроком буде створення ряду отворів під пружину. Для цього 

знадобиться інструмент Ellipse (Еліпс). Натиснувши їм по робочій поверхні, 

слід активувати вікно налаштувань цього інструменту і в поля Width 

(Ширина) і Height (Висота) ввести 2,5 мм. Далі, скопіювавши отриману 

окружність, слід розмістити обидві копії в верхніх кутах прямокутника-

сторінки на невеликій відстані від краю (рис.1). 

 
Рис.1 

 

 

3.За допомогою інструменту Vertical Align Center (Вертикальне 

вирівнювання по центру) палітри Align (Вирівнювання) слід вирівняти 

окружності один щодо одного (Рис.2). 



 
Рис.2 

4.Після цього потрібно виділити окружності і застосувати до них 

командуObject – Blend – Make (Об'єкт - Перетікання - Створити). 

Після цього слід налаштувати параметри перетікання, 

активувавшиBlendOptions (Параметри перетікання)в меню Object - Blend 

(Об'єкт - Перетікання). У вікні налаштувань в випадаючому списку Spacing 

(Інтервал) слід вибрати рядок Specified Distance (Завдання Дистанції), 

ввести в поле введення 5 мм і натиснути OK (Рис. 3).Після цього треба 

виділити отриманий об'єкт і застосувати до нього команду Expand 

(Перетворити) меню Object (Об'єкт). 

 
Рис.3 

5.Тепер необхідно вирівняти відносно один одного отриманий ряд кіл і 

прямокутник за допомогою кнопки Horizontal Align Centre (горизонтальне 

вирівнювання по центру) палітри Align (Вирівнювання). 

Після цього прямокутник сторінки і ряд отворів слід об'єднати за допомогою 

команди Subtract from Shape Area (Відняти область) 

палітриPathfinder(Обробка контурів), після чого натиснути кнопку Expand 

(Перетворення) цієї ж палітри. До отриманого об'єкту слід застосувати білу 

заливку і сірий контур товщиною 0,5 pt 

Форма сторінки готова (Рис.4). 

 
Рис.4 



Далі створюється разлиновка. Для цього слід скористатися інструментом 

Line Segment (Лінійний сегмент). При натисканні їм по робочому простору 

активізується вікно настройки, в нього необхідно ввести наступні параметри 

(Рис.5):Length (Довжина) – 80 мм, Angle (Кут) – 0. 

 
Рис.5 

В параметрах меню Stroke (Контур) в поле Width (Товщина) потрібно ввести 

значення 0,5 pt, потім вибрати колір контуру - світло-синій, бузковий, або 

сірий. Скопіювавши лінію, слід вибрати обидва примірника і розмістити їх 

один над іншим на відстані 45 мм так як показано. 

 
Рис.6 

Після цього до ліній потрібно застосувати команду Object - Blend - Make 

(Об'єкт - Перетікання - Створити). Далі активуємо вікно налаштувань 

ефекту Object - Blend - Blend options (Об'єкт - Перетікання - параметри 

перетікання). У вікні налаштувань в випадаючому списку Spacing 

(Інтервали) слід вибрати рядок Specified Distance (Завдання дистанції), 

ввести в поле введення 3 мм і натиснути OK (Рис.7).  

 
Рис.7 

Отримаємо проміжний результат. 



Продублювавши об'єкт, потрібно трансформувати його, змінюючи параметри 

в палітрі Transform (Трансформація) наступним чином: 

Angle (Кут) – 90 

Width (Товщина) – 80 мм 

Height (Висота) – 45 мм 

 
Рис.8 

Щоб надати блокноту обсяг і товщину, слід: 

Скопіювавши сторінку, розмістити її так, як показано на Рис. 9. 

 
Рис.9 

Виділивши обидва об'єкти, застосувати Object - Blend - Make (Об'єкт - 

перетікання - створити). 

У випадаючому списку Spacing (Інтервал) вікна Blend Options (Параметри 

перетікання) вибрати рядок Specified Distance (Завдання дистанції), 

введіть у поле введення 2 мм і натисніть OK (Рис.10). 

 
Рис.10 

Застосуйте до об'єкта команду Object (Об'єкт) - Blend (Перетікання) - 

Expand (Перетворити). 

Розгрупувати сторінки за допомогою команди Object - Ungroup (Об'єкт - 

розгрупувати). 

За допомогою інструменту Direct Selection (Прямий вибір) виділіть всі 

сторінки, крім першої та останньої і застосуєте до них більш світлу сіру 

заливку контуру (Рис.11). 



 
Рис.11 

 Для того, щоб створити пружину слід: 

  Вибрати інструмент Ellipse (Еліпс). 

  Активувати його настройки, клацнувши їм на робочому просторі. 

  В поля Width (Ширина) і Height (Висота) ввести 6 мм і 8 мм 

відповідно. 

  У нижній правій частині еліпса додати опорну точку за допомогою 

інструменту Add Anchor Point (Додати вузол) (Рис.12). 

 
Рис.12 

 Не знімаючи виділення, відразу видалити її, натиснувши 

клавішу<Delete> (Рис.13). 

 
Рис.13 

 У палітрі Stroke (Контур) в поле Width (Товщина) ввести значення 4 pt, 

колір контуру вибрати темно-сірий. 

  Скопіювати об'єкт і в палітрі Stroke (Контур) в поле Width (Товщина) 

ввести значення 0,1 pt і застосувати білий колір контуру. 

  Виділити обидва об'єкти і за допомогою кнопки Horizontal Align 

Centre (горизонтальне вирівнювання по центру) і Vertical Align Centre 

(Вертикальне вирівнювання по центру) палітри Align (Вирівнювання) 

вирівняти їх один щодо одного (Рис.14). 

 
Рис.14 

 Не знімаючи виділення, застосувати команду Object - Expand (Об'єкт 

- перетворити). 

 Застосувати до пари об'єктів команду Object - Blend - Make (Об'єкт - 

Перетікання - Створити). 

 Активувати вікно налаштувань Object - Blend - Blend Options (Об'єкт 

- Перетікання - Параметри перетікання) і в списку, що випадає Spacing 

(Інтервал) вибрати рядок Spacing Steps (Завдання кроку), в полі введіть 

значення 50 (Рис.15). 



 
Рис.15 

 Застосувати до отриманого об'єкту командуObject – Blend – Expand 

(Об'єкт - Перетікання - Перетворити). 
Для того, щоб з одного витка створити пружину, слід скопіювати об'єкт, 

розмістити обидва витка над крайніми отворами сторінки і застосувати 

команду перетікання (Рис. 16). 

 
Рис.16 

Збережіть отримане зображення під ім'ямBloknot.ai. 

 

Завдання №2 ВІЗИТНА КАРТКА 

 

1.Створіть новий документ File - New (Файл - Новий), з параметрами, 

представленими на малюнку: 

 
Рис.17 

2.Виберіть інструмент Rectangle (Прямокутник) і, клацнувши їм по 

робочому простору, активуйте вікно налаштувань інструменту. У цьому вікні 

в полях Width (Ширина) і Height (Висота) необхідно ввести значення 90 мм 

і 50 мм відповідно. 

3.Щоб розташувати вийшов прямокутник по центру сторінки, слід 

активувати палітру Align (Вирівнювання) і, вибравши команду Align to Art 

board (Вирівняти по сторінці), натиснути кнопки Horizontal Align Centre 



(горизонтальне вирівнювання по центру) і Vertical Align Centre 

(Вертикальне вирівнювання по центру). 
4.До отриманого фонового прямокутника слід застосувати графічний стиль. 

Для цього необхідно скористатися командою Open Graphic Styles Library 

(Відкрити бібліотеку графічних стилів) палітри Graphic Styles (Графічні 

стилі) і вибрати бібліотеку Buttons & Rollovers (Кнопки). Для фону даної 

візитки використовувати стиль Platinum Normal (Рис.18). 

 
Рис.18 

5.Для того, щоб намалювати голову чоловічка, слід скористатися 

інструментом Ellipse (Еліпс). Після клацання мишею по робочому простору 

активізується вікно налаштувань інструменту, в якому в полях Width 

(Ширина) і Height(Висота) слід ввести значення 35 мм. До отриманої 

окружності слід застосувати чорний контор товщиною 1 pt і градієнтну 

заливку з наступними параметрами: 

Type (Тип) - Radial (Радіальний), Location (Положення) - 0%, колір білий, 

Location (Положення) - 30%, колір Sunshine (на палітрі Swatches), 

Location (Положення) - 65%, колір Cappuccino (на палітрі Swatches), 

Location (Положення) - 100%, колір Mochaccino (на палітрі Swatches). 

C допомогою інструменту Gradient (Градієнт) слід розташувати заливку 

таким чином, щоб центр градієнтної окружності припадав на місце 

передбачуваного відблиску, і, утримуючи клавішу <Shift> і ліву кнопку 

миші, протягнути інструмент до краю об'єкта під кутом 45 (Рис.19). 

 

 
Рис.19 

6.Щоб додати посмішку, слід знову використовувати інструмент Ellipse 

(Еліпс). Активувавши вікно настройки інструменту клацанням по робочому 

простору, необхідно в поля Width (Ширина) і Height (Висота) ввести 

значення 20 мм і 18 мм відповідно. Виділивши верхній вузол отриманого 

еліпса за допомогою інструменту Direct Selection (Прямий вибір), слід 

видалити його, натиснувши клавішу <Delete> (Рис.20). 

 



 
Рис.20 

7.Намалюємо очі. Використовуємо інструмент Ellipse (Еліпс). З його 

допомогою потрібно створити коло діаметром близько 2, 5 мм і залити її 

чорним кольором. Продублювавши очі, можна починати компонувати особа 

(Рис.21). 

 
Рис.21 

8.Всі деталі смайлика слід згрупувати (Ctrl + G) 

Далі необхідно створити шию. Для цього слід намалювати невеликий 

прямокутник за допомогою інструменту Rectangle (Прямокутник) і залити 

його таким же градієнтом, як і голову, змінивши параметри Type (Тип) На 

Linear (Лінійний). 

9.Для тулуба необхідно створити коло з діаметром 25 мм. Для створення 

смугастої заливки знадобляться два невеликих прямокутника однакового 

розміру сірого і коричневого кольору. 

Розташувавши об'єкти як на малюнку 111, їх необхідно вирівняти по 

вертикалі Vertical Align Centre (Вертикальне вирівнювання по центру). 

Після цього слід згрупувати їх (Ctrl + G) і за допомогою миші перетягнути на 

палітру Swatches (Зразки заливки) (Рис.22). 

 
Рис.22 

10.Для створення білого комірця намалюйте квадрат з довжиною сторони 15 

мм. Після цього необхідно виділити отриманий прямокутник і в 

випадаючому списку Rotate (Обертання) палітри Transform 

(Трансформація) вибрати поворот на 45(Рис.23). 

 
Рис.23 

Далі необхідно створити дублікат окружності-тулуба і розташувати об'єкти 

таким чином, як показано на малюнку. Виділивши обидва об'єкти, слід 



скористатися кнопкою Subtract from Shape Area (Відняти область) палітри 

Pathfinder (Обробка контурів). 
11.Для того, щоб створити краватку слід скористатися інструментом Pen 

(Перо)(Рис.24). 

 
Рис.24 

12.Вибравши на палітрі Swatches (Зразки заливки) зразок градієнта Steel 

Cylinder, слід застосувати його до отриманої фігурі і в поле Angle (Кут) 

палітри Gradient (Градієнт) ввести значення 35 (Рис.25). 

 
Рис.25 

13.Тепер необхідно скомпонувати всі елементи зображення як показано на 

малюнку, і вирівняти їх за допомогою кнопки Horizontal Align Centre 

(горизонтальне вирівнювання по центру). 
14. Для того, чтобы набрать текст, следует использовать инструмент Type 

(Текст) (Самостоятельно подберите параметры). 

15.Для того щоб створити маркери, використаний символи гарнітури 

Windings. Щоб вибрати необхідний символ, слід викликати палітру Glyphs 

(Символи), вибравши її ім'я в списку палітри меню Window - Type (Вікно - 

Текст). У випадаючому списку внизу палітри слід вибрати гарнітуру 

Windings, а у вікні перегляду - потрібний символ, і виконати подвійне 

клацання по його зображенню (Рис.26). 

 
Рис.26 

16.Коли візитна картка буде скомпонована, необхідно позбутися від частини 

зображення, яка виходить за межі друкованої сторінки (Рис.27). 

 



Рис.27 

Для цього слід вибрати інструмент Rectangle (Прямокутник) і, клацнувши 

їм по робочому простору, активувати вікно налаштувань інструменту. У 

цьому вікні в полях Width (Ширина) і Height (Висота) необхідно ввести 

значення 90 мм і 50 мм відповідно. Щоб розташувати вийшов прямокутник 

по центру сторінки слід активувати палітру Align (Вирівнювання) і, 

вибравши команду Align to Artboard натиснути кнопку Horizontal Align 

Centre (горизонтальне вирівнювання по центру) і Vertical Align Centre 

(Вертикальне вирівнювання по центру). Після цього необхідно виділити 

всі об'єкти і застосувати команду Object - Clipping Mask - Make (Об'єкт - 

Маска обрізки - Створити) (Рис.28). 

 

 
Рис.28 

Збережіть отримане зображення під ім'ям Vizitka.ai. 

ЗАВДАННЯ: Створити свою власну візитку. 

 

Завдання №3 НАСТІННИЙ КАЛЕНДАРЬ 

1.Створіть новий документ File - New (Файл - Новий). У діалоговому вікні 

введіть ім'я файлу (Kalendar) виставте потрібні розміри (210 x 297 mm) (Рис. 

29). 

 
Рис. 29 

2.Відкрийте палітру шарів Window - Layers (Вікно - Шари) (Рис. 30). 

 
 

Рис. 31 

3.Перейменуйте шар Layer 1 у Фон: 



 
Рис. 32 

4.Виберіть інструмент Rectangle (Прямокутник). Клацніть лівою кнопкою 

миші по робочому полю і в діалоговому вікні встановіть наступні параметри 

(210x 297): 

 
Рис. 33 

5.Залийте прямокутник градієнтної заливкою (ліва межа градієнта 

замальовується темно червоним, права - червоним, інші настройки градієнта 

слід залишити без змін). 

6.Скопіюйте отриманий прямокутник в буфер обміну. 

7. Скопійований прямокутник вставте в той же шар, що і перший 

прямокутник. 

8. Задайте розміри другого прямокутника (205 x 292). 

9.До другого прямокутника застосуєте інструмент Store (Контур) товщиною 

3 мм білого кольору. 

10.За допомогою команд Horizontal Align Centre (горизонтальне 

вирівнювання по центру) і Vertical Align Centre (Вертикальне 

вирівнювання по центру) палітри Align(Вирівнювання) вирівняти їх один 

щодо одного. 

11. Не снимая выделения, сгруппируйте эти два прямоугольника Object – 

Group (Объект - Группировать) (Рис. 34). 

 
Рис.34 

12.Наступним етапом створення календаря повинно стати додавання нового 

шару з назвою Сітка. Для цього слід вибрати в нижньому правому куті 

палітри Layers (Шари) піктограму Great New Layer (Створити новий 

шар)(Рис.35).  



 
Рис.35 

На цьому шарі і слід розташувати календарну сітку. Для цього необхідно 

скористатися інструментом Type (Текст) на палітрі Інструментів і виставити 

параметри тексту як на малюнку: 

 
Рис.36 

Колір шрифту - білий, шрифт без обведення 

13. Натиснувши лівою кнопкою миші по робочому полю і, не відпускаючи 

кнопку миші, створіть рамку, в яку повинні вписати один календарний 

місяць. Потім потрібно вибрати інструмент Selection (Вибір) і в панелі 

Transform (Трансформація) виставити точні розміри (40 x 35). 

14.Рамка готова, тепер слід вибрати команду Type - Area Type Option 

(Параметри текстової рамки) і встановити ті ж параметри, що на Рис.37. 

 
Рис.37 

У групах Rows (Рядки) і Columns (Стовпці) встановлюється кількість 

рядків і стовпців (7 і 7) і відстань між ними Gutter. 

15.Потім необхідно вибрати інструмент Type (Текст), клацнути в робочому 

вікні лівою кнопкою миші і ввести назву місяця і числа. 

 
Рис.38 

На підставі наявної сітки можна створити календар на 1-е півріччя: для цього 

скористайтеся командами копіювання, вирівнювання. 



Друге півріччя створюємо за прикладом першого. При цьому слід врахувати, 

що дні тижня календарної сітки повинні розташовуватися з правого боку. 

16.Додамо зображення. Спочатку створимо новий шар з ім'ям пори року. За 

допомогою інструменту Rectangle (Прямокутник) потрібно накреслити 

прямокутник і розташувати його в центрі календаря, який буде виконувати 

роль маски зображення. 

17.Коли фотографії для колажу обрані, їх потрібно експортувати в файл з 

календарем File - Place (Файл - Вставити). Далі потрібно растерізіровать 

зображення за допомогою команди Object - Rasterize (Об'єкт - 

растеризация). 

18.Помістіть растеризувати об'єкт під прямокутником (слід зауважити, що 

зображення і прямокутник розташовуються в одному шарі). 

19.Для створення маски слід одночасно виділити за допомогою клавіші 

<Shift> і інструменту Selection (Виділення об'єкта) зображення і 

прямокутник, потім натиснути правою кнопкою миші і вибрати Make 

Clipping Mask (Створення маски). 
20.Далі створюється гарна рамка для зображення. Спочатку креслимо ще 

один прямокутник з розмірами аналогічними прямокутника, яка є маскою. 

Потім прибираємо заливку прямокутника, залишивши тількиStroke 

(Обведення) – 0,1 mm.Не знімаючи виділення з прямокутника, вибираємо 

кисть з назвою Mixed Bouquet зі стандартної бібліотеки кистейModFloran. 

Рамка готова, тепер її слід відцентрувати з замаскованим зображенням і 

помістити у верхню частину зображення. Для решти трьох зображень 

виконайте те ж саме (Рис.39). 

 
Рис.39 

Збережіть отримане зображення під ім'ям Kalendar.ai.Павловський О.В. 

 

5 Висновки: в процесі виконання лабораторної роботи студент застосовує 

отримані навички при роботі з Adobe Illustrator 



 

 

6 Контрольні запитання 

6.1 Способи переміщення об’єктів. 

6.2 Методи масштабування об’єктів. 

6.3 Способи повертання та нахиляння об’єктів. 

6.4 Копіювання об’єктів. 

6.5 Дублювання об’єктів. 

6.6 Способи об’єднання та групування об’єктів. 

6.7 Розгруповування об’єктів. 

6.8 Злиття об’єктів 

6.9 Вирізання об’єктів. 

6.10 Вирівнювання об’єктів. 

Упорядковування об’єктів. 

 

Література 

1 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 2008. -

600 с. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

3 Глинський Я.М. Інформатика Практикум з інформаційних технологій. – 

Тернопіль: Підручники і посібники, 2014 – 304 с. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Інструкція для виконання лабораторної роботи №9 
 

Тема: Програмний пакет векторної графіки Corel Draw. 

 

1 Мета: ознайомитись з програмним середовищем та вивчити інтерфейс 

програми, засвоїти навички роботи з палітрами, командами і панеллю 

інструментів, ознайомитися з одиницями виміру. Навчитись створювати 

документ заданого формату, змінювати розміри зображення. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Векторний графічний редактор CorelDraw » 

Нижче наведено список, що містить опис основних компонентів інтерфейсу програми 

CorelDRAW. 

• Набір інструментів містить інструменти для створення, заливки і зміни об'єктів 

в документі. 

• Стандартна панель інструментів містить клавіші швидкого виклику основних 

меню і команд, таких як відкриття, збереження і друк документів. Додаткові панелі 

інструментів містять клавіші швидкого доступу для спеціальних завдань. 

• Рядок меню містить меню пов'язаних команд, що розкриваються. 

• У рядку заголовка відображається заголовок поточного документа. 

• Панель властивостей (на рисунку згорнута) містить елементи управління, 

набір яких залежить від активного інструменту. Наприклад, при використанні 

інструмента «Текст» панель властивостей відображає елементи управління для 

створення і редагування тексту. 

• Вікно налаштування забезпечує доступ до команд і параметрами, пов'язаним з 

конкретним інструментом або завданням. 

• Горизонтальна і вертикальна лінійки дозволяють визначити розмір і 

розташування об'єктів в документі. 

• Навігатор документів дозволяє додавати сторінки в документ і переміщатися 

між сторінками в документі. 

• Вікно документа – це робоча область, обмежена смугами прокрутки та іншими 

елементами керування. Вона містить сторінку малювання і навколишню область. 

• Сторінка малювання – це прямокутник, що обмежує друковану область вікна 

документа. 

• Палітра документа дозволяє відстежувати кольори, використовувані в 

документі. 

• Колірна палітра – це панель із зразками кольору, що закріплюється. 

• Рядок стану містить відомості про властивості об'єкта, такі як тип, розмір, 

колір і заливка. Тут також відображаються стан кольоропроби, колірні профілі та інші 

відомості про кольори документа. 

 

 

 

 

 



4 Хід роботи: 

Завдання: створити два документа, в одному створити 5 сторінок формату 

А4. Підготувати документи до подальшого використання (Рис.1.). 

1. Створити новий документ за допомогою пункту головного меню 

«Файл» 

– «Создать» (або за допомогою комбінації клавіш Ctrl+N). 
2. У діалоговому вікні створення документу (рис.1.5) вибрати одиниці 

вимірювання «см» та встановіть потрібний формат 9х5 см. У полі 

розподільної здатності встановіть 300 піксель на дюйм, кольорову схему 

встановіть RGB. 

3. За допомогою пункту головного меню «Вид» – «Линейки» активуйте 

відображення лінійок, якщо вони вимкнені. 

4. За допомогою пункту головного меню «Инструменты» – 

«Параметры» – 

«Документ» – «Линейки» встановіть одиниці вимірювання лінійок – 

міліметри. Встановити одиниці також можливо завдяки визові контекстного 

меню на лінійках. 

5. За   допомогою   інструмента       на палітрі інструментів, витягніть 

направляючу з горизонтальної лінійки на рівень 17 мм. Витягніть 

вертикальну направляючу з вертикальної лінійки на рівень 25 мм. 

6. Зберегти файл креслення, присвоївши йому ім’я «візитка» вибравши 

розширення файлу *.cdr. 

7. Створити новий документ за допомогою пункту головного меню 

«Файл» 
– «Создать» (або за допомогою комбінації клавіш Ctrl+N), встановіть 

формат «А4», кольорову схему встановіть «RGB». 

8. За допомогою панелі властивостей змінить орієнтацію

 формату документу на горизонтальну (рис.1.5, б). 

9. Створіть 5 сторінок у документі, кожну сторінку назвіть «Лабораторна 

1» і т.д. 

10.Горизонтально розкресліть робоче поле документа на сторінці за назвою 

«Лабораторна 5» на три частини за допомогою направляючих, які 

витягуються із лінійок. Поверніться на сторінку «Лабораторна 1». 
11.Зберегти файл креслення, присвоївши йому ім’я «Лабораторні роботи» 

вибравши розширення файлу *. cdr. 

Рис. 1 Приклад виконання завдання 



 

12. Відкрити програму: Пуск – Програми – CorelDRAW 

13. Побудувати прямокутник синього кольору з червоним контуром та 

еліпс червоного кольору з синім контуром. Обрати інструмент Прямокутник. 

На листі провести мишкою діагональ прямокутника – для його побудови. На 

палітрі вибрати синій колір лівою кнопкою миші – прямокутник 

зафарбовано. На палітрі вибрати червоний колір правою кнопкою миші – 

колір контура фігури. 

14. Побудувати квадрат зеленого кольору з жовтим контуром та коло 

жовтого кольору з зеленим контуром. Рівні фігури у CorelDraw будуються з 

утриманням кнопки Ctrl. 

15. Намалювати та розфарбувати фігури:  

 

 
16. Намалювати чотирикутну зірочку. Обрати інструмент Зірка (Star 

Shapes) (з інструменту Базові фігури)  

17. Намалювати спіраль. Обрати інструмент Спіраль (Spiral Tool) з 

інструменту Сітка (Зверніть увагу! Після побудови №3 він може мати вигляд 

багатокутника!) 

Намалювати малюнок а): 

б) а)                                       

          б) 

                                

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Намалювати малюнок б). Обрати інструмент Художнє оформлення з 



інструменту Малюнок.  У верхній панелі 

інструментів вибрати Розпилювач (Sprayer) та його тип (з переліку). Таким 

чином можна намалювати рибки, камінці, водорості, бульбашки тощо. 

 
Побудова ока. 

18. Намалюйте квадрат, утримуючи клавішу Ctrl. 

19.Поверніть його на 45 градусів за допомогою панелі меню Упорядкувати – 

9.3 Перетворення -Поворот. 

20. Скопіюйте квадрат за допомогою клавіші + 

Намалюйте прямокутники за зразком (рис.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

21. Виділіть перший великий об'єкт. 

22.Клацніть мишею на кнопці заокруглені всі кути, так щоб вона була 

відтиснуті. 

23. Введіть 100 Число в полі, відповідне нижньому лівому кутку. Натисніть 

Enter. 

24. Повторіть п. 9.8 для поля, відповідне правому верхньому кутку. 

25. Виконайте ту ж операцію для другого і четвертого об'єкта. 

26. Для третього об'єкта затиснути замок і ввести в будь-яке поле значення 

100. 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

Збережіть файл у своїй папці з назвою Glaz. Cdr 

27. На основі виконаних завдань сформувати звіт та додати прінскріни 

малюнків 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навичок з редагування графічних об’єктів. Навчитися використовувати 

прив’язки при розташуванні графічних об’єктів в документах. Вивчити 

принципи вирівнювання об’єктів  
 

 

 

6 Контрольні запитання 

 

6.1 Яким чином можна збільшити масштаб відображення 

зображення на робочому полі документу, щоб розглянути ближче більш 

дрібні деталі? 

6.2 Як зменшити масштаб відображення зображення  на робочому 

полі документу, щоб воно цілком помістилося на екрані? 

6.3 Які дії треба зробити щоб встановити напрямні у документі? 
6.4 Як змінити розмір графічного зображення? 

6.5 Як виокремити частину графічного зображення? 

6.6 Що таке графічний примітив? 

6.7  Зробіть перелік і охарактеризуйте існуючі типи графічних файлів . 

 

Література 
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— К.: Вид. група BHV, 2009. — 400 с: іл. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

3 Компьютерная графика (Глушаков С. В., Капитанчук А.В., Вещев 

Е.В.)-Харьков:2006.- 511с. 

4 Романюк О.М., Кательніков Д.І., Пойда С.А. Комп’ютерна графіка та 

веб-дизайн. –Вінниця: 2007.-142с., 8с. іл. 

 



Інструкція для виконання лабораторної роботи №10 
 

Тема: Функції побудови та редагування кривих Без’є. Засоби редагування 

об’єктів в Corel Draw. 

 

1 Мета: набути навичок роботи з інструментами створення 

різноманітних графічних об’єктів. Навчитися використовувати прив’язки 

при розташуванні графічних об’єктів в документах. Вивчити принципи 

вирівнювання об’єктів. 
 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Створення об’єктів за допомогою інструменту «Кривая Безье» 

Оберіть інструмент «Кривая Безье» з меню «Кривая». Вкажіть точку початка креслення 

клацнувши один раз лівою кнопкою миші на обраному місці робочого поля документу 

(рис. 1, а). Оберіть точку кінця відрізку та натиснувши ліву кнопку миші на неї 

утримуйте кнопку зажатою (рис.1, б) і в той же час зміщайте покажчик миші в будь яку 

сторону, при цьому сегмент набуде криволінійний вигляд в залежності від ваших дій 

(рис. 1, в). При виконанні цих дій на вузлу з’являться керуючі викривленнями напрямні 

із стрілками. Обравши потрібний вид кривою кнопку миші слід відпустити.  Таким 

чином добудувавши решту частини об'єкта контур потрібно замкнути натиснув на точку 

з якої починалися побудови (рис. 1, г). 

 

а) б) в) г) 

Рис. 1. Створення об’єкту за допомогою інструменту «Кривая Безье» 

 

Для того щоб почати малювати інший об’єкт, або для закінчення роботи з текучим 

необхідно натиснути Enter або Esc. Для задання товщини абрису контуру необхідно 

обрати інструмент «Вибір» та виділити об’єкт натиснувши на нього. На панелі 

властивостей з’являться керуючі елементи завдяки котрим можливо настроїти 

параметри активного об’єкту (рис. 2). 

 
 
 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 2 Налаштування товщини обрису активного контуру 

Формування об’єктів 
Криві і лінії можна сформувати шляхом управління їх вузлами і сегментами   за   

допомогою   інструменту   «Форма»   , а також шляхом додавання і видалення 

вузлів при активному інструменті «Форма» (рис.3). 

 

Рис. 3. Керуючі елементі при редагуванні опорної точки інструментом 

«Форма» 

 

Щоб додати вузол, двічі клацніть шлях або клацніть шлях і натисніть кнопку «Добавить 

узлы»  на панелі властивостей. 

Щоб видалити вузол, двічі клацніть його або виберіть вузол і натисніть кнопку 

«Удалить узлы»  на панелі властивостей. 

Щоб зменшити число вузлів, виділіть їх рамкою за допомогою інструменту 

«Форма» і натисніть «Уменьшить число узлов»  на панелі властивостей. 

Вузли на об'єкті кривої можна змінити на один з чотирьох типів: перетин, згладжений, 

симетричний або лінія. Маркери управління кожного типу вузла працюють по-різному. 

Змінити тип вузла можливо за допомогою відповідної команди на панелі властивостей. 

 

 

 

 

 



4 Хід роботи: 

1. Відкрити документ «Лабораторні роботи». 

2. На сторінці «Лабораторна 1» користуючись інструментом «Кривая 

Бизье» зробіть замкнений контур подібний до наданого у прикладі (рис.2.4, 

а). 

3. Також за допомогою того ж інструменту у контурі зробленого об’єкту 

накресліть замкнені ділянки. Ввід кожної ділянки завершайте клавішею 

Enter або Esc. 

4. Збережіть файл натиснувши комбінацію клавіш «Ctrl»+S. 

 

  

а) б) в) 

Рис.2.4. Приклад кроків виконання роботи 

 

1. На сторінці з назвою «Лабораторна» створіть два графічних елемента:  

коло і прямокутник подібні до наданих у прикладі (рис.4.1), відповідними 

інструментами. 

2. Виділіть об’єкти та вирівняти їх за центрами (рис.4.2). 

3. Виділіть об’єкти та проведіть дію вирізання з кола прямокутника 

командою головного меню «Объект» – «Формирование» – «Исключить» 

(рис.4.3). 

4. Виділіть прямокутник та поверніть його на 45 градусів у будь-яку 

сторону (рис.4.4). Повторіть дію вирізання з кола прямокутника. 

Повертайте прямокутник та повторяйте дію вирізування з кола до 

отримання результату на прикладі (рис.4.5). 

5. Видалити прямокутник. Створіть окружність більшого за об’єкт 

радіусу із центру (зажати на клавіатурі під час створення окружності Ctrl і 

Shift) (рис.4.6). 

6. Зробіть заливки та задайте ширину обведення об’єктів відповідно до 

прикладу (рис.4.7). 

7. Згрупуйте усі об’єкти. Виділіть згрупований об’єкт та продублюйте 

його (комбінація клавіш Ctrl + D). Розмістить обидва об’єкти на подібної до 

наданої на прикладі відстані. Виділіть обидва об’єкти та вирівняйте їх по 

верхній грані (рис.4.8). 

8. Створіть прямокутник з кутами на центрах дубльованих об’єктів 

(рис.4.9). 

9. Перетворіть прямокутник в криві відповідною командою або 

комбінацією клавіш Ctrl + Q, за допомогою інструмента «Форма» надайте 

форму прямокутника подібну до приведеної на прикладі (рис.4.10). 

10. Створіть два прямокутника (рис.4.11), перетворіть їх у криві та надайте 

їм форму подібну до наданої у прикладі (рис.4.12). 



11. Створіть інші елементи та надайте їм відповідні кольори (рис.4.13). 

12. З допомогою інструменту «Кривая Безье» створіть лінії поєднання 

колеса та зірки (рис.4.14). 

14. Створіть два прямокутника над рамою, перетворіть їх в криві (рис.4.15). 

15. Надайте прямокутникам над рамою форму сідла. Створіть руль таким 

же чином (рис.4.16). 

16. Орієнтуючись на приклад виконання завдання створіть недостаючи 

елементи оформлення об’єкту (рис.4.17). 

17. Збережіть роботу натиснувши Ctrl + S. 
 

1) 2) 3) 4) 

Рис.4 Приклад кроків виконання роботи 

 
 

    

5) 6) 7) 8) 
 

9) 10) 11) 12) 

 

13) 14) 15) 

 

16) 17) 

Рис.4 Приклад кроків виконання роботи 

 



 

 

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навичок з редагування графічних об’єктів. Навчитися використовувати 

прив’язки при розташуванні графічних об’єктів в документах. Вивчити 

принципи вирівнювання об’єктів  
 

 

 

6 Контрольні запитання 

 

6.1 Чи можливо тимчасово приховати зображення на певних шарах? 

6.2 Чи можна видалити усі шари з документу? 

6.3 Яким чином можливо трансформувати фоновий шар у звичайний або 

навпаки? 

6.4 Які є інструменті створення контурів вільної форми. 

6.5 Чи є можливість створити стандартну геометричну фігуру? 

6.6 Якім чином можливо змінити товщину контуру об’єкту? 
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Інструкція для виконання лабораторної роботи №11 
 

Тема: Заповнення і кольори.  

1 Мета: набути навичок з надання графічним об’єктам кольору заливок та 

обвідок. Розглянути типи заливок і методи їх редагування та налаштування.  

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Векторний графічний редактор CorelDraw » 

Типи заливки 

Об'єкт можна заповнити однорідною або фонтанної заливкою, а також заливками 

візерунка, текстури, сіткою або заливкою PostScript. 

 

 

 

 

 

Однорідні заливки являють собою суцільні кольори, які 

можна вибрати або створити за допомогою колірних 

моделей і колірних палітр. 

Фонтанна заливка (градієнтна) – це змішана заливка з двох і 

більше кольорів з плавними переходами. Можна також 

застосувати до об'єкта заливку векторною графікою 

(заливка векторним візерунком) або растровими 

зображеннями (заливка растровим візерунком). 

Щоб застосувати заливку до об'єкта, в області «Заливка» вікна налаштування «Свойства 

объекта» виберіть тип заливки і вкажіть необхідні параметри. Щоб застосувати заливку 

сіткою, використовуйте інструмент 

«Заливка сеткой» . 

Вибір кольорів 

Палітра кольору – це набір зразків кольору. Кольори заливки і 

абриси можна вибирати за допомогою кольорової палітри за 

замовчуванням. Вибрані кольори заливки і абрису відображаються 

в полях зразків кольору у рядку стану. 

Для заливки об'єкта суцільним (однорідним) кольором клацніть зразок кольору в 

кольоровій палітрі або перетягніть зразок на об'єкт. 

Для зміни кольору абрису правою кнопкою миші клацніть зразок кольору в кольоровій 

палітрі або перетягніть зразок на абрис об'єкта. 

Щоб змішати кольори, виберіть пофарбований об'єкт, натисніть клавішу Ctrl і клацніть 

інший колір в кольоровій палітрі. 

Для вибору відтінку кольору клацніть і утримуйте зразок кольору. 

Можна також вибрати колір заливки і абрису в діалогових вікнах вибору кольору. Для 

цього натисніть кнопку «Заливка»  або «Абрис»  в рядку стану. 

 

 

 



4 Хід роботи: 

1. Відкрити документ «Лабораторні роботи». 
2. На сторінці «Лабораторна 1» користуючись інструментом «Выбор» 

виділити один з сегментів. 

3. Оберіть на палітрі кольору необхідний колір та клацніть на ньому лівою 

кнопкою миші (рис.1, а). Виділений сегмент буде закрашено обраним 

кольором. 

4. Далі користуючись інструментом «Выбор» почергово виділяйте та 

заливайте різними типами заливок усі сегменти об’єкту (рис.1, б). 

5. Збережіть файл натиснувши комбінацію клавіш «Ctrl»+S. 
 

а) б) 
Рис.1 Приклад виконання завдання 

 

1. Намалювати прямокутник за допомогою інструмента 

Rectangle Tool розміром 70*50. 

 

2. Застосувати до нього Inter- active Distortion Tool  - 

. Якщо тягнути зх середини прямокутника, то 

отримаємо квітку з однаковими пелюстками, якщо 

поставити курсор ближе до краю прямокутника, то 

отримаємо нерівну квітку (зробити будь-яку квітку) 

 

 

 

3. Фігури, яку отримали скопіювати тричі. Одну 

відкласти в сторону. На інших провести наступні зміни 

(першу та третю копії залишити одного розміру). Одну 

зменшити з кута (натиснув кнопку shift). 

 
4. Зменшену фігуру залити кольором C0, M7, Y17, K0, 
першу – кольором C35 , M0, Y0, K0. Контури безколірні 
(вкладка OutLine). 

 

 



5. До них застосувати Interactive Blend Tool . 

 

6. Теперь перейти до відкладеної фігури. Заповнити її 

білим кольором, колір контуру C35, M0, Y0, K0 та 

застосувати до нього Interactive Transparency Tool  . 

На панели атрибутів вказати заливку Radial замість Li- 

near 

 

7. Розмістити цю фігуру на попередні. За допомогою 

Align and Distribute задати вирівнювання за центром. 

 

8. Теперь намалювати середину квітки. Спочатку 

намалювати коло за допомогою Elipse Tool (натиснув 

кнопку ctrl). 

 

9. Застосувати до нього Inter- active Distortion Tool   з 

середини. 

 

10. Отримане зображення скопіювати, переміщуючи 

навколо осі, поки коло заповниться. Колір контуру та 

заливки на власний розгляд. 

 



11. Згрупувати їх, зменшити та вставити до центру 

першої групи. Квітка готова. 

 

13. Тепер почнемо малювати гілку з використанням 

Freehand   Tool    . Гілка складається з трьох частин. 

 
14. Скопіювати кожну частину.  

 

 
15. До першої гілки застосувати Interactive Contour Tool   

    (колір контуру та забарвлення C0, M60, Y60, K40). 

 

16. Копію залити C0, M46, Y100, K11 кольором, та 

застосувати до неї Interactive Transparency  Tool  . А 

потім додати на попередню та створити групу. 

 

17. Додати квітки на гілку. 

 



18. На одній із квітків можна побачити листок. Щоб 

отримати цю фігуру, намалювати овал за допомогою 

Elips Tool, застосувати до нього In- teractive    Distortion    

Tool . Потім Interactive Contour Tool       (колір 

заливки C68, M0, Y100, K24, контура C40, M0, Y100, K0). 

 

19. Виділити весь малюнок, згрупувати та застосувати до 

нього Interactive Drop Shadow Tool  . 

Результат нижче. 

 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навичок з надання графічним об’єктам кольору заливок та обвідок, вивчити 

типи заливок і методи їх редагування та налаштування. 

 

6 Контрольні запитання 

6.1 Чи можливо за допомогою палітри кольору змінити колір заливки та 

колір контуру об’єкта? 

6.2 Що таке фонтанна заливка? 

6.3 Яким чином нанести текстурну заливку? 

6.4 Що таке палітра кольорів? Як налаштувати палітру кольорів в програмі 

CorelDRAW? 

6.5  Перерахуйте типи заливок, доступних в CorelDRAW. 

6.6  Які можливості по налаштуванню однорідної заливки предоставляє 

CorelDRAW? 

6.7 Як виконується копіювання властивостей заливки з одного об'єкт на 

інший? 

6.8 Для чого використовується інструмент Інтерактивна заливка? 

6.9 Для чого застосовуються інструменти Піпетка і Ковш? 



6.10 Які можливості по налаштуванню градієнтної заливки надає 

CorelDRAW? 
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Інструкція для виконання лабораторної роботи №12 
 

Тема: Робота з текстом у CorelDraw. 

1 Мета: Ннабути навичок роботи з перетворенням текста.  

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Векторний графічний редактор CorelDraw » 

 

4 Хід роботи: 

Завдання 1. Отримання зображення «Ламаний дерев'яний текст» в 

CorelDRAW 
 

1. Виокремте текстовый обєкт   та натиснув кнопку Edit 

Text панелі Property Bar (Панель властивостей), можна 

відкрити діалог редагування тексту. Робота в цьому діалозі 

немає відрізняється від роботи з простим текстовим 

редактором. Вибравши шрифт Arial Black, 150), отримати 

напис 

 

 

2. Видалити абрис -  та вибрати  в якості заливки 

текстуру  - , яка імітує дерево. 

  

 

3. Перетворити текст в криві (Arrange – Convert to Curve).  

4. За допомогою інструменту Ластик (Eraser Tool) 

сформувати тріщини в тексті 
  

 

5. Додати тінь Interactive Drop Shadow Tool – Presets 
(переглянути можливі варіанти) 

 

 

 



 

Завдання 2. Перетворення тексту 

 

1. Написати текст, який пізніше треба перетворити в форму 

машини. Намалювати об'єкт: прямокутник - корпус 

машини, окружності - два колеса, окружності - виїмки з 

боків і центральний овал для кузова 

 

WRECKERS 

2. Виділити прямокутник і верхній овал - кнопка Arrang 

- Shaping - Weld, потім виокремити форму, яка вийшла  і 

окружності по кутах - кнопка Arrang – Shaping - Font 

Minus Baik  Теперь колеса та корпус – знову Arrang – 

Shaping - Trim. 

Має вийти щось таке: 
 

 

 

3.  Зменшити трохи колеса, нахилити їх вліво і залити синім 

 

 

 

4.  Інструментом Shape виділити і видалити два крайніх 

верхніх вузла справа і зліва кузова, за допомогою 

перетягування вузлів, додати машині вид як на картинці 

 

 



 

Завдання 3. Ефект розірваної фотографії 

 
1. Створити об'єкт Powerclip. 

Імпортувати фотографію в документ CorelDraw (Ctrl + I). 

Нижче намалювати прямокутник. Виділити фотографію і 

перетягнути її, утримуючи праву (!) Кнопку миші на 

порожній прямокутник. Після того як курсор змінить 

форму і стане схожий на приціл, відпустити миша. У 

діалоговому меню вибрати Powerсlip inside. 
 

 

 

2. За допомогою       намалювати зигзагоподібну лінію по 

центру прямокутника. Намалювати ще дві таких лінії 

ближче до кутів прямокутника. 

           

 

3.Виділити зображення та натиснути      (Ctrl+K).  

 

Ми розіб'ємо картинку на три шматки. Цілісні фрагменти 

можна відокремити один від одного за допомогою 

команди Arrange-Break RGB Bitmap Apart. 

Далі видалити всю обведення. Пересунути отримані 

шматочки в сторони, повернути деякі з них. 

 

 

 

 

5.  Перетворити текст в криві. Відкрити докер Envelope (Ctrl 

+ F7). Виділити текст і натиснути на іконку піпетки внизу 

докера (Create from). З'явиться жирна стрілка - клікнути їй 

на машині. Потім вибрати в діалоговому вікні докера 

напрямок Vertical і натиснути Apply. 

 

 

6. Перемістити створений об'єкт на місце старого контуру, 

старий контур видалити. Залити машинку червоним 

кольором 
 

 

Таким чином, можна використовувати будь-який об'єкт для 

створення Envelope. У нього надалі буде міститися текст, 

якому буде надано форму цього об'єкту 
 . 

 



4. Додати тінь кожному шматочку. Для цього виділити всі 

об'єкти, вибрати інструмент  Interactive Drop Shadow Tool 

 і потягнути від центру групи об'єктів вниз. 

Налаштувати параметри тіні в 

панелі властивостей 

 

 

 

 

 

5. Надрукувати який-небудь текст. Використовувати різні 

шрифти і різні масштаби 

 

 

 

6. Намалювати прямокутник, більший, ніж всі зображення 

і трохи скруглить його кути. 

 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навичок роботи з текстом. 
 

Контрольні запитання 

6.1 Які перетворення можна здійснювати над текстом в CorelDRAW за 

допомогою діалогу редагування тексту? 

6.2 Як перетворити текст в криві лінії? Що це дає для подальшої роботи? 

6.3 Як здійснити заливку фігури візерунком? 

6.4 Який інструмент для роботи з тінню існує в CorelDRAW? 

6.5 Призначення вкладки Shaping. 

6.6 Призначення докера докера Envelope. 

6.7 Призначення об'єкта Powerclip. 
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— К.: Вид. група BHV, 2009. — 400 с: іл. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 
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Інструкція для виконання лабораторної роботи №13 
 

Тема: Робота з графічними ефектами у CorelDraw. 

1 Мета: набути навичок роботи з інструментами додавання спеціальних 

ефектів графічним векторним об’єктам. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Векторний графічний редактор CorelDraw » 

Пункт меню «Эффекты» 

Команди ефектів програми CorelDRAW знаходяться в спеціальному меню 

«Эффекты». Проте це не єдині ефекти в програмі, також існують спеціальні ефекти 

для растрових об'єктів (команди меню «Растровые изображения») і деякі команди 

для тексту, які можна виділити в спеціальні ефекти для текстових об'єктів. Основні 

ефекти можуть застосовуватися до різних типів об'єктів, але основне їхнє 

призначення – це зміна векторних об'єктів і фігурного тексту. 

Динамічні графічні ефекти – одна з найбільш вдалих особливостей програми 

CorelDRAW. Вони дозволяють швидко створювати складні, вражаючі групи 

об'єктів, якими можливо легко і наочно керувати. Основна частина розглянутого 

пункту меню (рис. , а) присвячена саме ефектам. Крім того, в ньому присутні 

команди корекції кольору. Доступ до інструментів створення ефектів також 

можливий з набору інструментів (рис. 1, б) 

 

а) б) 
Рис. 1. Команди меню «Эффекты» 

 

Для об'єктів можливо створювати ілюзію тривимірного простору, додавши ефекти 

контуру, тіні або скоса. 

 

 

 

 



4 Хід роботи: 

1. Відкрити документ «Лабораторні роботи». 

2. На сторінці з назвою «Лабораторна 3» створіть прямокутник (рис.2, 1). 

Переведіть його в криві (Ctrl +Q). 

3. Інструментом «Форма» надайте його форму близьку до наданої у 

прикладі (рис.2, 2). 

4. Продублюйте об’єкт (Ctrl + D), зменшить масштаб дубльованому 

об’єкту. Виділить два об’єкта та відцентруйте по горизонталі і вертикалі 

відносно друг друга (рис.2, 3). 

5. Надайте заліку нижньому об’єкту (рис.2, 4). 
6. Виділіть обидва об’єкти та виріжте з нижнього верхній відповідної 

командою на панелі властивостей (рис.2, 5). 

7. Верхньому об’єкту (склу) задайте заливку обраним кольором. За 

допомогою інструмента «Прозрачность» нанесіть фонтанну прозорість на 

верхній об’єкт (рис.2, 6). 

8. Виділіть усі об’єкти та згрупуйте їх (Ctrl + G). Продублюйте групу (Ctrl 

+ D), дубльований об’єкт розташуйте справу. Виділіть обидва об’єкта та 

вирівняйте по верхній грані об’єктів (рис.2, 7). 

9. Створіть прямокутник між вдома половинами окулярів (рис.2, 8). 

Трансформуйте прямокутник у криві (Ctrl + Q). 

10. Задайте прямокутнику форму схожу на наведену у прикладі (рис.2, 9). 

За допомогою прямокутників та їх редагування завершіть побудову 

окулярів (рис.2, 10). 

11. Створіть аналогічні окулярі з круглими стеклами (рис.2, 10). 
12. Збережіть роботу (Ctrl + S). 

 

1)                                          2)                                       3) 
 

4) 5) 6) 

Рис. 2 Приклад виконання роботи 



 

 

 

7) 8) 9) 
 
 

10) 11) 

Рис. 2 Приклад виконання роботи 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має 

засвоїти набути навичок з роботи з інструментами додавання спеціальних 

ефектів графічним векторним об’єктам. 

 

 

 

6 Контрольні запитання 

 

6.1 Які методи утворення прозорості для об’єктів має інструмент надання 

прозористі? 

6.2  Чи можливо при створенні тіні задавати кут її падіння відносно об’єкту? 
6.3 Чи можливо видалення ефекту застосованого до об’єкту? 
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Інструкція для виконання лабораторної роботи №14 
 

Тема: З'єднання об'єктів. Побудова об'єкта складної форми шляхом 

об'єднання. Перетинання об'єктів. Виключення об'єктів. Розрізування і 

надрізання об'єктів. 

1 Мета: познайомитися з ефектом виникнення прозорої області при з'єднанні 

об'єктів, що перекриваються. Познайомитися з виконанням операції 

об'єднання кількох об'єктів. Ознайомитися з виконанням операції 

перетинання об'єктів, освоїти прийоми перетворення контурної лінії в об'єкт. 

Познайомитися з операцією виключення у програмі CorelDraw.  

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Дії з об’єктами в програмі CorelDraw» 

 

4 Хід роботи: 
1 Створіть новий документ CorelDraw. Побудуйте посередині сторінки 

великий прямокутник і перетягніть на нього жовтий зразок кольору з екранної 

палітри. Поверх жовтого прямокутника побудуйте синій, а потім — червоний 

прямокутники, розмістивши їх таким чином, щоб вони не виходили за краї жовтого 

прямокутника, але частково перекривали один одного.  

2 Виділіть спільно синій і червоний прямокутники і клацніть на кнопці 

Combine (З'єднати) Панелі атрибутів. Зверніть увагу на повідомлення в рядку 

стану — там говориться, що виділено один об'єкт класу «крива». Колір з'єднаного 

об'єкта буде залежати від того, який із прямокутників був виділений останнім, але в 

тій його частині, де об'єкти, що з'єднуються, перетиналися, буде видний жовтий 

колір. Щоб переконатися, що це — дійсно отвір, виділіть жовтий прямокутник і 

призначте йому заливання іншого кольору.  

3 Знову виділіть з'єднаний об'єкт і клацніть на кнопці Break Apart (Роз'єднати) 

Панелі атрибутів — на ній зображені саме два квадратики, що перекриваються і 

стрілки, що ніби розтягують їх у різні сторони. Зверніть увагу на колір об'єктів, що 

вийшли, і на їх розміщення у стопці - зверху знаходиться той із квадратів, що перед 

з'єднанням був виділений останнім і який передав свої колір з'єднаному об'єктові. 

Збережіть отриманий результат. 

4 Вставте у документ нову сторінку, клацнувши на знаку «плюс» у зоні 

прокручування сторінок документа, і побудуйте за допомогою інструмента Polygon 

(Багатокутник) приблизно посередині сторінки витягнутий по вертикалі 

восьмикутник розмірами приблизно 40 на 90 мм.  

5 Відкрийте пристиковуване вікно Transformation (Перетворення) 

однойменною командою меню Window / Dockers (Вікно / Пристиковувані панелі). У 

групі перемикачів вибору місця розташування центра обертання клацніть на 



нижньому середньому перемикачу, щоб сполучити центр обертання з нижнім 

кутом восьмикутника. У лічильник Angle (Кут) введіть значення 15° і кількома 

клацаннями на кнопці Apply To Duplicate (Застосувати до копії) перетворіть 

восьмикутник у витончену розетку (рисунок 1, а).  

 

Рисунок 1 - Розетка 

6 Розтягнуши рамку виділення, спільно виділіть усі об'єкти і задайте товщину 

контурної лінії в 4 пункти. Колір обведення і заливання об'єктів виберіть на 

власний розсуд. Після призначення заливання відразу стає очевидним положення 

об'єктів у стопці (рисунок 1, б).  

7 Залишилося тільки з'єднати усі восьмикутники, клацнувши на кнопці 

Combine (З'єднати) на Панелі атрибутів.  

8 Спробуйте побудувати ту саму розетку ще раз, але на кроці 5 скористайтеся 

елементами пристиковуваного вікна Transformation (Перетворення) для зміщення 

центра обертання нижче середнього нижнього маркера рамки виділення. 

Установіть прапорець Relative Center (Відносно) і введіть у лічильник Н значення -

90. Після виконання інших кроків вийде розетка (рисунок 1, в), у середині якої 

замість накопичення ліній контурів буде отвір. Збережіть отриманий малюнок. 

9 Намалюйте пляшку (рисунок 2). Почніть з побудови прямокутника, 

витягнутого по горизонталі, розміром приблизно 100 на 70 мм. За допомогою полів 

Панелі атрибутів приведіть розміри до точних значень і закругліть два з чотирьох 

кутів прямокутника.  

 

Рисунок 2 – Зображення пивної пляшки 

10 Побудуйте правильне коло діаметром 70 мм. Щоб точно сполучити її діаметр 

із правим краєм прямокутника, увімкніть режим прив'язки до об'єктів командою 

View / Snap To Objects (Вид / Прив'язати до об'єктів) і перемістіть коло на місце 

інструментом Pick (Вибір).  

11 Вимкніть режим прив'язки до об'єктів тією самою командою.  



12 Побудуйте два еліпси і прямокутник, спільно виділіть їх і вирівняйте по 

правому краю виділення. Утримуючи клавішу Shift натиснутою, додайте у 

виділення коло або прямокутник і вирівняйте усі фігури по середині виділення, 

сполучивши їх середини на одній горизонтальній лінії — геометричної осі пляшки 

(рисунок 2, зверху).  

13 Виділіть індивідуально прямокутник із двома закругленими кутами і 

призначте йому заливання 10 % чорним. Розтягніть прямокутник виділення 

навколо всіх об'єктів і клацніть на кнопці Quick Weld (Швидке об'єднання) Панелі 

атрибутів. Оскільки прямокутник побудували раніше інших об'єктів, він виявився 

нижнім у стопці, і, отже, об'єднаний об'єкт успадкував саме його заливання.  

14 На закінчення побудуйте кілька відблисків на поверхні пляшки. Кожний з 

них є колом без обведення з радіальним градієнтним заливанням з переходом 

кольору від білого в середині до 10 % чорного на периферії. Достатньо побудувати 

тільки одне коло — інші відблиски створюються копіюванням і зміною розмірів 

копій із розміщенням у потрібних місцях малюнка (рисунок 2, знизу). Збережіть 

малюнок. 

15 Зобразіть фрагмент крученої пари — два відрізки проводу різного кольору, 

скручені один з одним (рисунок 3). Для початку зобразіть один із проводів. За 

допомогою інструмента Bezier (Крива Безьє) побудуйте короткий вертикальний 

відрізок прямої. Увімкніть режим прив'язки до об'єктів і перетягніть побудований 

відрізок інструментом Pick (Вибір) чітко вниз до сполучення початкового вузла 

нового положення з кінцевим вузлом колишнього положення. Перед тим як 

відпустити ліву кнопку мишки, клацніть її правою кнопкою. Повторіть зсув униз з 

копіюванням ще два рази. У результаті вийдуть чотири вертикальних відрізки, 

причому у другого, третього і четвертого початкові вузли збігаються з кінцевими 

вузлами попередніх відрізків.  

 

Рисунок 3 – Зображення крученої пари 

16 Перетворіть ці чотири відрізки в криву, що складається з чотирьох сегментів. 

Для цього їх варто спільно виділити і з'єднати, клацнувши на кнопці Combine 

(З'єднати) Панелі атрибутів. Тепер у вашому розпорядженні є крива, що 

складається з чотирьох ділянок. Щоб перетворити з'єднану криву в звичайну, 

потрібно вибрати інструмент Shape (Форма) і по черзі виділити їм пари вузлів у 

місцях з'єднання відрізків (найкраще — розтягуючи рамку виділення навколо 

здвоєних вузлів), клацаючи після виділення на кнопці Join Two Nodes (З'єднати 

вузли) Панелі атрибутів. У результаті вийде крива, що містить в одній ділянці 

п'ять вузлів, розміщених на краях чотирьох лінійних сегментів (рисунок 3, а).  



17 Оскільки провід повинен згинатися, сегменти, що складають криву, варто 

перетворити в криволінійні. Виділіть усі вузли кривої, розтягнувши навколо неї 

рамку виділення інструментом Shape (Форма), і клацніть на кнопці Convert Line To 

Curve (Криволінійний сегмент) Панелі атрибутів. Виділіть вузли кривої через 

одним інструментом Shape (Форма) при натиснутій клавіші Shift і змістіть їх по 

горизонталі на деяку відстань (це зручніше за все робити клавішами керування 

курсором). Тепер у нас вийшла хвиляста крива (рисунок 3, б).  

18 Далі необхідно перетворити криву в об'єкт із заливанням. Як правило, 

CorelDraw надає для вирішення цього завдання кілька можливостей (наприклад, за 

допомогою суперліній). Скористайтеся командою перетворення контурної лінії в 

самостійний об'єкт. Виділіть криву інструментом Pick (Вибір) і задайте товщину 

контурної лінії. Оскільки ця товщина визначає діаметр проводу, можливо, для 

практичних цілей її краще б задавати за допомогою діалогового вікна Outline Pen 

(Перо для контурів), але обмежтеся стандартною товщиною 16 пунктів. Призначте 

колір контурної лінії (наприклад, жовтий), клацнувши правою кнопкою мишки на 

відповідному зразку екранної палітри (рисунок 3, в). Виберіть команду Arrange / 

Convert Outline To Object (Монтаж / Перетворити контур в об'єкт) і відкрийте 

пристиковуване вікно диспетчера об'єктів. З наведених у ньому відомостей ясно, 

що після перетворення на малюнку залишилися два об'єкти: замкнута крива з 

жовтим заливанням, що утворилася в результаті перетворення, і незамкнута крива 

без заливання й обведення — це те, що залишилося від вихідної кривої. Другу 

криву варто видалити, оскільки вона більше не знадобиться.  

19 Тепер побудуйте другий провід як дзеркальне відображення першого. 

Виділіть жовтий провід інструментом Pick (Вибір), натисніть клавішу Ctrl і 

перетягніть правий середній маркер рамки виділення вліво до появи ліворуч від 

проводу його «фантомної» копії синього кольору. Перед тим як відпустити ліву 

кнопку мишки, клацніть її правою кнопкою. Призначте побудованій дзеркальній 

копії заливання (наприклад, червоне) (рисунок 3, г). 

20 Тепер проводи необхідно сполучити. За причин, описаних вище, після цього 

вони розмістяться один над одним. Виділіть обидва об'єкти і скористайтеся 

діалоговим вікном Align and Distribute (Вирівняти і розподілити), щоб сполучити 

їх вертикальні осі (рисунок 3, д). У вікні диспетчера об'єктів видно, що зараз 

малюнок складається з двох об'єктів класу кривих, причому об'єкт із жовтим 

заливанням розміщений у стопці вище об'єкта з червоним заливанням.  

21 Виділіть жовтий провід, клацнувши на ньому інструментом Pick (Вибір), 

виберіть альтернативу Intersection (Перетинання) у списку, що розкривається, 

пристиковуваного вікна Shaping (Формоутворення) і потім клацніть на кнопці 

Intersect With (Перетнути з). Клацніть по червоному проводу, не натискаючи 

клавіші Shift. У результаті (рисунок 3, е) здається, що проводи помінялися місцями 

в стопці об'єктів і червоний тепер лежить вище. Вікно диспетчера об'єктів 

допомагає розвіяти ілюзію: насправді в місцях перетинання проводів утворився 

новий з'єднувальний об'єкт, що успадкував червоний колір від зазначеного об'єкта 

— червоного проводу, і складається з чотирьох ділянок, що мають форму, близьку 

до ромба.  

22 Залишається тільки доробити виниклу ілюзію, видаливши ромбовидні 

об'єкти через один. Для цього виділіть з'єднувальний об'єкт, клацнувши 

інструментом Pick (Вибір) на будь якому з ромбів, і розбийте його на окремі 

ділянки командою Arrange / Break Apart (Монтаж / Роз'єднати). Скасуйте 



виділення, натиснувши клавішу Esc, виділіть при натиснутій клавіші Shift два 

ромбовидних об'єкти і видаліть їх, натиснувши клавішу Del. Ілюзія побудована, і 

там, де червоний провід повинен був би перекривати жовтий, це роблять точно 

підігнані за формою червоні ―латки‖. Збережіть малюнок. 

23 Побудуйте зображення однієї з половинок дошки для гри в нарди (рисунок 

4). Почніть з побудови невеликого правильного кола. За допомогою клавіші ―+‖ 

(плюс) допоміжної клавіатури побудуйте поверх кола п'ять копій. Перетягнувши 

верхню в стопці об'єктів копію вправо на достатню відстань, виділіть всі об'єкти і 

рівномірно розмістіть їх на горизонтальній прямій за допомогою діалогового вікна 

Align and Distribute (Вирівняти і розподілити).  

24 Побудуйте прямокутник, що перекриває нижні частини кіл, і за допомогою 

того самого діалогового вікна вирівняйте його по горизонталі симетрично колам 

(рисунок 4, праворуч угорі). 

 

Рисунок 4 – Зображення дошки для гри у нарди 

25 Виділіть спільно всі шість кіл — вони будуть відігравати роль сукупності 

виділених об'єктів. Розкрийте пристиковуване вікно Shaping (Формоутворення) і 

виберіть у списку, що розкривається, альтернативу Trim (Виключення). Елементи 

керування виключенням цілком аналогічні до елементів керування об'єднанням і 

перетинанням. Установіть прапорець Source object(s) (Зберегти виділені) і клацніть 

на кнопці Trim With (Виключити з). Перетягніть об'єкт, що утворився у результаті, 

(рисунок 6.4, праворуч унизу) трохи нижче.  

26 Увімкнувши режим прив'язки до об'єктів, побудуйте прямокутник, що 

обмежує ігрове поле, розпочавши з лівого нижнього кута тільки що побудованої 

«гребінки». Побудуйте копію «гребінки», перетягніть її до верхнього краю ігрового 

поля і поверніть на 180°, утримуючи натиснутої клавішу Ctrl. Вимкніть режим 

прив'язки до об'єктів. Виділіть прямокутник ігрового поля і, утримуючи 

натиснутою клавішу Shift, перетягніть догори і вправо правий верхній маркер 

рамки виділення. Перед тим як відпустити ліву кнопку мишки, клацніть правою 

кнопкою. Геометричні форми половини ігрової дошки готові.  

27 Щоб зобразити шашку, перетягніть кут рамки виділення кола усередину, 

утримуючи натиснутою клавішу Shift, і перед відпусканням лівої кнопки мишки 

клацніть правою кнопкою. Згрупуйте два кола і побудуйте копію групи, а потім 

змістіть її вправо. Для однієї із шашок зробіть контурні лінії білими, а заливання 

чорним, для іншої — навпаки. Додаткові шашки створіть копіюванням. Розміщати 

шашки в лунках дошки краще при увімкненому режимі прив'язки до об'єктів.  



28 Призначте для ігрового поля і бортів дошки текстурне заливання. За 

характером зображуваного об'єкта непогано підійде заливання з бібліотеки 

Samples8 під назвою Wood Grain (Волокна деревини). Збережіть результат. 

29 Потрібно зобразити розірваний навпіл трафарет для нанесення напису 

фарбою (лист пластику з вирізаними в ньому буквами). Побудуйте прямокутник, 

витягнутий у горизонтальному напрямку, і задайте для нього заливання. Побудуйте 

блок фігурного тексту, виконайте форматування його потрібною гарнітурою і 

кеглем і розмістіть посередині прямокутника. Інструментом Freehand (Довільна 

крива) побудуйте поперек прямокутника і напису досить звивисту криву (рисунок 

5, зверху). 

 

Рисунок 5 – Зображення трафарету 

30 Тепер «розірвіть» фоновий прямокутник. Виділіть криву, розміщену над 

ним, і клацніть на кнопці Trim With (Виключити з) пристиковуваного вікна Shaping 

(Формоутворення), а потім — на самому прямокутнику. Через прямокутник 

пройшла тріщина, що розбила його по горизонталі на дві частини. Відзначимо, що 

побудований у результаті виключення об'єкт потрапив до самого верху стопки 

об'єктів, через що напис виявився цілком перекритим.  

31 За допомогою вікна диспетчера об'єктів або команди Arrange / Order / То 

Back (Монтаж / Порядок / Униз) перемістіть результат виключення в самий низ 

стопки об'єктів. Повідомлення в рядку стану говорить про те, що виділено всього 

один об'єкт класу кривих. Командою Arrange / Break Apart (Монтаж / Роз'єднати) 

роз'єднайте дві ділянки кривої — тепер існують дві криві, без зазорів, що 

сполучаються по звивистій границі, і напис.  

32 Перетворіть букви напису в отвори в трафареті. Для цього виділіть напис 

інструментом Pick (Вибір), зніміть обидва прапорці пристиковуваного вікна 

Shaping (Формоутворення), виберіть у списку, що розкривається, альтернативу 

Trim (Виключення), а потім, при натиснутій клавіші Shift, клацніть на верхній і 

нижній частинах колишнього фонового прямокутника. Трафарет готовий, 

залишається тільки підкреслити, що він розірваний.  

33 Злегка поверніть верхню частину трафарету, розширивши тріщину в її правій 

частині. Виділіть верхню частину інструментом Pick (Вибір), потім клацніть 

мишкою ще раз, щоб у рамці виділення з'явилися стрілки повороту, і перетягніть 

маркер центра повороту (кружок із точкою посередині) у точку, де тріщина 

перетинає лівий край трафарету. Збільшіть масштаб відображення й уточніть 

положення центра повороту. За допомогою відповідного поля Панелі атрибутів 

поверніть верхню частину трафарету рівно на один градус (рисунок 5, унизу). 

Збережіть результат. 



34 Потрібно зобразити яйце, що лопається, але ще не лопнуло до кінця (рисунок 

6). Спочатку зобразьте ціле яйце. Для цього побудуйте білий еліпс, перетворіть 

його в криву, виділіть інструментом Shape (Форма) розміщений праворуч вузол і 

трошки перетягніть його вліво при натиснутій клавіші Ctrl (щоб не порушити 

симетрію). Це буде білок. Потім надягніть на білок шкарлупу: натиснувши клавішу 

―+‖ (плюс), побудуйте дублікат об'єкта і задайте для нього заливання бежевого 

кольору. Кількома послідовними клацаннями інструментом Bezier (Крива Безье) 

побудуйте ламану лінію, що перетинає границю яйця.  

 

Рисунок 6 – Зображення яйця 

35 Розколіть тільки що зображене яйце. Для цього виділіть інструментом Pick 

(Вибір) ламану лінію, зніміть обидва прапорці у пристиковуваному вікні Shaping 

(Формоутворення), клацніть на кнопці Trim With (Виключити з), а потім — на 

бежевому об'єкті. Ламана лінія зникла, а по шкарлупі яйця пішла тріщина. Виберіть 

інструмент Shape (Форма) і переконайтеся, що об'єкт, що утворився - не складена, 

а звичайна крива, що складається усього з однієї ділянки.  

36 Трішки розширте тріщину, щоб через неї був видний білок. Для цього 

інструментом Shape (Форма) виділіть при натиснутій клавіші Shift усі вузли 

тріщини. Клацніть на кнопці обертання вузлів на Панелі атрибутів, перетягніть 

маркер центра обертання на вершину тріщини і змістіть правий нижній маркер 

рамки виділення у вигляді стрілки трішки вниз. Тріщина в бежевому об'єкті 

розшириться і крізь неї покажеться білок. Збережіть результат. 

 

5 Висновки: в процесі виконання лабораторної роботи студент має засвоїти  

навички з'єднання, перетинання, виключення об'єктів.  

 

6 Контрольні запитання 

 

6.1 Як згрупувати об’єкти? 

6.2 Які типи з’єднання об’єктів ви знаєте? 

6.3 Як виконати перетин об’єктів? 

6.4 Як з’єднати і роз’єднати об’єкти? 

6.5 Як роз’єднати об’єкти? 

6.6 Як перетворити об’єкт у криву? 

6.7 Як виконати надрізання об’єкта? 

6.8 Як виконати розрізання об’єкта? 

6.9 Як об’єднати об’єкти? 

6.10 Як відокремити об’єкти? 
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Інструкція для виконання лабораторної роботи №15 

 

Тема: Використання інтерактивних інструментів у CorelDraw 

1 Мета: вивчення можливостей використання інтерактивних інструментів 

для створення складних зображень. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 

 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Використання 

інтерактивних інструментів у CorelDraw» 

 

4 Хід роботи: 

Завдання 1. Намалюйте грушу за зразком: 

 

1. Використовуючи інструменти Еліпс через З точки та Прямокутник, 

побудувати відповідні       фігури. 

2. Використовуючи інструмент Інтерактивна оболонка, надайте цим 

фігурам потрібного вигляду: 



 

3. Виконайте заливку груші градієнтною заливкою: у списку типів заливки 

виберіть Радіальна та встановіть два кольори градієнтного перетікання: світло-

коричневий та темно-коричневий. Змініть розташування центру заливки. Виконайте 

заливку хвостика груші. 

4. Перемістіть зображення черенка до зображення груші. За допомогою інструмента 

Довільна форма намалюйте груші «чубчик». Збережіть його у файлі Груша.cdr. 

Завдання 2. Створіть зображення за зразком. 

 

1. Активізуйте інструмент Багатокутник. На панелі властивостей виберіть 

кількість кутів — 8. В робочій області намалюйте восьмикутник — це буде основа 

квітки. 

 

2. Виберіть інструмент Інтерактивне викривлення. На панелі властивостей 

оберіть режим використання цього інструмента — Викривлення під час 

стиснення та. Встановивши вказівник всередині восьмикутника ближче до його 

лівого краю і утримуючи натиснутою ліву кнопку миші,

 починайте переміщувати вказівник так, щоб 

отримати зображення, показане на рис. б. 

3. До зображення контуру квітки додайте зображення серцевини у вигляді 

кола. Зафарбуйте квітку, використовуючи радіальну градієнтну заливку (кольори 

градієнтного перетікання світло- рожевий і темно-рожевий). Аналогічно 

зафарбуйте зображення серцевини квітки.(рис. в.) 

4. Створіть зображення листочка. Для цього активізуйте інструмент 

Еліпс через З точки. 



 

5. Активізуйте інструмент Інтерактивне викривлення ( режим його 

застосування — Викривлення «застібка-блискавка»). Побудуйте листочок. 

Зафарбуйте отримане зображення, використовуючи режим градієнтної заливки. 

 
6. Виберіть інструмент Інтерактивне викривлення (Викривлення під час 

крутіння). Перемістіть вказівник миші до зображення листочка та обережно його 

«закрутіть». Намалюйте на листку прожилки, скориставшись інструментом Перо. 

7. Розмістіть квітку і листочок на стебельцях. Квітка.cdr. 

Завдання 3. Побудуйте фігуру, дотримуючись такої послідовності дій: 

1. Побудуйте два квадрати різних розмірів, виконайте поворот меншого на 

45° об’єднайте їх. 

2. Виконайте заливку отриманої фігури. 

3. Використовуючи інструмент Інтерактивне видавлювання, надайте фігурі 

об’єму, потрібного кольору та освітлення. 



 

Додаткові завдання: використовуючи інтерактивні інструменти, 

виконайте побудову фігур за зразком: 

 

 

Висновки: в процесі виконання лабораторної роботи студенти повинні вміти 

використовувати інтерактивні інструменти: Інтерактивна оболонка, Інтерактивне 

видавлювання. 

 

6 Контрольні запитання 

6.1 Де розташований інструмент Інтерактивна заливка (Interactive Fill)? 

6.2 Що являє собою ефект перспективи? 

6.3 Які дії потрібно виконати для створення ефекту перспективи? 

6.4 Як здійснюється управління об'єктом, до якого було застосовано ефект 

перспективи? 

6.5 До яких об'єктів можна застосувати ефект перспективи? 

6.6 Що таке ефект видавлювання? Де знаходиться інструмент цього ефекту? 

6.7 Як застосувати до об'єкта ефект видавлювання? 

6.8 Як додати освітлення до ефекту видавлювання? 

6.9 Що являє собою ефект перетікання? 

6.10 Що являє собою ефект ореолу? 

6.11 Де розташовані інструменти ефектів перетікання і ореолу? 

6.12 Якими діями створюється ефект перетікання? 
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Інструкція для виконання лабораторної роботи №16-17 

 

Тема: Розробка пакету фірмової документації у програмному пакеті CorelDraw 

1 Мета: Використовуючи отримані навички роботи з графічним редактором 

CorelDraw, створити пакет фірмової документації, згідно з зазначеним вимогам. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Corel Draw  

2.4 Мультимедійний проектор 

 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Corel Draw застосовується для виготовлення рекламної продукції, плакатів, 

листівок, календарів, візиток, шрифтових робіт,що виводяться на плотер і т. 

д. 

 

4 Хід роботи: 
 

Згідно свого варіанту завдання, скласти пакет фірмової документації, що складається з 

наступних документів: 

• Корпоративна візитка 

• Фірмова папка 

• Фірмовий конверт 

• Фірмовий бланк 

Розробіть логотип компанії і використовуйте його на всіх фірмових документах. 

Відсутні контактні дані, такі як номер телефону або e-mail придумайте самі. 

 

При створенні фірмової документації, необхідно враховувати наступні 

вимоги: 

 Корпоративна візитка 

Розміри візитної картки – 50х90 мм, друкувати їх краще на світлому папері. По центру 

вгорі вкажіть назву фірми, нижче прізвище, ім'я та по батькові, під ними – посада, в 

кутку контакти – адресу, номери телефонів, електронна пошта. 

 Фірмова папка 

Фірмова папка - поліграфічний виріб, є одним з основних елементів фірмового стилю 

компанії. Фірмова папка являє собою контейнер для збірки, зберігання та переносу 

невеликої кількості паперових документів і матеріалів. 

Папка формату А4 (в готовому складеному вигляді 215*305 мм).  

 

 Фірмовий конверт 

Для пересилання документів, кореспонденції та інших вкладень, що мають формат 

складеного втричі аркуша формату А4 або складеного навпіл — формату А5, 

використовується так званий «євроконверт», якого 220×110 мм. 

Розробка конвертів формату «євроконверт» ґрунтується на таких принципах, як зміст, 

розмір і розташування елементів адресних блоків, використання фонових зображень і 

визначення резервних полів конверта. 

Існує стандарт, згідно з яким реквізити адресанта розташовуються в лівому верхньому 

куті конверта, а адресата — у нижньому. 

 



Блок адресанта, як правило, досить-таки точно повторює фірмовий блок, 

використовуваний в титульній частині фірмового бланку і містить логотип компанії, її 

повне найменування, поштову адресу, а також (опціонально) — номери телефону і 

факсу, адреси електронної пошти і інтернет-сайту компанії. 

Блок адресата, в переважній більшості випадків, являє собою так звану адресну сітку, в 

яку вписуються реквізити одержувача, або прозоре вікно, що має розміри близько 

90×60 мм, через яке видно реквізити, надруковані безпосередньо на документі, 

вкладається в конверт. 

Як правило, розміри поля становлять не менше 15-20 мм кожне. Можна 

використовувати фонове зображення на конверті. 

 Фірмовий бланк 

Формат бланків документів - А4 (210х297 мм). Кожен аркуш документа, оформлений 

на бланку, так і без нього, повинен мати поля: 20 мм - ліве; 10 мм 

- праве; 20 мм - верхнє; 20 мм - нижнє. На бланку повинні бути розташовані логотип 

компанії, основні графічні елементи, дані про компанії. 

Такі бланки можуть використовуватися не тільки для ділових листів, але і для 

договорів і різних протоколів і угод, а також для внутрішньофірмового документообігу 

– наказів, розпоряджень. 

 

  
 
 

  
 

 

 

 

 

 

 

 

 

  
 Естетичний рівень виконання і виразність логотипу, оригінальність ідеї. 

 Наявність цікавих доречних ефектів і фонових зображень. 

 

Збережіть всі документи, вказавши його тип і своє прізвище, наприклад, 

Папка_Коновалов.cdr. 

Підсумкові роботи зберегти у форматах «*.cdr», «*.pdf». 

 

 

Висновки: в процесі виконання лабораторної роботи студенти повинні навчитися 

розробляти компоненти фірмового стилю, використовувати програму Corel Draw для 

їх створення 
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Інструкція для виконання лабораторної роботи №18 
 

Тема: Робота з графічним редактором Photoshop. Інструменти виокремлення. 
 

1 Мета: Ознайомитися з інтерфейсом  програми Adobe Photoshop. 
Сформувати вміння та навички роботи з файлами та їх форматами, навчитися на 
практиці використовувати інструменти виділення та переміщення. 
 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

 
Панель інструментів (Toolbox) містить кнопки графічних інструментів Photoshop. Ці 

інструменти призначені для швидкого виконання більшості операцій і процедур, 

пов'язаних з виділенням, розфарбовуванням, редагуванням і перегляду зображень. Усі 

інструменти діляться на чотири групи: 
 

 

 

 

 

 

 

 

 

 

 

 



Інструменти виділення: 

Область. Виділяє прямокутні області. Для отримання квадратної області при її 
виділенні утримуйте клавішу Shift.  
Овальнаобласть. Виділяє овальні області. Для виділення області у формі круга при її 
виділенні утримуйте клавішу Shift.  
Вертикальний і горизонтальний рядок. Визначає виділену область як рядок товщиною в 
один піксель, проходячи по всьому зображенню.  

Рамка. Вирізує із зображення виділену область, відсікаючи 

непотрібні фрагменти 

Лассо. Виділення областей довільної форми.  

Багатокутне Лассо. Призначено для виділення в зображенні областей, 

обмежених багатокутниками, складеними з відрізків прямих ліній довільної форми.   

«Чарівна паличка».  Виділяє фрагменти зображення на основі схожості кольорів суміжних 

пікселів. 

Магнітне Лассо. Використовується для створення виділень навкруги об'єктів. Межі області  

"чіпляються" за краї об'єкту, на яких відбувається зміна колірного тону і насиченості.  

 
 

Інструменти малювання і зафарбування: 
Вставка.  Виділяє великі області та рівномірно їх змішує із фоновим 
малюнком .  

 

Кисть. Дозволяє знищувати маленькі точки, царапини, морщинки. 
Гумка.  Використовується для видалення оригінальних пік селів  

 

Зображення шляхом зафарбування їх в колір фону.  

Олівець. Дозволяє малювати лінії з різкими краями.  

Лінія. Використовується для малювання прямих ліній. (На 

початку і в кінці можна додати стрілки.)  

 

Піпетка. Дозволяє задати основною і фоновий кольори шляхом узяття проб 

кольору на зображенні Градієнт.Заповнює область поступовим переходом від одного кольору до 

іншого 

 Заливка. Дозволяє замальовувати однорідні пік селі виділеній області 

зображення вибраним кольором.  

 

Перо. Використовується для малювання контурів за допомогою лінійних 

сегментів шляхом створення набору закріплених крапок (вузлів).  

 

Стрілка. Застосовується для коректування форми контура шляхом 

переміщення вузлових крапок.  

Перо +. Використовується для додавання нових вузлових крапок в контур.  

Перо -. Використовується для видалення вузлових крапок з контура.  

Перетворювач. Використовується для зміни властивостей закріплених 

крапок (зокрема, для перетворення їх в точки перегину 

 

 

 

 

 

 

 

 
 

 



Інструменти для редагування 
Рука. Дозволяє проглядати частини зображення, що не помістилися на екрані.  

Масштаб. Збільшує і зменшує зображення.  

Переміщення.  Використовується для переміщення виділених 

областей, шарів і направляючих  

Текст. Дозволяє створювати бітовий текст.   
 

 

Інструменти для ретушування:.  

Палець. Імітує ефект розмазання невисохлої фарби пальцем.  

Штамп.  Дозволяє відтворювати точні або модифіковані копії Елементів 

зображення і колірних зразків в тому ж зображенні, або в іншому документі.   

Розмиття. Дозволяє пом'якшувати дуже різкі межі або області в 

зображенні, зменшуючи контраст між пікселями.   

Різкість.Дозволяє підвищувати чіткість зображення, роблячи дуже м'які межі 

більш різкими.  

Освітлювач. Дозволяє освітлювати окремі області зображення.  

Затемнювач. Затемняє окремі області зображення.  

Губка. Змінює насиченість окремих частин зображення. 

 



Хід роботи: 

Завдання 1.  Робота із файлами 

1. Запустіть програму AdobePhotoshop 

2. Ознайомтеся з інтерфейсом програми. При відсутності

 панелі інструментів додайте її (Окна —Инструменты). 

3. Відкрийте файли в AdobePhotoshop, які є присутні на

 вашому комп’ютері. 

Зверніть увагу на типи файлів, з якими може працювати дана програма. 

4. При роботі із файлами використайте оглядач  (Файл—

Обзор). Перегляньте всі папки і файли, що зберігаються в них, зверніть увагу на їх 

характеристики. 

5. Виберіть один файл із довільним зображенням і збережіть його

 у своїй папці у таких форматах: .PSD, .BMP; .EPS; .TIFF, .GIF, .PNG, .JPEG. 

6. Створіть таблицю «Формати файлів та степінь

 стиснення», у якій запишіть формат та розмір файлу і на основі записів 

зробіть висновки. 

Завдання 2.Інструментивиділення 
Вибрати інструмент виділення прямокутником та розбити фотографію на дві 

частини. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Відкрийте файл «girls.jpg».  



 
 
• Скориставшись інструментом виділення прямокутником , 

виділіть ліву частину фотографії і виберіть пункт меню 

Редактировать—Копировать. 

• Створіть новий файл . Помістіть у нього зображення із буфера 

обміну та збережіть його. 

• Аналогічні дії виконайте із правою частиною фото. 
Примітка. Далі всю роботу виконуєте аналогічно до описаного зразка. Фото 

підбираєте на свій смак 

1. Вибрати інструмент виділення овалом та зробити фотографію як на зразку. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Примітка. Під час створення області натисніть і утримуйте клавішу Alt. Виділення області у вигляді 

кола або квадрата і рівномірно від точки центра. Під час створення області натисніть і утримуйте 

клавішу Shift+ Alt.  

2. Вибрати інструмент виділення довільної області (Лассо) та зробити 

фотографію як на зразку. 

Примітка. Інструмент Лассо дозволяє виділити в зображенні (або його частини) область ш л я х о м 
позначення їх границь.   З о б р а ж е н н я п і д б и р а є т е д о в і л ь н о .   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Вибрати інструмент виділення довільної області багатокутник та зробити 

фотографію як на зразку 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Вибрати інструмент виділення « магнітне лассо» і зробити фотографію як 

на зразку 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Вибрати інструмент виділення « магічна паличка» і зробити фотографію як 

на зразку 

Примітка. Інструмент „магічна паличка" дозволяє виділяти фрагменти зображення з подібними 

кольорами, ; при цьому цей інструмент звільнить вас від необхідності детального ручного попереднього 

окреслювання границь потрібних областей. Зображення підбираєте довільне. 



6. Вибрати інструмент виділення « магічна паличка» і зробити фотографію як 
на зразку: 

Примітка. Для виділення всього неба необхідно використати інструмент магічнапаличка та інструмент лассо 

Відкрийте файл «parus.jpg» 

• Виберіть інструмент «магічна паличка» 

• Параметру Допуск, який задається у меню Окна введіть 

значення 40 і відключіть прапорець параметра Смежность 

• Клацніть інструментом «магічна паличка»в будь-якій точці 

зображення неба. Утримуйте клавішу Shift. 

• Щоб змінити колір неба, потрібно натиснути клавішу  Delete. 

• Збережіть новий файл на диску . 

 

 

 

 

 

 

 

 

 

 

 
 

7. Вибрати інструмент переміщення 
 

 

• Відкрийте файл «piramidal.jpg». 

 

 

 

 

 

і зробити зображення як на зразку: 

• Виберіть інструмент «магічна паличка» та виділіть 

кольоровий квадрат. 

• За допомогою інструменту переміщення перемістіть його так, щоб 

побудувати піраміду з квадратів. 

• Виконайте виділення інструментом  «прямокутне виділення» і 

клацнувши правою клавішею мишки на виділеному об’єкті виберіть 

команду Разотметить 

• Повторіть ці дії з кожним із квадратів. 

• Збережіть новий файл на диску. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Вибрати інструмент «переміщення зображення»           у вікні 

 



 

Відкрийтебудь –якийфайлтазбільшітьйогомасштаб . 

( Зручнозбільшуватимасштабодночаснимнатискуваннямклавіш«Ctrl»та «+»,азменшувати 
«Ctrl»та «-»).Звернітьувагу,щов стрічцізаголовкувікнапоказановибраниймасштаб . 

Поекспериментуйте із довільними зображеннями. 
 

 

 

 

 
Питання для контролю: 

1 Як запустити програму Adobe Photoshop? Як відкрити файл зображення, з яким 

2 ви хочете працювати? 

3 У якому форматі зберігає файли Adobe Photoshop? З якими ще форматами 

4 працює дана програма? 

5 Який спосіб стиснення файлів кращий :.GIF, .PNG, .JPEG? 

6 У яких форматах потрібно зберігати зображення для розміщення у Web?  

7 На які групи ділиться панель інструментів програми Adobe Photoshop? 

8 Охарактеризуйте інструменти виділення. 



Інструкція для виконання лабораторної роботи №19 
 

Тема: Робота із кольоровими режимами і тональностями 

зображень. 
 

1 Мета: Набути навиків при роботі із кольоровими режимами та 

навчитись використовувати різні тональності до зображень. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 
 

У сучасних графічних програмах маніпуляція з кольором здійснюється 

за допомогою кольорових моделей та режимів. Кольорові моделі дозволяють 

точно описати колір за допомогою певних стандартних математичних 

формул. 

Кольорові режими - це способи реалізації певних кольорових моделей в 

межах різних графічних програм. Більшість комп'ютерних кольорових 

моделей базується на використанні трьох основних кольорів. Кожному 

основному кольору присвоюється певне значення цифрового коду, і всі інші 

кольори визначаються як комбінація основних кольорів. 

В програмі Photoshop можна змінювати кольорові режими зображень, 

використавуючи команди меню Изображение – Режим. Для зміни кольорів та 

тональності цілого зображення та окремих його частин використовуються 

команди меню Изображение – Установка. 

 

4 Хід роботи: 

Кольорові режими. 

1. Відкрийте файл Bear.psd із папки Взірці. Зараз на стрічці назви цього 

файлу ви можете бачити, що використовується кольоровий режим RGB. 

На панелі Информации (Інфо) ви можете побачити, що колір зображення 

задається трьома базовими кольорами: червоним, синім та зеленим. 

2. Щоб поміняти режим кольорів зображення виберіть команди: 

Изображение - Режим i поставте галочку біля режиму Черно-белый. 

Тепер ваше зображення містить тільки чорний та білий колір. Відмініть 

операцію зміни режиму на чорно-білий на панелі История. 

3. Змініть кольоровий режим з RGB на CMYK. Зображення візуально не 

змінилося, але тепер всі кольори зображення будуть будуватися з 

чотирьох основних СMYK. 

 Зміна тональності картинки 

4. Спробуйте зробити картинку темнішою або світлішою. Для цього 



виберіть команди: Изображение-Установка-Кривые. Відкриється вікно з 

діаграмною сіткою, яку перетинає пряма лінія по діагоналі. Перетягніть 

цю пряму вверх, або вниз, і побачите як вся картинка буде ставати 

темнішою, чи світлішою. Відмініть внесені зміни. 

5. Виберіть команди Изображение – Установка - Цветовой Баланс. В вікні 

Цветовой баланс є лінійки з бігунками. Перетягаючи бігунок в сторону 

якогось кольору, ви побачите як в зображення додається більше цього 

кольору. Відмініть внесені зміни. 

6. Виберіть команди Изображение – Установка - Яркость/Контраст. Якщо 

перетягати бігунок на лінійці яркості, зображення темніє або світлішає. 

Коли перетягати бігунок на лінійці контрасту, кольори зображення 

стають близькими по тону поки не зіллються в один колір, або 

навпаки, на зображенні виділяються протилежні кольори і відкидаються 

тонові переходи. Відмініть внесені зміни. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Виберіть команди Изображение – Установка - Тон/Насыщенность. 

8. Перетягаючи бігунок на лінійці Тон, ви додаєте якогось кольору в 

зображення, на лінійці Насищеность – змінюєте насиченість кольорів, 

Яркость - змінюєте яркість. Виберіть в полі Редактирование, замість режиму 

майстер, режим Голубые, і перетягніть бігунки на лінійках Тон, 

Насищеность, Яркость. 

9. Тепер у вас буде змінюватися тільки та частина зображення, де є 

голубий колір (небо, сніг). На стрічці з кольорами внизу вікна можна, 

пересуваючи бігунки, регулювати ті тони (синій, зелено-голубий), які будуть 

сприйматися програмою як голубий колір і 

змінюватися. 

Якщо вибрати першу з трьох піпеток в цьому 

вікні і клацнувши нею по малюнку ви 

зможете вибрати з малюнку колір який ви 

хочете змінювати, друга піпетка дозволяє 

додати до вибраного кольору ще якийсь, а 

третя - віднімає від вибраних кольорів, колір 



по якому ви клацнете. Відмініть внесені зміни. 

10. Виберіть команди Изображение - Установки - Заменить Цвет. 

Піпетками можна вибрати кольори з зображення, які ви хочете змінювати, і 

поміняти їх тон, насиченість та яркість, як в попередньому випадку. 

Відмініть внесені зміни. 

11. Команда Обесцветить з меню Изображение – Установки перетворює 

кольорове зображення в сіре півтонове. 

12. Виберіть команду Изображение – Установки - Карта градиента. В 

вікні Карта градиента в полі Градиент используемый для отображения 

полутонов натисніть на кнопку з ▼ і виберіть різні типи градієнтних 

переходів. 

Зображення буде відображатись в тонах вибраних переходів. Відмініть 

внесені зміни. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. Команда Инвертировать з меню Изображение -Установки перетворює 

кольори зобравження на протилежні. 

Команда Порог перетворює зображення у чорно-біле і можна регулювати 

його яскравість, рухаючи бігунком у вікні Порог. Команда Уронять зменшує 

кількість півтонів в зображенні, кольорові переходи стають більш різкими. 

Команда Постеризовать також дозволяє зменшити кількість півтонів, але вже 

на задану величину (максимально – 256, мінімально – 2). Використайте 

перечислені команди до зображення і зробіть висновки. 

14. Виберіть команди Изображение – Установки –Вариации. В вікні 

Вариации можна додати якогось кольору до зображення, зробити зображення 

темнішим або світлішим натискаючи на картинки з відповідними надписами. 

Картинка з надписом Текучий Вид показує як виглядає ваша картинка коли 

ви вносите зміни. Відмініть внесені зміни. 



Щоб редагувати кольори не цілого зображення, а якоїсь його частини, 

потрібно цю частину виділити, і тоді зміни будуть виконуватись тільки над 

виділеним фрагментом. 

15. Для закріплення пройденого матеріалу, виберіть одне із кольорових 

зображень, що знаходяться у папці Взірці. Проробіть усе, що було задано до 

виконання у пунктах 2-14 із окремими частинками зображення, перед тим їх 

виділивши відповідними методами виділення. Окремі пункти зберігайте до 

того як відміняти цю дію і продемонструйте їх у звіті викладачеві. В 

кінцевому вигляді у вас має вийти естетичне зображення. 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навики в роботі із кольоровими режимами та навчитись використовувати 

різні тональності до зображень 

 

 

 

6 Контрольні запитання 

 

6.1 Що розуміють під поняттям кольоровий режим? 

6.2 Які кольорові режими використовуються у програмі PhotoShop? 

6.3 Як змінити кольоровий режим зображення? 

6.4 Для чого призначені команди меню Изображение-Установка 

програми Adobe Photoshop? 

6.5 Які інструменти малювання та замальовування використовуються 

в програмі Adobe Photoshop? 

6.6 Що мається на увазі під поняттям кольорові режими? 

6.7 Які типи кольорових режимів використовує програма Adobe Photoshop? 

6.8 Що таке кольорова модель? 

6.9 Які види кольорових моделей існують? 

6.10Які команди входять в пункт меню - Змінити тональності картинки? 
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Інструкція для виконання лабораторної роботи №20 
 

Тема: Робота з шарами в Photoshop. 
 

1 Мета: розглянути можливості Фотошоп  по  роботі з шарами, 

використання ефектів змішування шарів 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 
 

Новий документ, створений в програмі Adobe Photoshop, складається тільки з 

фону (заднього плану). Цей фон можна порівняти з полотном, на якому 

малюється картина. Фон може бути білим, або забарвленим в поточний колір 

заднього плану. 

Ви можете додати в документ один або декілька шарів, які можна порівняти з 

листами абсолютно прозорої плівки, складеними в стопку поверх фону. 

Якщо шар не містить ніяких образотворчих елементів, то крізь нього буде 

видна вся решта шарів і задній план. 

Можна створювати різні елементи свого зображення на окремих шарах, а 

потім об'єднувати їх для створення складової композиції. Шари можна 

видаляти, додавати або перемішувати, використовуючи різні значення 

прозорості і режими змішування. 

Ще одна перевага використовування шарів полягає в тому, що редагувати 

або малювати можна на одному шарі, не вносячи ніяких змін в інші. Це 

означає, що можна застосовувати команди або інструменти малювання до 

однієї частини зображення, не турбуючись, що випадково можна зіпсувати 

решту частин. 

Є тільки одне обмеження, що стосується створення нових шарів в Рhotoshoр, 

−- їх може бути стільки, скільки дозволяє пам'ять комп'ютера. 

В Рhotoshoр існують ще і спеціальний вид шару − коректуючиий. 

Коректуючі шари дозволяють маніпулювати командами редагування 

кольору, без дії на решту шарів зображення. 
 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Шари» 



4 Хід роботи: 

Завдання 1. 

 

 

 

Завантажити програму Photoshop і відкрити зображення 

1.jpg 2.jpg, які знаходяться в папці Мої документи/ 

Photoshop.. Вирізаємо метелика із фону, попередньо 

використавши інструмент виділення Чарівна  

паличка        (Виділяємо фон і 
інвертуємо виділення). 

 

 

Копіюємо метелика і вставляємо в зображення 

1.jpg. Використовуючи інструмент переміщення, 

перетягуємо метелик на око. Використовуючи 

можливості трансформації, зменшуємо метелик і 

трохи повертаємо. 

  
Використовуючи інструмент Штамп, прибираємо ті 

області, які виходять за межі ока. 

 Зменшуємо прозорість шару з метеликом до 60% і 
поекспериментуємо з режимами змішування 
шарів (н-д, Замена светлым, Перекрытие и 
мягкий свет). 
 
 

 

 

Завдання 2. 

 

 

 

Створіть новий малюнок у форматі RGB і залийте його чорним 

кольором Редактирование − залить − черный». Зробіть напис білим 

кольором. Злийте робочий слой з попереднім  (Ctrl-E).  На  

інструментальній панелі 

«Канали» натисніть ПКМ на назві одного з них. Цим ви створите    

новий    канал,    копію   попереднього, 
перейменуйте його в main (основний). 

 Тепер створіть копію каналу main і перейменуйте його в white. 

Завантажте його як виділення (відповідна кнопка на панелі). 

Тепер розширимо виділення: виберіть: выделение − 

модифицировать − расширить із значенням 2 пікселя. Потім залийте 

виділену область білим кольором «Редактирование − залить − 

белый». Приберіть виділення «Выделение − убрать выделение». 

Розмиємо зображення (Фильтр − Blur − Gaussian 

Blur...), вибравши значення 2. 



 

 

Створіть копію попереднього каналу і назвіть його yellow. 

Завантажте його як виділення (відповідна кнопка на панелі). 

Знову виберіть выделение − модифицировать − расширить и 

введіть значення 2. Залийте білим, відмініть виділення і 

розмийте 
зображення за допомогою фільтра Гауса на 3 пікселі. 

 

 

Створимо останній потрібний канал як копію попереднього, 

назвемо його "green". Аналогічно до попереднього завантажте його 

як виділення, розширте область на 6 пікселів, залийте білим, 

відмініть 
виділення і розмийте на 10 пікселів. 

 

 

 

Переключіться на канал RGB. Далі «Выделение − загрузить 

выделение» і виберіть канал green. Тепер встановіть зелений 

колір в якості основного(на панелі інструментів ЛКМ на 

верхньому квадраті кольору). Залийте все основним кольором 

«Редактирование − залить − основной». Виконайте ті ж дії з 

жовтим 
каналом, вибравши основний колір жовтий. 

 Виконайте ті ж дії з білим каналом, вибравши основний колір білий. 

 Нарешті завантажте як виділення канал main, стисніть його на один 

піксель «Выделение − модифицировать − сжать» і залийте 

чорним. 
Збережіть зображення під назвою Текст3.jpg 

 

 

Завдання3: за допомогою текстових шарів наповнити текстовою 

інформацією документи створенні у попередніх роботах. Використати 

стилі для створення рельєфного тексту  

  

1. Відкрити документи «візитка» і «буклет стр 1».  

2. Відкрийте текстовий редактор із автоматичною перевіркою 

орфографії та наберіть текстове наповнення для документів. Перевірте 

орфографію.  

3. На відповіднім документі за допомогою інструмента   

«Горизонтальный текст» створить габаритну рамку для вводу тексту.   

4. Скопіюйте необхідний текст із текстового редактору, для чого 

виділіть його и натисніть комбінацію клавіш «Ctrl»+C, перейдіть у 

Photoshop помістіть текстовий курсор у габаритну рамку вводу тексту на 

робочім полі документу, та натисніть комбінацію клавіш «Ctrl»+V. 

Відформатуйте текст і натисніть кнопку створення текстового шару на 

панелі властивостей зверху – .  

  



  
Приклад виконання роботи  

 5 Висновки: в процесі виконання лабораторної роботи студент має 

набути навики роботи з шарами. Навчитись редагувати та змінювати 

властивості шарів. Текстові шари. Стилі шару. 

 

6 Контрольні запитання 

 

6.1 Чи можливо тимчасово приховати зображення на певних шарах?  

6.2 Чи можна видалити усі шари з документу?  

6.3 Яким чином можливо трансформувати фоновий шар у звичайний 

або навпаки?   

6.4 Як можна вирізати або скопіювати частину зображення на 

окремий шар ? 

6.5 Як задати ступінь прозорості шару? 

6.6 Які види блокування шару можна ввімкнути на панелі шарів? 

6.7 Як можна поміняти порядок розміщення шарів? 

6.8 Як створити копію шару та змінити його ім’я? 

6.9 Які ефекти можна застосувати до шарів зображення і як це 

зробити? 

6.10Якими способами можна виконати об’єднання шарів? 

 

Література 
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Інструкція для виконання лабораторної роботи №21 
 

Тема: Робота із фільтрами та інструментами  малювання. Редагування 

фрагментів зображення. 

 
 

1 Мета: Набути навиків при роботі із фільтрами та навчитись 

застосовувати інструменти малювання до зображень та окремих  його 

частин. Вивчити  дію окремих видів фільтрів і побачити їх практичне 

застосування. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 
 

Фільтри використовують для автоматичної обробки та редагування 

зображень. В програмі PHOTOSHOP фільтри призначені для створення 

найрізноманітніших ефектів, а також вирішувати складні задачі по 

корегуванню освітлення, перспективи, зміни різкості, можливість додавання 

об’єму чи перетворення зображення в мозаїку. Всі команди для роботи з 

фільтрами поділяються на корегуючі та спотворюючі. 

Корегуючі фільтри. Щоденно використовують для редагування сканованих 

зображень, при підготовці їх до друку чи перегляду на екрані. Після вибору 

команди із меню Фільтр програма застосовує його до виділеної ділянки або 

до всього зображення. Перевагою також є те, що результат дії фільтра є 

передбачуваним, оскільки його можна переглянути у вікні попереднього 

перегляду або безпосередньо у вікні документу. 

Будь-який фільтр працює лише із одним - активним – шаром, а якщо є 

виділена область – то лише із нею. Для повторення дії останнього 

застосування фільтра слід виконати команду Фильтр – Последний фильтр , а 

для послаблення дії фільтра – команду Фильтр – Ослабить . Усі фільтри 

розділені на групи: Имитация, Размытие , Штрихи , 

Деформация Шум Оформление, Визуализация, Резкость, Эскиз, 

Стилизация , Текстура , Видео , Другие. 



4 Хід роботи: 

 

1. Фільтри дають можливість автоматично додавати до зображення 

якісь ефекти. Відкрийте файл Dune.psd із папки 

2. Взірці. Виберіть в меню Фільтр – Искажение – Стікло. Перетягаючи 

бігунки налаштуйте параметри: ступінь викривлення, ступінь в вікні фільтру 

Стікло. Зображення буде виглядати так, ніби воно розташоване під склом. 

Відмініть цей фільтр. 

3. Виберіть фільтр Фільтр – Рендерінг – Блік (Спалах) та налаштуйте 

відповідні параметри у цьому вікні. Зображення буде виглядати так, ніби ви 

дивитесь на нього через лупу. Відмініть цей фільтр. 

4. Виберіть фільтр Фильтр – Текстура – Мозаїчні фрагменти і налаштуйте 

параметри мозаїки у вікні Мозаїчні фрагменти. Зображення стане ніби 

викладене з мазаїки. 

 
 
 
 
 
 
 
 
 

5. Самостійно попробуйте як працюють фільтри Дисторсия, Зигзаг, Рябь, 

Сферызация, Волны з групи Искажения; Добавить шум, Медиана, Ретушь, 

Пыль и царапины з групи Шум; Витраж, Зерно, 

Кракелюры з гріпи Текстура; Волокна, Облака, Облака из наложением з групи 

Рендеринг; Гипс, Мокрая бумага, Тушь….,Рельэф, Уголь, Хром з групи Эскиз; 

Ветер, Выделение краев, Диффузия, Соляризация, экструзия з групи 

Стилизация; Фрагмент, Мозаика,Кристаллизация з групи Оформление; 

Минимум, Максимум, Заказная з групи Другие та інші. 

 Інструменти малювання 

6. Створіть новий файл, вибравши команди: Файл – Создать. В вікні, що 

відкриється, задайте Высоту зображенняm – 10 см, Ширину - 15 см, Роздільну 

здатність – 300 dpi, Pежим кольорів – СMYK, та Cодержание – бiлий. 

7. На новому малюнку спробуйте щось намалювати використовуючи 

інструменти Кисть, Карандаш, Аерограф та Ластик, щоб стирати. Міняйте для 

цих інструментів тип пензлика, прозорість, натиск, здаючи їх на панелі 

властивостей в полях Кисть , Непрозрачность . 



8. Виділіть прямокутну ділянку, крім звичайної заливки, яку ви 

вже використовували, ділянку можна залити градієнтною заливкою. 

Виберіть інструмент Градиент, на панелі властивостей задайте тип 

градієнта лінійний (радіальний, ромбовидний, ...), його кольори, 

прозорість... 
 

 Редагування фрагментів зображення 

9. Відкрийте зображення Effel Tower.tif із папки Взірці. Виберіть 

інструмент Ластик і витріть ним частинку зображення. 

10. Тепер вам потрібно відновити знищену частину зображення. 

Виберіть інструмент Штамп. Натисніть клавіщу Alt і клацніть 

мишкою на фрагменті картинки, який би підійшов, щоб замалювати 

знищену частину зображення (Цей інструмент малює копією 

вибраного фону). 

11. Відновіть за допомогою цього інструмента зіпсуту частину 

картинки. При цьому старайтесь домальовувати так, щоб не було 

помітно ніяких дефектів на картинці. 

12. Виберіть інструмент Размытие і натисніть мишкою кілька 

раз по якійсь частині зображення, де є різкі переходи кольорів. 

Даний інструмент розмиває кольори зображення, в місці де ви 

натискаєте. 

13. Інструмент Резкость робить зображення, в місці, де ви 

натискаєте, навпаки більш різкими. Попрацюйте цим інструментом. 

14. Інструмент Палец дає ефект, ніби ви тягнете пальцем по 

мокрій фарбі; ним можна замалювати маленькі дефекти. 

Використайте його. 

15. Інструмент Осветление висвітлює чавстинку зображення по 

якій ви клацаєте. Інструмент Затемнение – навпаки затемнює. 

Попрацюйте цими інструментами. 

16. Інструемнт Губка – зближує тони кольорів, зменшує контраст 

між кольорами. Використайте цей інструменту у практичній роботі 

до зображення. 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навики при роботі із фільтрами та навчитись застосовувати інструменти 

малювання до зображень та окремих  його частин. Вивчити  дію окремих 

видів фільтрів і побачити їх практичне застосування. 
 

 

 

 

 

 



6 Контрольні запитання 

 

6.1 Які кольорові режими використовуються у програмі PhotoShop 

і як змінити кольоровий режим зображення? 

6.2  Для чого призначені команди меню Изображение-Установка 

програми Adobe Photoshop? 

6.3  Які інструменти малювання та замальовування 

використовуються в програмі Adobe Photoshop? 

6.4  Для чого призначені фільтри в програмі Adobe Photoshop? 

Наведіть приклади. 

6.5  Як працює інструмент Штамп? 

6.6  Для чого призначені такі інструменти, як Размытие, Резкость, Палец? 

6.7 Як працюють інструменти Осветление, Затемнение , Губка? 
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Інструкція для виконання лабораторної роботи №22 
 

Тема: Робота з текстом в Adobe Photoshop 
 

1 Мета: Навчитись створювати зображення з використанням 

інструментів для створення тексту, надання тексту різних ефектів, 

застосування набутих навиків при створенні нового. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 
 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Шари», «Фільтри» 

 

4 Хід роботи: 

1. Створимо нове зображення: пишемо білим кольором будь-яке 

коректне слово. 
 
 

Крок 1. Крок 2. Крок3. 
 

2. Тепер для текстового слоя застосовуємо фільтр 

Фильтр/Смазывание/Размытие по Гаусу, об’єднюємо отримані слої 

CTRL+E, робимо дублікат слоя і знову застосовуємо фільтр 

Фильтр/Пиксилизация/Мозаїка із параметрами від 8 до 11 на ваш смак, 

після чого робимо непрозорість слоя 50%. 

3. До верхнього слоя застосовуємо останній фільтр: 

Фільтр/Посилена різкість/Посилена різкість, повторим фільтр раза 3-4. 

Якщо ви хочете додати колір, то виконайте 

Зображення/Корекція/Кольоровий тон,Насиченість. 

4. Створення "Обрамлення золотий текст". Створимо нове 

зображення із чорним фоном і напишемо якийсь текс білим кольором, 

потім натиснемо Ctrl+E . 



 

Крок 1. 
Крок 2. Крок 3 .      Крок 4. 

 

5. Після того як ми об’єднали 2 слої, то розмиваємо наше зображення 

Фільтр/ Розмиття/Розмиття по гаусу на 2-3 пикселя. Дальше 

Фільтр/Стилізація/Соляризація і натискаємо Shift+Ctrl+L (Автотон). 

6. Потім Фільтр/Стилізація/Вітер із параметрами Спосіб: Вітер і 

Направлення: Зліва. Дальше Зображення/Обертати зображення/ 90 і 

знову застосовуємо цей же фільтр, і так поки зображення не стане в 

вихідну позицію. 

7. І знову застосовуємо фільтр Фільтр/Стилізація/Світло для країв c 

параметрами: Ширина: 1 ; Яркість країв: 6; Пом’якшення: 8. Натискаємо 

Ctrl+U (галочку на кольоровий тон) і ставимо параметри: Тон 45 ; 

Насиченість 55 ; Яркість 0. 

 
Вправа №1. "Штрих-код 
 

   

Крок 1. Крок 2 Крок 3 
 

 Крок 1. Створимо нове зображення і застосуємо фільтр 

Фільт/Шум/Додати шум із параметрами: Ефект = 400 ; По Гаусу ; 

монохромне, і знову фільтр Фільт/Розмиття/Розмиття із рухом із 

параметрами: кут = 90, відстань = 999 pixels. 

 Крок 2. Тепер по рисунку встановлюємо контрастність і чіткість лінії 

CTRL+M 

(потрібно по експериментувати). 

 Крок 3. Наступним обрізаємо непотрібну частину і вставляємо цифри, і наш 

штрих код готовий. 



 

5 Висновки: в процесі виконання лабораторної роботи студент має 

зформувати вміння створювати різноманітні ефекти для тексту, виконувати 

роботу із фільтрами. 

 

6 Контрольні запитання 

 

6.1 Які фільтри Ви використовували на дані Лабораторній роботі? 

6.2 Які фільтри входять в групу Викривлення? 

6.3 Якіфільтри входять в групу Шум і в яких

 випадках вони використовуються? 

6.4 Які фільтри використовуються для розмиття зображення? 

6.5 Наведіть приклади найбільш застосовуваних на даній лабораторній 

роботі 6.6 фільтрів і їх груп? Приклади можливого їх застосування в 

інших цілях? 

6.7 Які інструментом набрати текст? 

6.8 Які методи виділення ви застосовували на Лабораторній робот? 

6.9 Які методи виділення існують ? І в яких випадках вони застосовуються? 

6.10 Як об’єднати декілька слоїв? 

6.11Які команди дозволяють дублювати шари (слої)? 

 

Література 
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Інструкція для виконання лабораторної роботи №23 
 

Тема: Реставрування пошкодженого зображення 

 

1 Мета: набути навичок роботи з інструментами редагування зображення. 

Навчитись використовувати техніки редагування зображення для поліпшення 

якості пошкодженого зображення.  

 

 

2 Матеріально-технічне  та навчально-методичне  забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 

 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 
 
Одним з основних переваг цифрової обробки зображень є можливість 

реставрації пошкоджених архівних фотографій. Комп'ютерна реставрація 

фотографій – це процес цифрової обробки відсканованого фото, в 

результаті якого видаляються ушкодження, відновлюються втрачені 

елементи зображення. Найчастіше буває так, що на фотографії втрачені 

якісь важливі фрагменти. В цьому випадку фотографію також можна 

відреставрувати, але бажано мати при собі додаткові фотографії, щоб 

можна було більш точно відтворити втрачені деталі фотографії. У подібних 

випадках пошкоджені фрагменти потрібно домалювати вручну.  

Для початку фотографію необхідно перетворити в цифрове зображення. 

Для цього потрібно відсканувати її, або перезняти цифровою фотокамерою. 

Якщо фотографія, що підлягає реставрації, досить великого розміру (15 х 

21 і більше), то її краще відсканувати з максимально можливим дозволом. 

Мінімально допустима якість для друкованої роботи 300 dpi.  

Потім необхідно проаналізувати зображення, розбити проект реставрації на 

кілька етапів і вибрати шляхи вирішення завдань на кожному з етапів. 

Наприклад, на суб'єктивну думку авторів цих методичних рекомендацій, 

пропонується керуватися наступними порядком виконання 

«ремонтнореставраційних робіт».  

  

Алгоритм виконання реставраційної роботи.  

1. Технічна робота з графічним документом (робота з дозволом 

документа, кольоровими схемами, кадрування, збереження у потрібному 

форматі).  

2. Тонова корекція зображення, робота з яскравістю, контрастом, 

різкістю.  



3. Усунення дрібних артефактів (пилу, тріщин, дрібних подряпин, білих 

і чорних точок, які не є частиною зображення).  

4. Відновлення відсутніх частин зображення.  

5. Кольорова корекція зображення. Форматування для виведення на 

друк.  

 Розглянемо на прикладі базові можливості програмного продукту з 

реставрування фотографій. Відкрийте відскановану з відповідною якістю 

фотографію за допомогою пункту меню «Файл» – «Відкрити», або 

натисканням комбінації клавіш CTRL + O (рис.1, а).  

4 Хід роботи: 

1. Технічна робота з документом.  

За допомогою інструменту «Рамка» вирівняйте і відсічіть непотрібні 

частини зображення (рис.1, б). Для обертання зображення використовуйте 

команди «Вращение изображения» з пункту головного меню 

«Изображение». Збережіть документ у форматі PSD використовуючи пункт 

меню «Файл» - «Сохранить как».  

  

    
 а)  б)  

Рис. 1 Етапи технічної роботи з документом  

  

2. Тонова корекція зображення.  

Перед початком корекції необхідно зробити копію шару з зображенням і 

працювати вже з ним. Дана операція дозволить запобігти псуванню 

вихідного зображення в разі помилок при роботі.  

Якщо реставруються зображення було «чорно-білим» для усунення 

колірних зрушень, різний плям і інших дефектів, що виникли згодом 

необхідно перевести документ в режим відтінки сірого, якщо це не було 



проведено в процесі сканування зображення. Для цього використовується 

пункт головного меню «Изображение» – «Режим» – «Градации серого». У 

разі реставрації кольорового зображення надану маніпуляцію не потрібно 

проводити.  

Для регулювання яскравості зображення рекомендується використовувати 

команду головного меню «Изображение» – «Коррекция» – «Уровни» 

(рис.2, а), або натиснувши комбінацію клавіш CTRL + L. У вікні 

налаштувань команди «Уровни» продемонстрована гістограма розподілу 

яскравості на зображенні в режимі об'єднаного колірного каналу, в даному 

випадку «Гр.Сер.». Під діаграмою розташовані три індикатори яскравості у 

вигляді сердечок: біле - зліва, чорне - справа і сіре - посередині. Це 

відповідно індикатори абсолютно білого, чорного і сірого відтінку на 

зображенні. Якщо гістограма не стосується, наприклад, як показано, 

чорного і білого індикатора – це означає що на зображенні відсутні 

абсолютно чорний і білий колір. Для настройки яскравості зображення 

вручну можна підвести індикатори чорного і білого впритул до країв 

гістограми, після чого на око за допомогою середнього індикатора півтонів 

провести регулювання яскравості на зображенні (рис.2, б).  

Найчастіше рівні яскравості в різних частинах зображення різні, тому на 

зображенні створюють виділені області різних частин і коригують їх 

окремо один від одного.  

Автоматичну і напівавтоматичну корекцію в даній роботі ми не 

розглядаємо.  

У разі якщо зображення надмірно пікселізовано після сканування, тобто 

має яскраво виражену сітчасту текстуру, усунути даний дефект можливо 

використавши фільтр розмиття по методу Гаусса з мінімальними 

параметрами. Для чого необхідно скористатися пунктом головного меню 

«Фильтр» – «Размытие» – «Размытие по Гауссу» задавши параметр 

«Радиус» в діапазонах 0,1–0,3 і перевіряючи якість зображення на око.  

У разі розмиття частини або всього зображення можна трохи підтягнути 

різкість за допомогою команди меню «Фильтр» – «Усиление резкости». 

Фільтри групи «Усиление резкости» працюють посилюючи різницю в 

кольорі сусідніх пікселів, за рахунок чого візуально до певної межі 

спочатку йде посилення різкості, а потім виникає зайва яскравість кольорів 

на зображенні.  

  

3. 4 Усунення дрібних артефактів. Відновлення відсутніх частин  

зображення.  

Якщо зображення багато на масу дрібних подряпин і пошкоджень усунути 

їх можна за допомогою фільтра «Пыль и царапины» пункту головного 

меню «Фильтр» – «Шум».  



  

 

 

 

 

 

 

 

 

 а)  б)  

Рис.2. Приклад використання команди «Уровни» 

  

Більші дефекти можна усунути за допомогою інструменту «Штамп». 

Даний інструмент служить для клонування обраної частини зображення на 

вказане місце. Для того щоб вибрати клонуємо зображення необхідно при 

активному інструменті «Штамп» затиснути клавішу ALT (після цього 

індикатор курсора перетвориться в приціл) і лівою кнопкою миші вибрати 

частину зображення для клонування. Потім відпустити мишу і клавіатуру. 

Після цього навести курсор миші на місце клонування і затиснувши ліву 

кнопку миші зробити в потрібні місця клонування зображення. При 

клонуванні на екрані буде присутній два курсора, один в вигляді прицілу 

показує звідки клонується зображення, інший – місце куди здійснюється 

клонування. Відсутні частини текстури заднього плану також можна 

наростити за допомогою інструменту «Штамп» (рис.3).  

  

5. Колірне корегування зображення. Форматування для виведення на друк.  

У разі реставрації «чорно-білого» зображення на даному етапі робиться 

підготовка до друку в залежності від типу паперу і типу пристрою друку.  

Колірна корекція не обов'язкова.  

Якщо необхідно «чорно-білу» фотографію зробити кольоровою, потрібно 

змінити колірну схему документа з градацій сірого в RGB або CMYK. Далі 

можна скористатися командою «Цветовой тон/Насыщенность» (CTRL + U) 

для тонування частин зображення. Перед цим необхідно створити виділені 

області для різних частин зображення або розмістити редаговані області на 

різних шарах.  

  



 

Рис.3. Приклад роботи після виконня  Рис.4. Приклад роботи після 

пункту 3 та 4  кольорового корегування  

  

Порядок виконання роботи  
 Вибрати із бібліотеки наданих пошкоджених зображень потрібний та 

відкрийте його в Photoshop.  

1. Збережіть документ назвавши його «Реставрування» і вибравши 

розширення «*.psd» при збереженні документа.  

2. Використовуючи  наданий  вище  алгоритм  дій  обробіть 

 графічне зображення.  

3. Збережіть зображення.  

5 Висновки: в процесі виконання лабораторної роботи студент має набути 

навичок роботи з інструментами редагування зображення  

 

6 Контрольні запитання 

6.1 Яким чином можливе обертання зображення?   

6.2 Чи можливо перетворити чорно-біле зображення у кольорове?  

6.3 Чи можливе регулювати ступінь розмиття відповідного фільтру?  

  

Література 

1 Березовський В. С. та ін. Основи комп'ютерної графіки: [Навч. посіб.] / 

— К.: Вид. група BHV, 2009. — 400 с: іл. 

2 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 

2008. -600 с. 

3 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

4 Глинський Я.М. Інформатика Практикум з інформаційних технологій. – 

Тернопіль: Підручники і посібники, 2014 – 304 с. 

5 https://helpx.adobe.com/ua/photoshop/user-guide.html 



Інструкція для виконання лабораторної роботи №24 
 

Тема: Створення анімованого зображення в редакторі Adobe Photoshop 

 

1 Мета: Навчитися створювати рухомі зображення в графічному 

редакторі Adobe Photoshop 

 

2 Матеріально-технічне  та навчально-методичне  забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 

 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Анімація у програмі 

Adobe Photoshop» 
 
4 Хід роботи: 

Завдання 1. Створення рекламного банера розміром 100х100 у форматі GIF.  

Вказівки до виконання  

Для виготовлення цього банера будемо використовувати заливку і написи. 

Створіть шар з заливкою і невеликим малюнком у куточку. 

 
Потім, кожен шар вносите елемент, який буде змінюватися. Наприклад, 

текст, розбитий на літери. 

 

 

 

 

 

 

 

 

 



Перейдіть в Adobe ImageReady і задайте анімацію з часом показу кадру 0.5 

секунди 

Збережіть банер оптимізованим <Малюнок 2>. 

 

Завдання 2. Створення рекламних банерів на задану тему. 

 

Необхідно створити серію іміджевих банерів (розміром 468х60, 100х100) 

єдиної тематики, розробивши слоган, візуал, колірну гаму, текст. 

 

Обов'язкові елементи:  

Єдина колірна гамма; 

Рекламний слоган; 

 

Завдання 3 Ефектна поява аватар (міні-картинка в Інтернет, що 

відбиває внутрішній стан його власника, або просто його фото або 

елемент творчості власника) 

 

Завдання. Створити власний аватар для форуму з застосуванням ефектів 

анімації.  

Створюємо новий документ. (200х200, колір - білий)  

Беремо кисть (brush tool). Вибираємо зі списку кисть, схожу на мазки і 

зображену на картинці (23 пікселів). 

 

 
 

Створюємо новий шар (Шар – Новий Шар) і малюємо пензлем, як показано 

нижче. 

 

 

 

 

 

 

 

 

 

 



Вставляємо фото. Ми використовуємо зображення Мони Лізи. <Малюнок 

12>. Якщо він не підходить за розмірами, використовуємо інструмент Вільне 

трансформування 

 

 

 

 
Тиснемо Ctrl+Alt+G, або Layer > Create clipping mask 

Зверніть увагу на палітру Шари. Вона виглядає наступним чином: 

 

 
 

Виділяємо Слой1 і Слой2 і об'єднуємо обидва шару (Шар – Об'єднати шари). 

Дублюємо цей шар (Ctrl+J).  

Потім беремо ластик (Eraser tool) з такими ж параметрами кисті як і раніше 

Дублюємо шар і робимо невидимим попередній. Стираємо нижній штрих як 

показано нижче. 

 

 
 

 

Таким же чином кілька разів дублюємо шар і стираємо штрихи. 



 
 

Переходимо в ImageReady. Відкриваємо вікно анімації. Для створення 

першого кадру сховаємо всі шари. Далі натискаємо на панелі значок 

Дублювати кадр і робимо видимим другий шар на палітрі. 

Продовжуємо дублювати фрейми, поступово роблячи видимими приховані 

шари. 

 

 
 

Тиснемо Ctrl+Alt+Shift+S (File > Save optimized As), щоб зберегти анімацію. 

Милуємося результатом: <Малюнок 23> 

 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має 

навчитися автоматизувати роботу у програмі, записувати послідовність 

виконання певних дій у вигляді операції, здійснювати пакетну обробку 

зображень,створювати сторінки з мініатюрами тощо. 

 



Контрольні запитання 

 

6.1 Які ви знаєте способи створення анімацій у Adobe PhotoShop ?   

6.2 Чим відрізняється зображення у форматі jpg та у форматі gif?  

6.3 Яке розширення мають збережені файли анімації? 

6.4 Як створити анімацію у  Adobe PhotoShop? 

6.5 Які інструменти використовують для створення анімації? 
  

 

Література 

1 Березовський В. С. та ін. Основи комп'ютерної графіки: [Навч. посіб.] / 

— К.: Вид. група BHV, 2009. — 400 с: іл. 

2 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 

2008. -600 с. 

3 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

4 Глинський Я.М. Інформатика Практикум з інформаційних технологій. – 

Тернопіль: Підручники і посібники, 2014 – 304 с. 

5 https://helpx.adobe.com/ua/photoshop/user-guide.html 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Інструкція для виконання лабораторної роботи №25 
 

Тема: Комбінування графіки  додатків пакету CreativeSuite 

 

1 Мета: створити запрошення, використовуючи можливості програм 

CorelDraw та Adobe Photoshop. 

 

2 Матеріально-технічне  та навчально-методичне  забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe Photoshop 

2.4 Мультимедійний проектор 

 
 
4 Хід роботи: 

Завдання для індивідуальної роботи: 

Використовуючи пошукові сервіси мережі Інтернет, знайти векторні графічні 

примітиви, зображення, зразки фонів і використати їх для створення 

запрошення згідно зразка: 

 

 

 

При створенні передбачити можливість роздрукування трьох запрошень на 

одному аркуші А4 альбомної орієнтації (розмір запрошень підібрати самостійно). 

При оцінюванні роботи враховується: 



 наявність фону та елементів оформлення; 

 акуратність та чіткість виконання; 

 наявність фігурного тексту. 

Виконане завдання необхідно представити у трьох форматах: cdr, psd та png. 

 

 

6 Контрольні запитання 

 

6.1 Які Ви знаєте графічні редактори?   

6.2 Яким чином можна поєднати їх застосування?  

6.3 Яке розширення мають мають файли різних графічних редакторів? 

 

Література 

1 Березовський В. С. та ін. Основи комп'ютерної графіки: [Навч. посіб.] / 

— К.: Вид. група BHV, 2009. — 400 с: іл. 

2 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 

2008. -600 с. 

3 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

4 Глинський Я.М. Інформатика Практикум з інформаційних технологій. – 

Тернопіль: Підручники і посібники, 2014 – 304 с. 

5 https://helpx.adobe.com/ua/photoshop/user-guide.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Інструкція для виконання лабораторної роботи №27 
 

Тема: Знайомство з програмою Adobe InDesign. Інтерфейс, робоче 

середовище в InDesign. 

1 Мета: Ознайомлення з можливостями налаштувань Аdobe InDesign CS. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe InDesign 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Програма Adobe Indesing 

CS» 

 

4 Хід роботи 

1. Створення нової публікації. 
Запустіть програму Adobe InDesign (Пуск>Программы>Adobe>Adobe 

InDesign). 

Створіть нову публікацію (File>New>Document або <CTRL>+ 

<N>).Відкриється діалогове вікно, в якому задаються наступні параметри: 

Кількість сторінок (Number of Pages) — 4 

Розмір сторінки (Page Size) — довільний (Custom), ширина (Width) — 205 

мм, висота (Height) — 280 

Розворот (встановити перемикач Facing Pages) 

За допомогою палітри Pages перемістіться на шаблон-сторінку А-Master. За 

допомогою команди Master Options for «А-Master» з меню палітри Pages ви 

можете поміняти такі властивості шаблона, як префікс, ім'я шаблон-сторінки, 

базовий шаблон для даної шаблон-сторінки і номер сторінки, до якої 

застосовується дана шаблон-сторінка. 

Для подальшої роботи над макетом треба створити основні елементи на 

шаблон-сторінці, які будуть потім повторюватися на основних сторінках. 

Виберіть Layout>Margins and Columns. Відкриється діалогове вікно, в 

якому можна указати кількість колонок на сторінці і відстань між ними. У 

розділі Columns укажіть кількість колонок (Number) —2, відстань між 

колонками (Gutter) — 5 мм. 

2. Створення колонтитулів. 

Для того, щоб колонтитули були розміщені симетрично і вирівняні по 

одному рівню, потрібно скористатися направляючими. Горизонтальні 

направляючі створюються простим перетягуванням при лівій натиснутій 

клавіші миші з верхньої горизонтальної лінійки, вертикальні направляючі — 



відповідно з вертикальної лінійки. Створіть горизонтальну направляючу на 

рівні 20 мм. Якщо відразу не вдалося помістити направляючу на потрібну 

координату, можна указати точне значення координати в контрольному 

рядку, який розташований безпосередньо під текстовим меню. Якщо 

контрольний рядок за умовчанням не відображується у вікні документа, 

викликати його можна через меню Window>Control або поєднанням 

клавіш <Alt>+<Ctrl>+<6>. Натиснувши клавішею миші по направляючій, ви 

зможете побачити в контрольному рядку її координати і при необхідності 

змінити їх. Якщо ви не можете перемістити направляючу, то це значить, що 

встановлена опція закріплення направляючих. Відключити її можна за 

допомогою меню View>Lock Guides. Якщо направляючі закріплені, поряд із 

цією командою встановлений перемикач. Команда Lock Guides є і в 

контекстному меню, що відкривається натисненням правою клавішею миші 

на направляючій, або у вільному місці сторінки. 

Виберіть інструмент Line Tool (Лінія) з палітри інструментів. Уздовж 

направляючої на висоті 20 мм намалюйте пряму лінію на лівій сторінці — 

вона буде візуально відділяти колонтитули від тексту. У контрольному рядку 

вкажіть товщину лінії — 0,5 pt (цей параметр знаходиться в правому 

верхньому кутку контрольного рядка), тип лінії за умовчанням указується як 

суцільний (Solid), його змінювати не потрібно, проте можна подивитися, які 

типи ліній можна намалювати в InDesign. 

Повторіть цю ж операцію для правої сторінки. 

Виберіть інструмент Rectangle Frame Tool (Прямокутний фрейм) з палітри 

інструментів. З його допомогою намалюйте фрейм висотою 5 мм і довжиною 

60 мм (параметри можна точно указати в контрольному рядку). Розмістіть 

фрейм в лівому верхньому кутку лівої сторінки. Тепер потрібно надати 

фрейму чорний колір. Зробити це можна за допомогою кнопок управління 

кольором з палітри інструментів. 

Fill. Зразок заливання об'єкта. Якщо ця кнопка знаходиться на передньому 

плані, то вибирається і редагується заливання. Якщо об'єкт не має заливання, 

кнопка помічена косою червоною рискою. 

Stroke. Зразок обведення об'єкта. Якщо ця кнопка знаходиться на 

передньому плані, то вибирається і редагується обведення. Якщо об'єкт не 

має обведення, кнопка помічена косою червоною рискою. 

Наш фрейм повинен бути з чорним заливанням і не мати обведення. Для 

того, щоб задати йому такі параметри, виділіть фрейм за допомогою 

інструменту Selection (Виділення), потім зробіть кнопку заливання активною 

і укажіть чорний колір (чорний колір, градієнт і відсутність кольору — ці три 

значки розташовані також на палітрі інструментів, трохи нижче кнопок (Fill і 

Stroke). Перевірте, щоб обведення у фрейма не було. 

3. Розташування тексту. 

Виберіть інструмент Type Tool (Текст) з палітри інструментів і натисніть 

ним в середині фрейма. Кнопка Fillстала відображуватися як квадрат з 

чорною буквою «Т». Двічі натисніть по цій кнопці. Відкриється 

палітраColour. В цій палітрі за допомогою повзунка виберіть білий колір або 



просто введіть в полі відсотків цифру «0». Це означає, що в кольорі тексту 

буде 0% чорного кольору, тобто текст буде білим. Наберіть текст «Огляд 

товарних ринків». Виділивши набраний текст за допомогою миші, перейдіть 

до вибору шрифтів і розміру в контрольному рядку. Укажіть шрифт Europe, 

зображення Bold, розмір 9 pt, інтерліньяж (відстань між рядками) 10,5 pt. 

Укажіть, що всі букви повинні бути заголовними (цей параметр також 

знаходиться на контрольному рядку і позначається двома великими буквами 

«Т»). Окрім цього параметра можна визначити для тексту також закреслення, 

підкреслення, верхній і нижній індекси. 

Створіть ще один фрейм, але без обведення і заливки. Наберіть в ньому текст 

«Опт & дистриб’юція». Надайте тексту ті ж параметри, що і в попередньому 

фреймі, але тільки без зміни кольору. Розташуйте фрейм в правому 

верхньому кутку лівої сторінки і лівому верхньому куті правої сторінки. 

Створення і редагування верхнього колонтитула закінчено, тепер можна 

переходити до нижнього колонтитула. 

Для нижнього колонтитула створіть горизонтальну направляючу з 

координатою 265 мм. Скопіюйте з верхнього колонтитула горизонтальні лінії 

і розмістіть їх уздовж цієї направляючої. Створіть текстовий фрейм з 

наступними параметрами: колір тексту чорний, шрифт Europe, зображення 

bold, розмір 7,5 pt, інтерліньяж 9 pt. Наберіть текст «Торгові Відомості 7 (7) 

вересень 2008 р.». Розмістіть фрейм в правому нижньому кутку лівої 

сторінки, а його копію — в лівому нижньому кутку правої сторінки. 

Тепер потрібно створити автоматичну нумерацію сторінок. Створіть 

текстовий фрейм в лівому нижньому кутку лівої сторінки і натисніть в ньому 

інструментом Type Tool (Текст). Потім перейдіть в меню Type>Insert 

Special Character>Auto Page Number або просто натисніть поєднання 

клавіш <Alt>+<Shift>+<Ctrl>+<N>.У фреймі з'явиться буква «А». Це 

означає, що ви створили для поточного шаблона автоматичну нумерацію 

сторінок. Виділіть текст і надайте йому наступні параметри: шрифт Europe, 

зображення bold, розмір 10 pt, інтерліньяж 11 pt, колір тексту — чорний. 

Повторіть операцію з фреймом для правої сторінки, розмістивши його в 

правому нижньому кутку. 

Збережіть публікацію (File>Save As або <CTRL>+<S>) як 

«Лабораторна_робота_№27)».  

Закрийте її (Файл => Закрити). Відкрийте публікацію, яку ви зберегли (для 

цього зробіть Файл => Відкрити). При цьому ви можете відкрити копію або 

оригінал. 

 

 

5 Висновки: в процесі виконання лабораторної роботи студент має 

ознайомитись з  можливостями налаштувань Аdobe InDesign CS. 

 

 

 



 

6 Контрольні запитання 

6.1 Які основні параметри налаштування програми Adobe Indesign? 

6.2 Як створити сторінки-шаблони? 

6.3 Як створити фрейм? 

6.4 Які параметри фрейма? 

6.5 Як виконується робота зі сторінками: додавання, видалення, 

переміщення? 

6.6 Що таке «майстер-шаблона» документа? 

6.7 Як виконати зв'язування текстових блоків у ланцюжки? 

6.8 Як увести інформацію у текстові блоки? 

6.9 Як імпортувати текстові документи з інших програм? 
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Інструкція для виконання лабораторної роботи №28 
 

Тема: Створення макету видання. Робота з шаблонами. 

1 Мета: Уміти створювати документи, налаштовувати параметри сторінок, 

поля, колонки. Виконувати роботу з напрямними. Уміти зберігати документ. 

Уміти створювати, зберігати та застосовувати шаблони. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe InDesign 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Зміна параметрів документу 

Зміна параметрів у діалоговому вікні Параметри документа впливає на кожну 

сторінку документа.. 

Виберіть меню «Файл» → пункт Параметри документа. 

Зазначте параметри документа і натисніть кнопку OK. 

Зміна полів сторінки та налаштувань колонок 

Для сторінок і розворотів можна змінити параметри колонок і полів. Під час 

зміни параметрів колонок і полів на сторінці-шаблоні змінюються параметри 

для всіх сторінок, до яких застосовано цей шаблон. Зміна колонок і полів 

звичайних сторінок впливає тільки на сторінки, виділені на панелі 

"Сторінки". 

Щоб змінити параметри полів і колонок для сторінок, виберіть ці сторінки на 

панелі "Сторінки" або виберіть шаблон, керуючий сторінками, які необхідно 

змінити. 

Виберіть пункт меню Макет → Поля та колонки, визначіть наступні 

параметри і натисніть кнопку OK. 

Шаблони — це зручні заготовки для створення стандартних документів 

— вони попередньо налаштовують макет, графіку і текст. Наприклад, 

якщо ви готуєте щомісячний журнал, ви можете створити шаблон, що 

міститиме макет типового випуску, включно з напрямними лініями, 

сіткою, шаблонами сторінок, власними стилями та зразками, шаблонними 

кадрами, шарами і будь-якою стандартною графікою й текстом. Відтак 

кожного місяця ви можете просто відкривати цей шаблон і імпортувати до 

нього новий вміст. 

Шаблон створюється так само, як і звичайний документ, єдина відмінність 

полягає у тому, як документ записується. 

 

 



4 Хід роботи 

1. Створіть нову публікацію: кількість сторінок – 6, розмір сторінки 

– А5, прапорець біля - розворот, орієнтація – альбомна, розмір полів ліве, 

праве – 10 мм, верхнє, нижнє – 15 мм. 

2. Змініть  розмір  полів  першої  сторінки  усі  по  25  мм.  Макет→Поля  

і 

колонки. 

3. Перейдіть на четверту сторінку розбийте її на три колонки 

Макет→Поля і колонки, середник – 5 мм. 

4. Вставте   в   документ   після   четвертої   сторінки   ще   2   сторінки 

Макет→Сторінки→Вставити сторінки… 

5. Відкрийте Панель Сторінки (Вікно→Сторінки або F12) та 

використовуючи меню цієї панелі або кнопку Створити нову сторінку, яка 

розміщена в нижній частині додайте ще 4 сторінки, після першої сторінки. 

6. Виконайте зміну параметрів документу, встановивши розмір 

сторінки 210х210 мм та зніміть прапорець – розворот. Файл→Параметри 

документа… 
 

7. Змініть одиниці виміру на лінійці на сантиметри для цього 

виконайте команду Редагування→Установки→Одиниці виміру…, 

Розмітка лінійки по горизонталі та по вертикалі виберіть із списку 

сантиметри. 

 

8. Перейдіть   на   другу   сторінку   

та створіть три горизонтальні 

напрямні через шість сантиметрів від 

краю поля. Макет → Створити 

напрямні… 
 

 

9. Перейдіть на третю сторінку створіть вертикальну напрямну по центру 

сторінки. 

Виберем інструмент «Виділення» та перемістимо напрямну з 

вертикальної лінійки, необхідно стежити за заначенням Х: біля курсору, 

нам необхідне значення 105. 

10. Збережіть документ під назвою Макет1.indd. 

11. Створіть нову публікацію: кількість сторінок – 4, розмір сторінки 

– А4, орієнтація – книжна, кількість колонок – 4, середник – 4 мм, розмір 

полів ліве, праве – 10 мм, верхнє – 20 мм, нижнє – 15 мм. 

12. Виберіть інструмент «Сторінка»  та виконайте зміну орієнтації 

сторінки 1 та 2 на Панелі управління. 

13. За   допомогою   команди   Макет→Сторінки→Вставити   

сторінки…, 

додайте 2 сторінки. 



14. Розділіть першу сторінку на 3 колонки з середником- 5мм, Макет→Поля 

і колонки… 

15. Другу сторінку розділіть на 2 колонки з середником – 10 мм. 

16. За допомогою Панелі Сторінки створіть дублікати першої та другої 

сторінок, викличте контекстне меню сторінки, яку необхідно 

продублювати та оберіть команду Створити дублікат. 

17. Перемістіть створені дублікати в кінець публікації, відкрийте 

Панель Сторінки, викличте контекстне меню сторінки, яку необхідно 

перемістити та оберіть команду Перемістити сторінку, у вікні діалогу 

вкажіть після якої сторінки її помістити або перемістіть сторінку методом 

перетягування. 

18. Видаліть третю сторінку перетягнувши її піктограму у корзину в 

Панелі Сторінки. 

19. Збережіть документ під назвою Макет2.indd. 

20. Створіть публікацію: кількість сторінок – 8, розмір сторінки – А3, 

орієнтація – книжна, розмір полів ліве, праве – 15 мм, верхнє – 20мм, 

нижнє – 25 мм. 

21. Перейдіть  на  шаблону  сторінку  позначену  літерою  А  (на  панелі 

Сторінки). 

22. Створіть на ній верхній колонтитул. (Текстовий блок у якому 

надрукуйте власне прізвище та ім’я). 

23. За допомого інструмента «Перо» намалюйте хвилястий контур. 

24. Користуючись інструментом «Текст за контуром» надрукуйте 

вздовж хвилястої лінії Оператор комп’ютерної верстки. Перемістіть 

контур у верхній колонтитул. 

25. Подивіться чи відобразились створені вами елементи на решті 

сторінок. 

26. Перейдіть на першу сторінку створіть прямокутний    кадр 
 

інструментом  

27. Перетворіть його на текстовий виділіть прямокутний 

фрейм Об’єкт→Вміст→Текст. 

28. Розмістіть  у  нього  довільний  текст  методом  копіювання  із  роботи 

Вулиці.doc. 

29. Перейдіть на третю сторінку створіть п’ятикутник за допомогою 

інструмента «Багатокутник» (кількість кутів встановлюється на Панелі 

керування). 

30. За допомогою Панелі керування проведіть налаштування 

наступних параметрів: 

a. Залийте багатокутник  кольором,  контур  –  хвилястий,  товщиною  –  

6пт 
 

 

 



b. Поверніть багатокутник на 60 градусів та нахиліть на 20 градусів. 
 

 

c. Тип кутів багатокутника задайте – округлий виріз  
 

31. Збережіть публікацію у власній папці під іменем Шаблон1.indd. 

32. Створіть нову публікацію: кількість сторінок – 4, розворот, розмір 

сторінки – А4, орієнтація – книжна, розмір полів зовні – 10 мм, зсередини 

– 15 мм, верхнє – 25мм, нижнє – 15 мм. 

33. Перейдіть на праву шаблону сторінку намалюйте прямокутник, 

виберіть тип лінії - білий ромб, ширина – 10 пт, колір синій. Розмістіть 

його у верхньому правому куті. 

34. Перейдіть  на  ліву  шаблону  сторінку.  У  верхньому лівому куті 

створіть фігуру з надписом: 
 

 

 

35. Перейдіть  на  першу  сторінку.  Створіть  прямокутний фрейм по 

середині сторінки для цього створіть напрямні по горизонталі та вертикалі 

(Напрямні витягуються з горизонтально та вертикальної лінійок 

затиснувши ліву клавішу миші). 

36. Задайте параметри. Тип лінії прямокутника – тонка товста, 

шириною – 10 пт; колір довільний; тип кута – віньєтка. 

37. Всередині розмістіть текст Мої роботи. 

38. Перейдіть на другу сторінку та помістіть на ній першу роботу 

по темі Word Мова.doc. Для цього виконайте команду 

Файл→Помістити (Ctrl+D). 
39. На третій та четвертій сторінках розмістіть наступні роботи: 

Україна.doc та Місто.doc. 

40. У прямокутнику на шаблонній сторінці надрукуйте сьогоднішню 

дату. 

41. Збережіть роботу у власній папці під назвою Шаблон2.indd. 

42. Створіть нову публікацію кількість сторінок – 12, розмір 

сторінки – А5, орієнтація – книжна, кількість колонок – 2, середник - 4 

мм,розмір полів ліве, праве – 10 мм, верхнє – 15мм, нижнє – 10 мм. 

43. На шаблонній сторінці створити верхній колонтитул (Сірий 

прямокутник шириною – 1см, з текстом Конспект лекцій). 

44. Нижній колонтитул по центру (еліпс з текстом місто Рівне) та 

справа (маленький сірий квадрат – для колон цифри) 

45. Збережіть публікацію під назвою Шаблон3.indd. 

46. Створіть публікацію: кількість сторінок – 16, розворот, розмір 

сторінки – А4, орієнтація – альбомна, розмір полів зовні – 10 мм, 

зсередини – 15 мм, верхнє – 15 мм, нижнє – 10 мм. 

47. Розмістіть  на першій сторінці  текст:  Робота із шаблонами. 

48. Перетворіть першу сторінку на шаблону. 



49. Створіть нову шаблону сторінку на основі В-шаблону. 

50. Перейменуйте С-шаблон на Власний(Меню панелі 

Сторінки→параметри шаблону), префікс: Власний та Ок. 

51. Розділіть другу та останню сторінку публікації на дві колонки, 

середник – 

8 мм. 

52. Третю сторінку розділіть на три колонки. 

53. Видаліть В-шаблон. 

54. Збережіть публікацію, як шаблон у власній папці під назвою Шаблон4. 

 

55. Здійсніть набір запропонованого тексту за допомогою ТР Word та 

збережіть його під назвою Заготовка.doc. 

56. Відкрийте  публікацію  Шаблон3  помістіть  Заготовка.doc у 

публікацію. 

Файл→Помістити або методом перетягування. 

57. Збережіть Шаблон3.indd, як Заготовка.indd. 

 

5 Висновки: в процесі виконання лабораторної роботи студент має 

навчитися створювати документи, налаштовувати параметри сторінок, поля, 
колонки. Виконувати роботу з напрямними. Уміти зберігати документ 

6 Контрольні запитання 

1 Як розділити сторінку на три колонки? 

2 Чи можна розділити сторінку на колонки під час створення? 

3 Чи можна змінити кількість колонок після створення документу? 

4 Як змінити розмір полів сторінки? 

5 Виконати налаштування параметрів напрямних? 

6 Додати 3 сторінки після першої? 

7 Які способи видалення сторінок ви знаєте? 

8 Що найчастіше розміщують на шаблонних сторінках? 

9 Як створити шаблону сторінку? 

10 Чи можна видалити шаблону сторінку? 

11 Як зберегти публікацію як шаблон? 

12 Перетворити сторінку на шаблон? 

13 Як застосувати до сторінок шаблон? 
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Інструкція для виконання лабораторної роботи №29 
 

Тема: Створення текстових кадрів, робота з ними. 

 

1 Мета: Уміти створювати текстові кадри, виконувати їх 

переміщення, зміну розміру, створювати зв’язані текстові блоки. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe InDesign 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Створення текстових кадрів 

Текст в InDesign міститься в рамках, які називаються текстовими 

кадрами (текстовими фреймами або текстовими блоками). 

Текстові кадри та графічні кадри, можна переміщати, змінювати розмір та 

заміняти. Інструмент, за допомогою якого виділений текстовий кадр, 

визначає тип змін, які можна здійснити: 

 Інструмент «Текст»  дозволяє вводити чи редагувати текст у кадрі.

 Інструмент «Виділення»  дозволяє виконувати загальні задачі для 

макета, як-от розміщення та встановлення розміру кадру.

 Інструмент «Часткове виділення»  дозволяє змінювати форму 

кадру. Текстові  кадри  можна  створити  на  основі  колонок.  Текстові  

кадри можна розмістити також на шаблон-сторінках, а текст приймати все 

одно на сторінках документа. 

Створювати текстові кадри при розміщенні чи вставленні тексту не 

потрібно — InDesign автоматично додає кадри. 

Щоб створити текстовий кадр: 

Оберіть інструмент «Текст» , а потім 

перетягніть, щоб визначити ширину й 

висоту нового текстового кадру. 

Перетягніть, утримуючи клавішу Shift, 

щоб обмежити кадр до квадрату. Коли 

кнопку миші відпустити, у кадрі 

з'являється текстовий курсор.
 

Зміна розміру текстового кадру: 

 Щоб змінити розмір за допомогою інструмента «Текст» , 

утримуйте клавішу Ctrl та перетягуйте будь-який маркер кадру.

 Щоб змінити розмір з використанням інструмента «Виділення» , 

перетягуйте маркери на межі кадру. Щоб масштабувати текст всередині 

кадру, утримуйте клавішу Ctrl.



 Щоб змінити розмір за допомогою інструмента «Масштабування» 

, змініть розмір кадру шляхом перетягування.

Застосування текстових кадрів на шаблонах сторінок 

При створенні нового документа можна вибрати параметр «Шаблонний 

текстовий кадр», щоб на стандартній шаблон-сторінці документа був 

розташований порожній текстовий кадр. Цей кадр має атрибути стовпців 

та полів, вказані в діалоговому вікні «Новий документ». 

 Якщо треба ввести текст у шаблонний текстовий кадр на сторінці 

документа, утримуйте клавіші Ctrl+Shift і клацніть текстовий кадр на 

сторінці документа. Потім клацніть всередині кадру інструментом 

«Текст» і починайте вводити текст.

 

4 Хід роботи 

1. Створіть нову публікацію: кількість сторінок – 4, розмір сторінки 

– А5, орієнтація – альбомна, кількість колонок – 2, розмір полів ліве – 10 

мм, праве – 15 мм, верхнє – 8 мм, нижнє – 12 мм, розворот. 

2. На першій сторінці по центру розмістіть текст Форматування 

символів та абзаців. 

3. Побудуйте на 2 та 3 сторінках два зв’язані текстові кадри по різміру 

сторінки. Для того щоб зв’язати кадри необхідно натиснути на вихідний 

порт першого кадру, а потім на вхідний порт другого кадру. 

4. Виберіть команду «Об'єкт» → «Параметри текстового фрейму» 

змініть такі параметри як кількість стовпців - 3 у текстових кадрах. 

5. Виконайте набір запропонованого тексту. 

6. Виконайте перевірку орфографії «Правка» →«Орфографія» → 

«Автоматичне виправлення». 

7. Користуючись панеллю керування виконайте наступне 

форматування (для цього повинен бути активним інструмент «Текст»): 

a) Перший абзац: шрифт – Mistral Century, кегль- 12 пт, інтерліньяж – 

18 пт, відступ абзацу справа – 10 мм. 

b) Для другого абзацу: символи - капітель, ви ключка – по формату з 

останнім рядком вліво. 

c) Третій абзац:відбивка перед абзацом – 6 мм, колір тексту –зелений, 

символи – підрядковий індекс. 

d) Заголовок: шрифт – Arial, кегль – 18 пт, відбивка після абзацу – 6 

мм, колір тексту – жовтий, виконайте обводку – синім кольором. 

8. Виділіть текстові фрейми виконайте заливку текстових кадрів світло 

сірим кольором та обводку: тип лінії – хвиляста, товщина – 10 пт, колір - 

синій. 

9. Здійсніть вставку символу ® вкінці першого та третього абзаців 

Текст→Гліфи. 

10. Збережіть публікацію під назвою Текст1.indd. 



11. Створіть нову публікацію: кількість сторінок – 4, розмір сторінки 

– В5, орієнтація – книжна, прапорець – шаблоний текстовий фрейм, 

розмір полів ліве – 15 мм, праве – 12 мм, верхнє – 18 мм, нижнє – 12 мм. 

12. Заповніть текстові фрейми шаблонним текстом «Текст» → 

«Заповнити шаблонним текстом» або команда «Заповнити 

шаблонним текстом» контекстного меню. 
13. Збережіть публікацію під назвою ШаблоннийТекст.indd. 

14. Створіть публікацію: кількість сторінок – 1, розмір сторінки – 

200х200 мм, розмір полів по 10 мм. 

15. Розмістіть на сторінці 6 текстових 

фреймім довільним чином. Розмір 

фреймів 50х50 мм. Чотири 

прямокутні фрейми. Два останні 

багатокутні фрейми (трикутник та 

семикутна зірка). Виберіть інструмент 

«Багатокутний фрейм» клацніть один 

раз лівою клавішою миші у вікні, що 

з’явилось встановіть необхідні 

параметри. 

16. Перетворіть створені фрейми у зв’язані. 

17. Змініть розмір першого фрейму довільни чином. 

18. За допомогою інструменту «Часткове виділення» перетворіть 

другий на трапецію. 

19. Для третього фрейму виконайте команду «Об'єкт» → «Параметри 

текстового фрейму» змініть такі параметри як кількість стовпців – 

встановіть 2.  

20. Четвертий фрейм залийте довільним кольором, 

непрозорість 40%. За допомогою інструменту «Перо, додати 

опорну точку», додайте стільки точок, щоб перетворити 

форму фрейму за допомогою інструменту «Часткове 

виділення» на фантазійну фігуру. 

21. Змініть розмір п’ятого фрейму: висота – 60 мм, ширина – 40 мм, 

встановіть округлений тип кутів на 12 пт. 

22. Залийте  фрейм  жовтим  кольором,  непрозорість  50%  та  застосуйте  

до 
 

шостого фрейму ефекти: тіні та глянець. На Панелі управління кнопка fx. 
 

23. Заповніть зв’язані фрейми шаблонним текстом. 
 

24. Виконайте поворот першого фрейму на 20° за допомогою Панелі 

управління  або Об’єкт →Трансформувати→Поворот. 

25. Виділіть усі об’єкти (обведіть їх утримуючи ЛКМ або Ctrl+A) та 

згрупуйте виконавши команду Об’єкти →Згрупувати або Ctrl+G. 



26. Заблокуйте усі об’єкти на сторінці (після цього редагувати об’єкти 

буде не можливо). Для цього виділіть їх та виконайте команду Об’єкти 

→Заблокувати або Ctrl+L. 

27. Збережіть публікацію під назвою ТекстовіФрейми.indd. 
 

5 Висновки: в процесі виконання лабораторної роботи студент має 

навчитися створювати текстові кадри, виконувати їх переміщення, зміну 

розміру, створювати зв’язані текстові блоки. 

 
 

6 Контрольні запитання 

1 Як виконати зміну розміру фрейму, напишіть усі відомі способи? 

2 Відобразити лінії зв’язку зв’язаних фреймів? 

3 Що означає червоний плю в вихідному порті текстового кадру ? 

4 Який значок буде у вхідному та вихідному портах зв’язаних кадрув? 

5 Як зв’язати існуючі текстові кадри? 

6 Чи видалиться фрагмент тексту, якщо видалити текстовий 

кадр із ланцюжка зв’язаних кардрів? 

7 Як здійснити перевірку орфографії? 

8 Чи можна виконати налаштування параметрів перевірки орфографії? 
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Інструкція для виконання лабораторної роботи №30 
 

Тема: Імпорт тексту. Форматування символів та 

абзаців. 

 

1 Мета: Знати як виконується імпорт тексту. Уміти виконувати 

форматування символів та абзаців. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe InDesign 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Вставлення тексту з іншої програми 

1. Щоб зберегти форматування та інформацію, як-от стилі та маркери 

індексів, відкрийте розділ «Робота з буфером» діалогового вікна 

«Параметри» та виберіть у пункті «Вставка» елемент «Вся інформація». Щоб 

видалити ці елементи та інше форматування під час копіювання, виберіть 

елемент «Тільки текст». 

2. Виріжте чи скопіюйте текст в іншій програмі чи в документі InDesign. 

3. Якщо потрібно, виберіть текст чи клацніть у текстовому кадрі. Інакше 

текст буде вставлено у власний новий кадр. 

4. Виконайте одну з описаних нижче дій. 

 Виберіть команду «Правка» → «Вставити». Якщо вставлений текст не 

містить усього форматування, можливо, знадобиться змінити налаштування в 

діалоговому вікні «Параметри імпорту» для документів RTF.

 Виберіть команду «Правка» → «Вставити без форматування». 

(Команда «Вставити без форматування» заблокована при вставці з іншої 

програми, якщо в пункті «Параметри оброблення буфера обміну» вибрано 

варіант «Тільки текст».)

Можна також перетягнути текст з іншої програми безпосередньо в 

документ InDesign, або ж вставити текстовий файл чи файл програми 

обробки текстів просто в документ InDesign з Провідника Windows. Текст 

буде додано до нового кадру. При перетягуванні з натисненою клавішею Shift 

форматування усувається. 

Розміщення (імпорт) тексту 

Переконайтесь що не виділені або виділений потрібний текстовий блок. 

1. Виберіть команду «Файл» → «Помістити». 

2. Якщо імпортований файл повинен замінити вміст виділеного кадру чи 

виділений текст або замінити вміст виділеного кадру, виберіть команду 

«Замінити виділений елемент». Щоб увести імпортований файл у новий кадр, 

слід вимкнути цей параметр. 



3. Виберіть Показати параметри імпорту та двічі клацніть по файлу, який 

треба імпортувати. 

4. Налаштуйте параметри імпорту та натисніть кнопку «OK». 

Перегляд прихованих символів (які не друкуються) 

1 Виберіть команду «Текст» → «Показати приховані символи». 

Вставка спеціальних символів Текст→Гліфи 

4 Хід роботи 

1. Створіть нову публікацію: кількість сторінок – 8, розмір сторінки 

– А4, шаблонний текстовий кадр, орієнтація – книжна, кількість колонок – 

2, розмір полів ліве, праве – 10 мм, верхнє – 20мм, нижнє – 25 мм. 

2. Виберіть інструмент «Текст» для того щоб почати набір тексту 

натисніть комбінацію клавіш Ctrl+Shift. 

3. Виконайте імпортування документу Заготовка.doc Файл→Помістити 

(Ctrl+D). 

4. Виконайте форматування тексту. Для цього повинен бути 

активним інструмент «Текст». 

5. Користуючись панеллю керування виконайте наступне 

форматування: 

a. Перший абзац: гарнітура – Mistral, кегль- 16 пт, першу букву 

перетворіть на буквицю висотою на три рядки, інтерліньяж – 24 пт, 

відступ абзацу справа та зліва – 5 мм. 

b. Для другого абзацу: гарнітура – Time New Roman, кегль – 24 пт, 

символ – надрядковий індекс. 

c. Третій абзац: гарнітура – Time New Roman, кегль – 16 пт, відбивка 

перед абзацом – 6 мм, колір тексту –зелений. 

d. Четвертий абзац: гарнітура – Arial, кегль – 16 пт, відбивка після 

абзацу – 6 мм, колір тексту – білий, виконайте обводку – синім кольором. 

6. Виділіть весь текстовий кадр виконайте заливку світло жовтим 

кольором. 

7. Здійсніть вставку символу ☺перед заголовком Текст→Гліфи. 

8. Збережіть документ під назвою Форматування1.indd. 

9. Створіть нову публікацію: кількість сторінок – 1, розмір сторінки 

– А4, орієнтація – альбомна, розмір полів ліве, праве – 15 мм, верхнє – 

20мм, нижнє – 25 мм. 

10. Створіть 4 текстових кадри, висота 100 мм, ширина – 50 мм. 

11. Зв’яжіть текстові кадри. 

12. Залийте текстові кадри світло жовтим кольором. 

13. Виконайте імпорт документу Вулиці.doc Файл→Помістити (Ctrl+D). 

14. Виконайте форматування тексту. Для цього повинен бути активним 

інструмент «Текст». 

15. Користуючись панеллю керування виконайте наступне 

форматування: 

a. Шрифт – Book Antiqua, кегль- 14 пт, інтерліньяж – 18 пт, відступ перед 

абзацу – 4 мм, справа та зліва – 3 мм, відступ першого абзацу – 10 мм. 



16. Виконайте обрамлення текстових кадрів: колір – темно синій, товщина 

– 5 пт, тип кута - фігурний. 

17. Додайте ефект тіні до текстових кадрів, виділіть кадри за допогою 

інструменту «Виділення» та натисніть кнопку «Тінь» на Панелі  

управління. 

18. Збережіть документ під назвою Форматування2.indd. 

 

5 Висновки: в процесі виконання лабораторної роботи студент повинен 

вміти виконувати імпорт тексту, форматування символів та абзаців. 

 

 

6 Контрольні запитання 

1 Як виконати зміну розміру шрифту?  
2 Здійснити зміну гарнітури за допомогою пункту меню Текст?  
3 Відобразити на екрані панель Символ?  
4 Приховати панель Абзац?  
5 Вирівняти абзац по правому краю за допомогою панелі керування?  
6 Вирівняти абзац по правому краю за допомогою панелі Абзац?  
7 Як набрати текст капітеллю ?  
8 Змінити трекінг можна за допомогою?  
9 Виконати обводку символів?  
10 Змінити колір символів? 

 

 

 

Література 

1 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 

2008. -600 с. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

3 Глинський Я.М. Інформатика Практикум з інформаційних технологій. – 

Тернопіль: Підручники і посібники, 2014 – 304 с. 

4 https://helpx.adobe.com/ua/indesign/user-guide.html 

 

 

 

 

 

 

 

 

 



Інструкція для виконання лабораторної роботи №31 
 

Тема: Імпорт графіки та компонування тексту і 

графіки 

 

1 Мета: Уміти виконувати імпорт графіки та компонування тексту та 

графіки. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe InDesign 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

Розміщення (імпорт) графіки 

Команда «Помістити» — це основний спосіб для вставляння графіки в 

InDesign, тому що він забезпечує найвищий рівень підтримки роздільної 

здатності, файлових форматів, багатосторінкових PDF-файлів та файлів 

INDD, а також кольорів. Помістити графіку – це те саме, що й імпортувати 

зображення або вставити малюнок. 

1. Виконайте одну з описаних нижче дій. 

 Для того, щоб імпортувати графіку не створюючи кадр, 

перевірте, чи в документі не виділено жодного елемента.

 Щоб імпортувати графіку до існуючого кадру, виділіть його. 

Якщо нове зображення більше за розмір кадру, ви можете змінити кадр 

пізніше, виконавши команду "Об'єкт → Припасування" .

 Щоб замінити існуюче зображення, виділіть його графічний кадр.

2. Оберіть команду "Файл →Помістити" та виділіть один або 

декілька графічних файлів будь-якого доступного формату. 

Якщо ви виділяєте декілька файлів, ви можете розмістити їх одночасно у 

документі, клацнувши кнопкою миші або перетягнувши їх у документ. Якщо 

виділяєте один натисніть «Відкрити» та розтягніть рамку необхідного 

розміру. 

3. Щоб замінити виділений вами об'єкт, оберіть "Замінити 

виділений елемент". 

4. Щоб додати підпис на базі метаданих зображення, виберіть 

«Створити статичні підписи». 

Щоб налаштувати параметри для імпорту у певному форматі, виконайте одну 

з наступних дій: 

5. Виберіть Показати параметри імпорту та натисніть «Відкрити». 

6. Натискаючи «Відкрити», утримуйте клавішу Shift або двічі 

клацніть кнопкою миші по імені файлу, також утримуючи клавішу Shift. 

Копіювання та вставлення графіки 



1. В InDesign або іншій програмі виділіть оригінальну графіку та 

оберіть "Правка → Копіювати". 

2. Перейдіть до вікна документа InDesign та оберіть "Правка → 

Вставити". 

Для здійснення вкладання графіки в межах контейнерних кадрів 

скористайтеся командою «Вставити в». 

Припасування об'єкта до кадру 

 

Якщо кадр та його вміст різні за розміром, ви можете скористатися командою 

«Припасування», щоб досягти ідеального припасування 

1 Виділіть кадр об'єкта. 

2 Виберіть «Об'єкт → Припасування (Подгонка)» та один з параметрів. 

Можна вибрати параметр «Автоматичне припасування» на панелі керування. 

 

4 Хід роботи 

1. Відкрийте раніше створений документ Стиль.indd 

Файл→Відкрити. 
2. Зробіть активною першу сторінку. 

3. На монтажному столі створіть фрейм у вигляді шестикінечної 

зірки. (Виберіть інструмент Багатокутний фрейм, викличте вікно 

параметрів клацніть ЛКМ, кількість сторін-6, висота променів зірки-30%) 

4. Виділіть об’єкт інструментом «Виділення» та виконайте команду 

Файл→Помістити, оберіть довільний графічний файл, натисніть Ок. 

5. Виконайте команду Об’єкт→Припасування→Припасувати 

вміст із збереженням пропорцій або відповідна команда контекстного меню 

об’єкта. 

Для переміщення зображення у кадрі, виберіть інструмент «Виділення» 

наведіть його у центр фрейму вигляд вказівника зміниться на «Рука» 

затискаючи ліву клавішу миші виконайте переміщення зображення. 
 

6. Перемістіть графічний кадр на текст та 

виконайте обтікання текстом навколо фігури на відстані 

2 мм. Панель «Обтікання текстом» (Вікно→ 

Обтікання текстом). 

7. За   допомогою   панелі   «Вирівнювання» 

(Shift+F7) виконайте вирівнювання кадру по правому 

верхньому краю. 

8. Створіть прямокутний фрейм тип лінії 

контуру, товщина та колір довільні, встановіть 

округлення кутів. 
 

9. Перемістіть створений фрейм у текст. 

Встановіть обтікання текстом Навколо рамки та 

встановіть прапорець Інвертувати. Вирівняйте фрейм по 

центру панель «Вирівнювання». 



10. Переконайтесь що нічого не виділено та 

виконайте команду Файл →Помістити, оберіть 

графічний файл, натисніть кнопку Відкрити. Біля 

вказівника миші з’явиться піктограма зображення 

розтягніть рамку кадру або клацніть один раз лівою 

клавішею миші для розміщення зображення. Цей кадр 

розташуйте на монтажному столі. 

11. Створіть овальний кадр на монтажному столі, скопіюйте і 

розмістіть в фреймі зображення з попереднього пункту (Копіювати , 

Вставити в). 

12. Виконайте припасування. 

Скопіюйте цей кадр, копію розмістіть у тексті, виконайте обтікання текстом 

по контуру на відстані 1 мм. Вирівняйте цей кадр по лівому нижньому краю. 

14. Створіть багатокутний фрейм на  

монтажному столі. 

За допомогою Панелі «Обробка контурів» 

(Вікно→Об’єкти і макети→Обробка контурів) 

перетворіть створений багатокутнику у трикутник. 

15. Залийте трикутний фрейм градієнтом 

довільного кольору. Надайте ефект тіні. 

Об’єкт→Ефект→Тінь (тінь темно синього кольору, 

відстань 10мм, непрозорість 50%) 

16. Перемістіть овальний кадр на монтажному столі так щоб він 

пересікався з трикутним кадром. Розмістіть трикутний кадр на задній план. 

Об’єкт→Порядок→Перемістити на задній план. 

17. Скопіюйте овальний кадр, копію розмістіть під трикутним 

кадром. Надайте йому ефект непрозорості 50% за допомогою панелі Ефекти. 

18. За допомогою інструмента «Лінійка» виміряйте висоту овального 

кадру. 

19. Задопомогоюінструментівгрупи 

«Трансформування» виконайте поворот, нахил, 

зміну масштабу овального кадру. 

20. Змініть розмір графічних кадрів на монтажному столі 

так щоб усі були видимі. Згрупуйте їх та перемістіть на останню сторінку 

публікації. 

21. Виконайте нумерацію сторінок римськими цифрами. 

Макет→Параметри нумерації і розділу. Подивіться на панелі Сторінки чи 

виконалась нумерація. 

22. Збережіть документ у власній папці з назвою Графіка2.indd. 

 

5 Висновки: в процесі виконання лабораторної роботи студент повинен 

вміти виконувати імпорт графіки та компонування тексту та графіки. 

 

 

6 Контрольні запитання 



6.1 Як помістити зображення у кадр? 

6.2 Напишіть як  виконати припасування? 

6.3 Як перемістити зображення у кадрі? 

6.4 Як змінити розмір зображення у кадрі? 

6.5 Виконати обтікання текстом? 

6.6 Які способи обтікання текстом ви знаєте? 

6.7 Способи вирівнювання зображення в тексті? 

6.8 Як згрупувати два і більше об’єкти? 

6.9 Заблокувати об’єкти можна? 

 

Література 

1 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 

2008. -600 с. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

3 Глинський Я.М. Інформатика Практикум з інформаційних технологій. 

– Тернопіль: Підручники і посібники, 2014 – 304 с. 

4 https://helpx.adobe.com/ua/indesign/user-guide.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Інструкція для виконання лабораторної роботи №32 
 

Тема: Верстка журнальної сторінки. 

 

1 Мета: Уміти виконувати верстку журнальної сторінки. 

 

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програма Adobe InDesign 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

4 Хід роботи 

1. Створимо журнальний розворот (тема довільна: спорт, мода, 

кулінарія). Для цього спочатку за допомогою мережі Інтренет підготуємо 

текстову та графічну інформацію, збережіть її у своїй папці.  
2. Створіть нову публікацію: кількість сторінок – 4, розворот, розмір 

сторінки – А4, орієнтація – книжна, розмір полів зовні – 10 мм, зсередини 

– 15 мм, верхнє – 25мм, нижнє – 15 мм. 
 
3. Перейдіть на ліву А-шаблону сторінку розворот. Створіть зверу 

біля поля прямокутник на весь розворот, висотою приблизно 10 мм.  
4. Заповніть прямокутник блакитним кольором.  
5. Вставте знизу сторінки колонцифру (нумерація сторінок). Для 

цього створіть маленький текстовий кадр приблизно 10х10 мм, коли у 

ньому з’явиться курсор викличте контекстне меню→Вставити 

спеціальни символи→Маркери→Номер поточної сторінки або 

натиснути комбінацію клавіш Alt+Shift+Ctrl+N.  
6. Відформатуйте колонцифру наприклад: шрифт - Monotype Corsiva, 

кегль – 16 пт, колір – синій, контур – чорний.  
7. Скопіюйте колонцифру та розмістіть її на правій шаблоній сторінці.  
8. Розмістіть на свій смак будь-які об’єкти, які б ви хотіли. Наприклад 

можна розмістити фонове зображення на весь розворот. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



9. Перейдіть на другу сторінку публікації. 

10. Створіть графічні та текстові фрейми аби наповнити їх інформацією. 

Не забудьте, що текстові кадри повинні бути зв’язаними. 
11.  

 
 

11. Виконайте імпорт текстової та графічної інформації. 12.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. Збережіть створену публікацію у власній папці з назвою Журнал.indd. 

Після цього виконайте команду Файл→Упакувати (імя та місце 

збереження теж саме). Так як публікація містить інформацію з інших 

файлів необхідно виконувати дану команду. 
13.  



13. Створіть обкладинку журналу на власний смак, та збережіть у власній 

папці з назвою Обкладинка.indd. 
14.  

14. Самостійно виконайте верстку книжної обкладинки та розвороту. 

Документ збережіть у власній папці з назвою Книга.indd 

 

 

Література 

1 БотеллоК. Adobe InDesign, Photoshop и IIIustrator :Руководство 

дизайнера, пер.с англ. Серия: Мастер-класс/ Рединг Э. А.; М.: Эксмо, 

2008. -600 с. 

2 Василюк А. С., Мельникова Н. І. Комп’ютерна графіка Навчальний 

посібник. Львів : Видавництво Львівської політехніки, 2016. 308 с.  

3 Глинський Я.М. Інформатика Практикум з інформаційних технологій. 

– Тернопіль: Підручники і посібники, 2014 – 304 с. 

4 https://helpx.adobe.com/ua/indesign/user-guide.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Інструкція для виконання лабораторної роботи №33-34 
 

Тема: Створення рекламних макетів з використанням CorelDraw, Adobe 

Photoshop та Adobe Indeign. 

 

1 Мета: Уміти виконувати верстку журнальної сторінки. 

  

2 Матеріально-технічне  та навчально-методичне забезпечення: 

2.1 Інструкція до виконання роботи 

2.2  Персональний комп'ютер 

2.3 Програми Adobe InDesign, CorelDraw, Adobe Photoshop 

2.4 Мультимедійний проектор 
 

3 ТЕОРЕТИЧНІ ВІДОМОСТІ: 

4 Хід роботи 

ІНДИВІДУАЛЬНЕ ЗАВДАННЯ 

 

Презентація комплексу фірмового стилю уявного бренду (на вибір 

студента) із розробленими та оформленими за допомогою відповідного 

комп’ютерного програмного забезпечення (Adobe Photoshop, Corel Draw, 

Adobe InDesign та інші) елементами: 

 логотипом, слоганом, фірмовою колористикою бренду; 

 оформленою візиткою представника бренду; 

 прес-релізом (бекграундером) про бренд (виконаний на 

фірмовому бланку) або фірмовим буклетом; 

 зверстаним рекламним блоком для газети або журналу. 

Індивідуальна робота оформлюється у вигляді кейсу, в форматі Microsoft 

Powerpoint або PDF (максимальний обсяг – 15 слайдів). 

 

 

ЗАВДАННЯ № 2  Розробка модульної реклами для газети та журналу 
 

Користуючись програмою Adobe InDesign, оформити рекламне звернення 

довільного продукту для газети й журналу. 

 Можливі формати рекламних оголошень для тижневика 

«Суббота плюс»: 235*286 мм (627 кв.см), 235*141 мм (331 кв.см), 

139,4*286 мм (399 кв.см), 139,4*213,5 (298 кв.см); 

 можливі формати рекламних звернень для журналу: повний 

аркуш А4 або А5. 

Необхідно розробити концептуальну ідеї рекламного оголошення в 

програмі Adobe InDesign, використовуючи необхідні фотографії, текстові й 

графічні елементи, та адаптувати її до газетного й журнального формату. 

 



Дозвольте відрекомендувати вам нову торгівельну марку «Бейбі 
Бум». 

Дитяче харчування для малюків від 1-3 
років. 

Поєднання якості і вітамінів вразить 
Вас! 

ВАЖЛИВО! Робота виконується індивідуально й подається викладачеві в 
друкованому вигляді та в електронному форматі (pdf або jpg). Також докладається 
вихідний файл (*indd). 

 

 

 

Приклад оформлення кейсу 

 

Слайд 1 
 



Слайд 2 
 

 

 

 
 

 

Всім нам відомо, що дітям в такому віці складно пояснити чого саме вони 

хочуть. 

Але ми чуємо їхні думки... 

Ми можемо задовільнити їхні бажання! 
 
 
 

 

Слайд 3 
 

 

А зараз я розповім Вам, про фірмовий стиль цього бренду. 
 



Слайд 4 
 

 

 

ФІРМОВИЙ ШРИФТ 
 

 

Для цієї продукції я обрала шрифт Arial Narrow 

 
 
 
 
 
 
 

 

Слайд 5 
 

 

Фірмова емблема 
 
 

Використанний 

малюк для емблеми 
 
 
 
 
 
 
 
 
 
 
 

 

Як ви бачите фірмовою емблемою є як літери (назва), так і малюк, який розташований посередині 

двох слів. 



Слайд 6 
 

 

 

Фірмовий лозунг 
 
 
 
 

Всім відомо, що дітям в такому віці складно пояснити 

чого саме вони хочуть. 

Тому я вигадала лозунг, в якому йдеться про те, що ми чуємо думки 

дитини. 

Таким лозунгом я даю змогу зрозуміти батькам, що їхня дитина хоче саме 

“Бейбі Бум” ! 
 
 

 

Слайд 7 
 

 

 

Візитка 
 
 
 
 

 



Слайд 8 
 

 

 

 

Ммм… “Бейбі Бум” 
 
 
 

 

 

Слайд 9 
 

 

Дякую за увагу… 
 
 
 
 
 
 

 

пам’ятайте… 

 
 
 
 

 
…ми читаємо думки:) 
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2008. -600 с. 
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Інструкція до виконання лабораторної роботи №34-35 

 

Тема: Основні теги HTML. Створення пов’язаних WEB-сторінок. 

 

1 Мета роботи: Уміти створювати нескладні веб-сторінки засобами мови 

HTML. Створити сторінку з гіперпосиланнями і динамічними ефектами. 

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Мультимедійний проектор 

 

3 Теоретичні відомості: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Структура HTML 

документа. Списки. Таблиці. Гіперпосилання» 

 

Головні теги для форматування тексту. 
<Р> — початок нового абзацу; його прийнято записувати в кінці 

попереднього. Наступне речення починатиметься з нового, вирівняного до 

лівого краю абзацу без відступу в першому рядку. 

<BR> — наступний за цим тегом текст буде наведено у новому рядку без 

пропуску порожнього рядка. 

<HR> — буде проведена горизонтальна лінія. 

<В> текст </В> — товстий шрифт тексту, що є між тегами. 

<І> текст </І> — шрифт-курсив. 

<U> текст </U> — підкреслений шрифт. 

<BIG> текст </BIG> — великий шрифт. 

<SMALL> текст </SMALL> — малий шрифт. 

<ЕМ> текст </ЕМ> — виокремлений курсивом текст (тег І). 

<В> <І> текст </Іх/В> — товстий курсив. Цей приклад демонструє 

застосування вкладення тегів. 

Графічні зображення (фотографії, картинки, піктограми тощо) зберігаються 

на серверах в окремих файлах з розширеннями bmp, jpg, gif та іншими і 

подаються на екран клієнта за допомогою команди, що задається одинарним 

тегом <IMG> з параметрами: 

<IMG SRC="aдlpeca графічного файлу" ALT= "альтернативний текст" 

ALIGN="left" WIDTH="240" HEIGHT="200"> 

Обов'язковим є лише перший параметр SRC. Альтернативний текст — це 

текст, який виводитиметься замість картинки, якщо браузер не може 

прийняти графічний файл або якщо вимкнено режим відображення графіки. 

Параметр ALIGN задає місце розташування картинки на екрані, а параметри 

WIDTH і HEIGHT — її розміри по ширині і висоті в пікселях або відсотках. 

Наприклад, <IMG WIDTH=="300"> задає ширину картинки 300 пікселів; 



<IMG WIDTH="50%"> задає ширину картинки півсторінки у 

горизонтальному напрямку. 

Зображення можна подати в рамці, що рекомендують робити, якщо його 

використовуватимуть як гіперпосилання. Для створення рамки навколо 

зображення призначений параметр BORDER= "товщина рамки в пікселях". 

За допомогою тега IMG можна вставити також відеофільм, який 

запускатиметься в момент відкриття веб-сторінки: 

<IMG DYNSRC="адреса відеофайлу"> 

Є два види гіперпосилань: 1) на файл; 2) на деяке місце на цій сторінці, а 

саме: на початок сторінки — top, кінець сторінки — bottom, на деякий 

позначений текст. 

Деяке графічне зображення можна зробити гіперпосиланням. Для цього в 

середині тега <А>...</А> потрібно використати тег IMG. Наприклад, 

фотографію Світлани, що є у файлі "svitlana.gif", візьмемо в рамку і зробимо 

з неї гіперпосилання на файл newinf.htm: 

<А HREF = "newinf .htm"> <IMG SRC = "svitlana.gif" BORDER =8 ></A> 

Щоб вставити звук чи відео, достатньо як значення параметра HREF у тезі 

гіперпосилання задати шлях до відповідного звукового чи відеофайлу, який 

вже є на диску, наприклад: 

Тепер <А HREF="mysound.wav"> послухайте мене (150К) </А>. 

Динамічними називають ефекти, коли графічні зображення на веб-сторінці 

змінюються з часом, елементи сторінки змінюють розміри або навіть свій 

зміст після клацання над ними мишею, текст «біжить» вздовж екрана тощо. 

 

4 Хід роботи: 

4.1 Створіть свою особисту веб-сторінку.  
Відкрийте Блокнот. Введіть текст про себе за наведеним нижче зразком і 

збережіть його у файлі filel.htm: 

<HTML> 

<HEAD> 

<TITLE> My Be6-page </TITLE> 

</HEAD> 

<BODY BGCOLOR = "aqua" TEXT = "red"> 

<H2> Це веб-сторінка Світлани Марущак</Н2> <HR> 

<CENTER><B>Привіт!</B>Мене звати<B>Світлана</B> 

</CENTER><P> 

Я вчуся на другому курсі на факультеті прикладної математики 

Чернігівського промислово-економічного коледжу Київського національного 

університету технологій та дизайну .<I> Мені 17 років. Мої улюблені 

предмети: інформатика, математика, англійська мова, історія</І>. Я люблю 

слухати гарну музику, читати пригодницькі романи, подорожувати влітку, 



кататися на гірських лижах взимку, ходити на дискотеку у будь-яку пору 

року, інколи читати конспекти. <BR> 

<CENTER> Колись тут буде моя фотографія 

</CENTER><P>  

<ADDRESS> Moя адреса: 14032, Чернігів-32 

</ADDRESS><HR> 

</BODY> 

</HTML> 

Збережіть файл на диску з назвою file1.html у власній папці і перегляньте 

його за допомогою браузера, клацнувши на його піктограмі.  

4.2 Поекспериментуйте з тегами форматування тексту і розмірами вікна, 

в якому демонструється документ. 
 Переконайтеся, що браузер автоматично міняє розташування тексту, щоб 

його можна було переглядати без горизонтальної смуги прокручування 

4.3 Проекспериментуйте з різними значеннями кольорів (green, white, 
yellow, blue, #ffaa55 тощо) параметрів BGCOLOR і TEXT. 
4.4  Усі заголовки створіть у броузері зеленим кольором. 
4.5 Переробіть файл filel1.htm, щоб створити списки двох видів. Новий 

файл назвіть file2.htm. Перегляньте його у браузері. 
Ненумерований список утворюють за допомогою парного тега 
<UL> ...</UL> і одинарних тегів <LI>, наприклад, так: <LH> Мої 
улюблені предмети:</LH>  
<UL> 
<LІ>інформатика 
 <LІ>математика 
<LІ>англійська мова  
<LІ>історія 
</UL> 

На екрані отримаємо таке (ліворуч, а не в центрі): Мої улюблені 
предмети: 

• інформатика 
• математика 
• англійська мова 
• історія 
Нумерований список створюють за допомогою парного тега 
<OL>...</OL> з необов'язковим параметром TYPE та одинарних тегів 
<LI>, наприклад, так: 
<LH> Мої улюблені предмети:</LН> 
<OL TYPE="1"> 
<LІ>інформатика 
 <LІ>математика 
<LІ>англійська мова  
<LІ>історія 
</OL> 
На екрані отримаємо: 
Мої улюблені предмети: 
1. Інформатика 
2. Англійська мова 
3. Історія 
4.6 Використайте якнайбільше тегів форматування і надайте своїй 
сторінці якнайліпшого вигляду. 
Скільки тегів форматування використано під час створення сторінки? 



 

4.7 Вставити дві свої фотографії або, якщо фотографій немає, деякі 

картинки. 

Тег IMG може мати такий вигляд: 

<IMG SRC="d:/images/myfoto.gif" ALT="H на морі">. 
Для виклику віддалених файлів, тобто файлів, які є на серверах у мережі 
Інтернет, адресу записують із зазначеням назви протоколу доступу http і 
URL- адреси файлу, наприклад, 
SRC = "http://www.polynet.lviv.ua/ourpage.htm". 
Для доступу до файлів на локальному диску використовують протокол 
доступу file: SRC = "file:///диск:/шлях до файлу". Наприклад, SRC = 
"file:///d:/mycatalog/mypage.htm". Назву протоколу можна інколи не писати, 
наприклад, SRC = "c:/windows98/f orest.bmp". 
Якщо графічні чи інші файли є в тому ж каталозі, що основний html-файл, то 
достатньо зазначити лише назву файлу, наприклад, SRC = "myfoto.gif". Якщо 
файл є в деякому сусідньому каталозі images, то шлях до нього подають так: 
"../images/myfoto.gif". Отже, тег IMG може мати такий вигляд: 
<IMG SRC = "c:/windows98/forest.bmp" ALT = "Ліс">. 
4.8 Вставте у свій файл гіперпосилання на об'єкти: графічні, звукові та 

відеофайли, які доступні на вашому комп'ютері, а також на деякий html- 

файл, наприклад, file1.htm. Збережіть файл під назвою file3.htm 

Гіперпосилання вставляють за допомогою парного тега <А>...</А> з 

параметром HREF = "адреса файлу". 

У реченні "Мене звати Світлана" слово "Світлана" потрібно зробити 

гіперпосиланням на файл "newinf.htm", що містить додаткові відомості про 

Світлану (цей файл ще треба створити). Це роблять так: 

Мене звати <А HREF = "newinf.htm"> Світлана</А>. 

На екрані слово Світлана буде підкреслене і зображене іншим кольором. 

4.9 Застосуйте гіперпосилання для переходу на початок та кінець 

сторінки. 

Для  цього  слід  у  документі,  на  який буде виконано перехід, задати певну 

опорну точку, або якор.   

 <A NAME="R1"> МТД-212 </A>.  

У цьому випадку текст, що міститься в середині контейнера, не буде 

відрізнятися від тексту всього документу. Таким чином, якщо  необхідно  

виконати  перехід  на  якор R1, що  міститься  у файлі file3.htm, слід у 

документі, звідки иконуватиметься перехід, задати мітку   

<A HREF=" file3.htm #R1"> Перехід до МТД-212  </A>. 

4.10 Застосуйте гіперпосилання для переходу на сайт нашого коледжу. 

<A HREF="http://cnmtt.at.ua/">сайт</A> 

4.11 Застосуйте тег MARQUEE до одного з заголовків і 

поекспериментуйте із його параметрами. 

Розглянемо ефект біжучого тексту в смузі, що має висоту HEIGHT ="висота 

в пікселях" і фон BGCOLOR ="колір фону". Ефект створюється за 

допомогою парного тега <MARQUEE>...</ MARQUEE>: 

http://www.polynet.lviv.ua/ourpage.htm
file:///d:\mycatalog\mypage.htm


<MARQUEE BGCOLOR=" green" HEIGHT = "40"> Вас вітає фірма 

Дeoл</lVIARQUEE> 

Текст «Вас вітає фірма Деол» пробігатиме в полосі справа наліво, 

заходитиме за край екрана і з'являтиметься знову праворуч. Такий ефект 

рекомендують застосовувати до заголовків сторінки. 

4.12 Продемонструйте створений сайт викладачу 

 

5 Висновки: В процесі виконання лабораторної роботи студент повинен 

отримати основні навики створення web-сторінок,  використання  

гіперпосилань, застосування мови HTML. 

 

6 Контрольні питання: 

6.1 Для чого призначена мова HTML? 

6.2 Що таке тег і які є теги? 

6.3 Які параметри може мати тег BODY? 

6.4 Який тег позначає початок нового абзацу? 

6.5 Які теги позначають товстий, курсивний і підкреслений шрифти? 

6.6 Яке призначення тега FONT? 

6.7 Яких значень можуть набувати параметри тега FONT? 

6.8 Які є типи списків? 

6.9 Як створити ненумерований (маркований) список? 

6.10 Яка особливість пари тегів <PRE>...</PRE> і як ЇЇ можна 

використати? 
6.11 Які теги призначені для вирівнювання елементів на сторінці? 
6.12 Як вставити графічне зображення у веб-сторінку? 

6.13 За допомогою якого тега вставляють гіперпосилання? 

6.14 Які є види посилань в межах одної веб-сторінки? 

6.15 Як вставити відеофільм у веб-сторінку? 

6.16 Які параметри може мати тег IMG? 

6.17 Як деяке графічне зображення зробити гіперпосиланням? 

6.18 Які є види посилань у межах одної веб-сторінки? 

6.19 Що таке якори? 
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Інструкція до виконання лабораторної роботи №37 

 

Тема: Розробка веб-сайту. Публікація та реєстрація сайту 

 

1 Мета роботи: отримати навички створення веб-публікацій засобами 

Google, ознайомитися з бібліотекою шрифтових та кольорових схем, типами 

макетів. Навчитися редагувати, форматувати та зберігати веб-публікацію. 

Розміщувати сайти на безкоштовних серверах. 

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Мультимедійний проектор 

 

3 Теоретичні відомості: 
Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Засоби автоматизованої розробки веб-сайтів» 

Створення веб-сайта засобами он-лайн системи керування веб-контентом 

відбувається в кілька кроків: 

1. Реєстрація облікового запису на сервері. 

2. Вибір імені сайта та шаблону для його оформлення. 

3. Створення сторінок сайта, системи навігації. 

4. Заповнення сторінок контентом. 

Розглянемо, як відбувається процес розробки веб-сайта засобами, що 

безкоштовно надає користувачам веб-сервер Google. Відповідний сервіс 

має назву Сайти Google. 

Для створення сайта потрібно: 

1. Відкрити у вікні браузера головну сторінку сайта Google (http:// 

www.google.com.ua). 

2. Вибрати у верхній частині сторінки гіперпосилання Ще /Сайти.  

3. Заповнити на сторінці Google Sites – безкоштовні веб-сторінки та 

вікі поля Електронна пошта та Пароль даними вашого облікового запису, якщо 

вони не заповнені. Вибрати кнопку Увійти. 

4. Вибрати на сторінці Сайти Google кнопку Створити сайт. 

5. Вибрати один з наведених шаблонів для створення сайта. За замовчуванням 

пропонується шаблон Пустий шаблон. 

6. Заповнити поле Дати назву сайта. Одночасно автоматично буде запропонована 

URL-адреса головної сторінки сайта. Вона матиме вигляд: 

https://sites.google.com/site/<назва_ сайта>. Частина назва_сайта не повинна містити 

літер кирилиці, а тому система пропонує запис українських слів літерами 

англійського алфавіту без пропусків. Для вказаної назви сайта системою буде 

запропонована адреса https://sites.google.com/site/ klasnezitta, але за бажанням її 

можна змінити. URL-адреса головної сторінки сайта повинна бути унікальною. 

7. Відкрити список Вибрати тему та вибрати тему оформлення сайта. За 

замовчуванням пропонується тема Запустити за умовчанням. Наприклад, виберемо 

тему Бейсбол. 

8. Увести символи в поле Введіть код, який Ви бачите на малюнку. 



9. Вибрати кнопку Створити сайт. 

У вікні браузера відкриється домашня сторінка вашого сайта. У верхній частині 

сторінки буде відображатися вказана вами назва сайта, зліва – панель навігації, у 

центральній частині – область для інформаційного блока сторінки із заголовком 

Домашня сторінка 

 

4 Хід роботи: 

1 Створіть на сервері Google сайт на тему Українські дослідники 
космосу:  

1. Доберіть URL-адресу для сайта, відповідну його назві. 
2. Виберіть тему оформлення Мерехтіння. 
3. Заповніть Головну сторінку описом матеріалів, які будуть 
розміщені на сторінках сайта, та даними про вас як розробника 
сайта. 
4. Створіть і розмістіть веб-сторінки на основі такої схеми 
внутрішньої структури: 
 
 
 
 
 
 
 
 

Виберіть для сторінок такі шаблони: Історія досліджень, Перший 
українець у космосі – шаблон Веб-сторінка, Новини з орбіти – 
шаблон Оголо-шення, Хронологія польотів – шаблон Картотека. 
5. Заповніть сторінку Історія досліджень текстовими матеріалами 
6. Створіть на сторінці Історія досліджень гіперпосилання для 
переходу на сторінку Новини з орбіти, пов’язавши його з першим 
реченням на сторінці. 
7. Розмістіть на сторінці Перший українець у космосі текстові та 
графічні матеріали, наприклад з папки Тема 4\Практична 
18\Попович, таким чином, щоб фотографія розміщувалася по центру 
сторінки, а текст – ліворуч і пра-воруч від неї. Використайте для 
компонування сторінки модульну сітку Три стовпці (просте). 
8. Створіть на сторінці Перший українець у космосі гіперпосилання 
для пе-реходу на сторінку з URL-адресою http://h.ua/story/285307, 
пов’язавши його з графічним зображенням. 
9. Налаштуйте на сторінці Хронологія польотів нетиповий список 
так, щоб у ньому містилися про кожний політ такі дані: рік польоту, 
космонавт, космічний корабель, опис. Заповніть список даними про 
3–4 польоти. 
10. Розмістіть на сторінці Новини з орбіти запис з останньою 
новиною із сайта http://space.vn.ua. 



11. Завантажте на сторінку Новини з орбіти сайта файли, що 
містяться в папці D\Файли. 
12. Повідомте викладачу URL-адресу вашого сайта. 
13. Продемонструйте свій сайт оточуючим і візьміть участь у 
конкурсі на створення ліпшого сайту.  
 

 

 

5 Висновки: В процесі виконання лабораторної роботи студент повинен 

навчитися створювати веб-публікацій засобами Google, редагувати, 

форматувати та зберігати веб-публікацію. Розміщувати сайти на 

безкоштовних серверах». 

 

 

6 Контрольні питання: 

6.1 Назвіть і поясніть етапи автоматизованого створення веб-сайтів 
засоба-ми веб-серверів. 
6.2  Які шаблони веб-сторінок використовуються під час 
створення веб-сайтів засобами сервісу Сайти Google? Опишіть їх 
особливості. 
6.3 Як вставити зображення на веб-сторінку? Що може бути 
джерелом зо-браження під час вставлення на веб-сторінку? 
6.4 Як пов’язати гіперпосилання з текстовим фрагментом? 
6.5 Як вставити відеооб’єкт на веб-сторінку? Що може бути джерелом 
відео?  
6.6 Які формати графічних, відео- та аудіофайлів рекомендується 
використовувати під час розміщення об’єктів на веб-сторінках? Чим 
це пояснюється? 
6.7 Чим відрізняються результати операцій вставлення графічних 
зображень та їх завантаження? 
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Інструкція до виконання лабораторної роботи №38 

 

Тема: Середа Dreamweaver.  

 

1 Мета роботи: Вивчити інтерфейс HTML-редактора Macromedia 
Dreamveawer, настроювання його параметрів на умови користувача.  

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Редактор Macromedia Dreamweaver 

2.4 Мультимедійний проектор 

 

3 Теоретичні відомості: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Основи веб-майстерності. 

Створення сайтів за допомогою програми візуального редагування web-

сторінок Adobe DreamWeaver.» 

 

4 Хід роботи: 

Початок роботи у Dreamweaver MX 
1)      Завантажте програму Macromedia Dreamweaver MX (Пуск - Програми -

 Macromedia - Macromedia Dreamweaver MX). 

2)      Розглянте основні елементи інтерфейсу програми . 

3)      Переключіться в режим Code, клацнувши мишкою на кнопці  . 

4)      Переключіться в режим Code and Design, клацнувши мишкою на кнопці  

 . 

5)      Переключіться в режим  Design, клацнувши мишкою на кнопці   . 

6)      Переключіться в режим  Code and Design, вибрав пункт меню View -

 Code and Design. 

7)      Зверніть увагу на HTML-код пустої сторінки. (Структура HTML-кода) 

8)      Замість  Untitled Document між тегами <title></title> напишіть "Моя перша 

сторінка". В результаті повинно вийти:<title>Моя перша строрінка</title> 

9)      (якщо в програмі некоректно відображаються російські букви, то виконайте 

настройку програми) 

10)  Натисніть клавішу Design і ви побачите, як зміни HTML-кода відобразились 

у вікні документа (у заголовкуу вікна програми з’явився напис "Моя пешая 

сторінка (Untitled-1)" 

11)  Натисніть клавішу F12, щоб побачити, як виглядає ваша сторінка в 

браузері. Зверніть увагу на заголовок вікна браузера. 

 

 



Принципи мови HTML 
1)     Зверніть увагу на HTML-код сторінки й зробіть так, щоб поміж 

тегами <body> </body> не було ніякої іншої інформації. 

2)      Між тегами <body> </body> напишіть який-небудь вірші. В результаті 

повинно вийти: 

< body> 

Люблю тебя, Петра творенье, 

Люблю твой строгий, стройный вид, 

Невы державное теченье, 

Береговой его гранит. 

< /body> 
3)      Натисніть клавішу Design и перегляньте результат. 

4)      Після кожного рядка поставте тег <br>. В результате повинно вийти: 

< body> 

Люблю тебя, Петра творенье, <br> 

Люблю твой строгий, стройный вид, <br> 

Невы державное теченье, <br> 

Береговой его гранит. <br> 

< /body> 
5)      Натисніть Design та перегляньте результат 

6)      Після вірша напишіть прізвище автора. В результаті повинно вийти: 

< body> 

Люблю тебя, Петра творенье, <br> 

Люблю твой строгий, стройный вид, <br> 

Невы державное теченье, <br> 

Береговой его гранит. <br> 

Пушкин А.С. 

< /body> 
7)      Зробимо вірш і підпис автора окремими абзацами. Поставте тег абзацу <p> 

де показано нижче:  

<p>Люблю тебя, Петра творенье, <br> 

Люблю твой строгий, стройный вид, <br> 

Невы державное теченье, <br> 

Береговой его гранит. </p> 

<p>Пушкин А.С.</p> 

< /body> 
8)      Виокремте прізвище автора тегами <b>. В результаті повинно 

вийти <b>Пушкин А.С.</b>. 

9)      Обраміть текст вірша тегами <i>. В результаті повинно вийти: 

<p><i>Люблю тебя, Петра творенье, <br> 

Люблю твой строгий, стройный вид, <br> 

Невы державное теченье, <br> 

Береговой его гранит. </i></p> 

< p><b>Пушкин А.С.</b></p> 

</body> 
10)  Поставте зайві пропуски між словами в якому-небудь рядку вірша. 
Наприклад: 



1 Люблю     тебя,     Петра      творение, 

11)  Перегляньте результат в режимі Design. 

Атрибути тегів 
1)      Обраміть прізвище автора тегами <marquee>. Повинно 

вийти: <marquee><p><b>Пушкин А.С.</b></p></marquee> Оцініть результат. 

2)      У відчиненому тезі <marquee> поставте атрибут direction="right". В 

результаті повинно вийти: <marqueedirection="right"><p><b>Пушкин 

А.С.</b></p></marquee> Оцініть результат 

3)      Поекспериментуйте з атрибутами: 

direction="up" 

direction="down" 

behavior="alternate" 

behavior="slide" 

4)      Виберіть пункт меню Help - Reference. 

2  
5)    У списку Book виберіть "O'Reilly HTML References", зі списку Tag виберіть 

MARQUEE, а з сусіднього списку виберіть атрибут behavior.   

6)      Попрацюйте з довідковою системою і з'ясуєте значення інших атрибутів. 

(Для тих хто володіє технічною англійською мовою) 

           5 Висновки: В процесі виконання лабораторної роботи студент 

повинен вивчити інтерфейс HTML-редактора Macromedia Dreamveawer, 
настроювання його параметрів на умови користувача, розміщення 
файлових об'єктів сайту та створення структури сайту. 

6 Контрольні питання: 

6.1 В якому розділі html-сторінки знаходиться тег <title>? 

6.2 В html-коді абзацу Ви між двома словами поставили п'ять прогалин. 

Скільки прогалин Ви побачите в браузері? 

6.3 Який з перерахованих тегів визначає абзац? 

6.4 Який з перерахованих тегів тільки переводить курсор на новий рядок? 

6.5 Яка з наведених конструкцій є синтаксично вірною? 
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Інструкція до виконання лабораторної роботи №39 

 

Тема: Робота з текстовою інформацією в Adobe Dreamweaver 

1 Мета роботи: Вивчити оновні прийоми при роботі з текстом у редакторі 
Macromedia Dreamveawer.  

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Редактор Macromedia Dreamweaver 

2.4 Мультимедійний проектор 

 

3 Теоретичні відомості: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Основи веб-майстерності. 

Створення сайтів за допомогою програми візуального редагування web-

сторінок Adobe DreamWeaver.» 

 

4 Хід роботи: 
    

Запустіть програму Dreamweaver MX (Пуск> Програми> Macromedia> Macromedia 

Dreamweaver MX). 

2) При запуску програми створюється новий HTML-документ. Знайдіть палітру 

об'єктів (Insert), панель властивостей (Properties). 

3) Якщо якоїсь палітри немає на екрані, то відобразіть її, використовуючи пункт 

меню Window. 

4) Приховайте панелі Insert і Properties, прибравши галочки перед пунктами Inserts і 

Properties в меню Window. 

5) Відкрийте на екрані палітру History, вибравши в меню Window команду Others> 

History. 

6) У правій частині екрана у вас з'явилася панель, в якій представлені відразу 

кілька палітр, але активізована в поточний момент тільки одна - палітра History. 

Щоб активізувати іншу палітру, клацніть мишкою на її назві. 

7) Відкрийте на екрані палітри Insert і Properties. Для цього в пункті меню Window 

виберіть спочатку команду Inserts, а потім Properties. 

Створення сайту в DreamWeaver 

1) Виберіть у меню Site команду New Site. 

2) Перейдіть на вкладку Advanced. В поле Site Name вкажіть назву вашого 

майбутнього сайту. Наприклад, MySite. 

3) В полі Local Root Folder потрібно вказати папку сайту. Клацніть по зображенню 

папки поруч з цим полем. 

4) Відкриється діалогове вікно, в якому потрібно вибрати папку, де будуть 

знаходиться файли сторінок. 

5) У списку Папка виберіть папку Мої документи. 

6) Клацніть мишкою по піктограмі створення нової папки. 

7) Введіть ім'я папки - ваше ім'я латинськими буквами. Натисніть Enter. 

8) Двічі клацніть піктограму програми нової папки, для того, щоб зайти в неї. 



9) Натисніть кнопку Зберегти. Локальна папка сайту обрана. 

10) Поле HTTP Adress залиште недоторканим. Прапорець Enabled Cache також не 

прибирайте. 

11) Натисніть кнопку ОК - новий сайт успішно створено. 

12) Викличте вікно Site (Файли сайту). Для цього в меню Window виберіть палітру 

Site. 

13) З'явиться вікно, подібне вікну Провідника в Windows, для операції з файлами 

сайту. 

14) Створимо новий файл. У пункті меню File виберіть команду New File. 

15) У правій частині вікна з'явиться піктограма нового HTML-файлу і його ім'я 

Untitled1.htm. 

16) Виправте це ім'я на index.htm. Для цього клацніть на ім'я файлу два рази, з 

інтервалом між клацаннями приблизно в 1 сек. 

17) Створимо папку, в яку будемо розміщувати всі графічні об'єкти нашого сайту. 

Для цього в меню File виберіть командуNew Folder (Нова папка) і введіть ім'я 

папки Images. 

 

18) Відкрийте файл index.htm. Для цього двічі клацніть по імені файлу у вікні Site. 

Переконайтеся, що він порожній. 

19) Перейдіть в режим одночасного відображення коду та дизайну. Для цього в 

меню View виберіть команду Code andDesign. Незважаючи на те, що на сторінці 

поки нічого немає, HTML-код вже містить деяку інформацію про сторінку. 

20) Закрийте вікно HTML-файлу, натиснувши кнопку закриття вікна документа. 

Потрібно клацнути по другому зверху хрестику, тому що перший хрестик 

відноситься до вікна програми Dreamweaver. 

Установка параметрів сторінки 

1) Активізуйте сайт для роботи. Для цього в палітрі Site з розкриває списку 

виберіть ім'я вашого сайту. 

2) Клацніть двічі на значку файлу index.htm, щоб почати з ним роботу. 

3) Налаштуйте коректне відображення символів російського алфавіту. Для цього в 

меню Edit виберіть команду Preferendes. 

4) Перейдіть на вкладку Fonts. Для цього клацніть мишею на назві вкладки в 

лівому фреймі. 

5) У списку Font Settings виберіть значення Cyrillic. 

6) Перейдіть в категорію New Document. 

7) У списку Default Encoding виберіть Cyrillic (Windows1251). 

8) Клацніть на кнопці OK. 

9) У будь-якому місці сторінки клацніть правою клавішею миші та в контекстному 

меню виберіть команду Page Properties. 

10) У поле Title введіть заголовок сторінки Моя перша Web-сторінка. 

11) У списку Document Encoding виберіть Cyrillic (Windows1251). 

12) Клацніть на кнопці ОК. 

 

Форматування тексту 

     В папці Source у вас знаходяться документи в форматі Word, що представляють 

собою зміст теми «Web-технології», для якої ми будемо створювати Інтернет 

ресурс. 



1) Відкрийте в програмі Microsoft Word файл teor5.doc папки Source. Всю текстову 

інформацію з цього документа ми зараз перенесемо на Web-сторінку. Не 

закривайте програму Microsoft Word. 

2) Запустіть програму Dreamweaver MX. 

3) Переконайтеся, що в палітрі Site у вас обраний щойно створений сайт (MySite). 

4) Створіть нову сторінку (File> New ...) і збережіть її під ім'ям teor5.htm. 

5) За допомогою панелі завдань Windows перейдіть на вікно програми Word. 

6) Виділіть весь текст, вибравши пункт меню Правка> Виділити все. 

7) Треба скопіювати текст в буфер обміну, вибравши Правка> Копіювати. 

8) Перейдіть на вікно програми Dreamweaver. 

9) Поставте курсор в самий початок Web-сторінки в режимі Design. 

10) Вставте текст з буфера обміну на поточну сторінку, вибравши пункти меню 

Edit> Paste. Текст успішно вставився на Web-сторінку, але абсолютно без 

збереження будь-якого форматування. Це пов'язано з тим, що Dreamweaver не 

виробляє самостійне форматування тексту, скопійованого з "чужої" програми. 

Погляньте на HTML-код даної сторінки (для цього перейдіть в режим Code and 

Design). Кожен рядок вставленого тексту закінчується тегом <BR>, таким чином в 

цьому тексті немає навіть абзаців, а отже, щоб почати форматування необхідно 

розбити текст на абзаци. 

11) Визначимо в тексті абзаци. Для цього потрібно виконати такі дії. Поставте 

курсор в тексті, де повинен закінчуватися абзац і натисніть клавішу Enter, а потім 

клавішу Del для видалення порожнього рядка. 

12) Визначте абзаци в усьому тексті поточної сторінки. У міру роботи не забувайте 

зберігати сторінку (File> Save). 

13) Поверніться в початок сторінки і виділіть мишкою текст «Сценарії на стороні 

сервера» і за допомогою палітри властивостей встановіть в списку Format значення 

Heading2. 

14) Аналогічно для всіх назв мов серверного програмування (Perl, ASP і т.д.) в 

списку Formatустановіте значення Heading3. 

15) За допомогою списку вибору гарнітури шрифту встановіть для всіх заголовком 

гарнітуру «Arial, Helvetica ...», а для основного тексту гарнітуру «Verdana ...». 

16) Для основного тексту встановіть в списку Size розмір 3. 

17) Для заголовків підберіть колір за допомогою списку вибору кольору. 

18) Виберіть пункти головного меню програми: Modify> Page Properties. 

19) У діалоговому вікні в полі Background виберіть колір для фону сторінки. 

20) У поле Text виберіть колір для основного тексту сторінки. Пам'ятайте, що 

кольору фону і тексту повинні бути досить контрастні для кращого сприйняття. У 

процесі підбору кольорів ви можете натискати кнопку Apply для оцінки вибору без 

закриття вікна Page Properties. Для завершення роботи з вікном Page Properties 

натисніть кнопку ОК. 

21) Про призначення інших полів вікна Page Properties ви дізнаєтеся далі. 

22) За допомогою кнопок «B» і «I» на ваш смак змініть зображення у заголовків 

тексту. Встановіть вирівнювання назв мов серверного програмування по центру, а 

основного тексту - по ширині. 

23) Збережіть сторінку (File> Save). 

 

 

 



САМОСТІЙНА РОБОТА СТУДЕНТА 

1. Переведіть в формат HTML все текстові документи з папки Source. В результаті 

у вас повинні вийти такі сторінки: 

• index.htm - «Теоретичні відомості» (інформація з файлу index.doc) 

• teor1.htm - «Web-сторінка, Web-сайт, Web-сервер» (інформація з файлу teor1.doc) 

• teor2.htm - «Мови розмітки: HTML, XML, XHTML, WML» (інформація з файлу 

teor2.doc) 

• teor3.htm - «Мови сценаріїв. Технологія "клієнт-сервер" »(інформація з файлу 

teor3.doc) 

• teor4.htm - «Сценарії на стороні клієнта» (інформація з файлу teor4.doc) 

• teor5.htm - «Сценарії на стороні сервера» (інформація з файлу teor5.doc) 

• prakt.htm - «Практична робота» (інформація з файлу prakt.doc) 

• samost.htm - «Самостійна робота» (інформація з файлу samost.doc) 

• test.htm - «Тест» (інформація з файлу test.doc) 

2. Відформатуйте текстову інформацію на всіх сторінках в єдиному стилі. 

Зауваження. При виконанні форматування тексту статей допускається 

використання додаткових параметрів форматування за бажанням слухачів. Ви 

можете виділити в тексті найбільш важливі слова, створити нумеровані і 

маркіровані списки і т.п. 

3. Створіть нову сторінку avtor.htm і розмістіть на ній інформацію про себе, як про 

автора курсу. 

           5 Висновки: В процесі виконання лабораторної роботи студент 

повинен вивчити інтерфейс HTML-редактора Macromedia Dreamveawer, 
настроювання його параметрів на умови користувача, розміщення 
файлових об'єктів сайту та створення структури сайту. 

6 Контрольні питання: 

6.1 Записуючи на HTML абзац, Ви між двома словами поставили п'ять 

прогалин. Скільки прогалин Ви побачите в браузері? 

6.2  Який з перерахованих тегів визначає абзац? 

6.3 Який з перерахованих тегів тільки переводить курсор на новий рядок? 

6.4 Що визначає тег <PRE> ... </ PRE>? 

6.5 Якою конструкцією задається розмір шрифту? 
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Інструкція до виконання лабораторної роботи №40 

 

Тема: Табличний дизайн у Adobe Dreamweaver. 

 

1 Мета роботи: Знайомство з  табличним дизайном сторінки.  

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Редактор Macromedia Dreamweaver 

2.4 Мультимедійний проектор 

 

3Теоретичні відомості: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Таблична структура Web-

сайту» 

 

5 Хід роботи: 

 

1) Створити таблицю (2 рядки, 1 столбец) з наступними параметрами. 

Ширина (width) 770 пікселей, cellpadding=0, cellspacing=3, рамка (border) 

дорівнює нулю. 

2) Виділіть таблицю (натисніть на тег <table> в нижній частини вікна) і за 

допомогою панелі властивостей задайте вирівнювання (align) по центру 

сторінки (center). 

3) В першу комірку таблиці вставте нову таблицю (1 рядок, 2 стовпці) з 

параметрами (width=100%, border=1, а всі інші залиште без змін). Далі в 

панелі властивостей для нової таблиці поставте параметр Brdr Color # 

9ED1FF. 

4) В першу чарунку вставленої таблиці зробіть вставку зображення (insert - 

image) та оберіть файл wd.gif. Задайте для ячейки параметри: BgColor # 

9ED1FF, Brdr # 9ED1FF. 

5) У другому місці вставленої таблиці напишіть "Дистанційний курс". 

Задайте для клітинки параметри: BgColor # 9ED1FF, Brd # 9ED1FF. 

6) Вирівняйте цей напис по горизонталі. 

7) У другу сходинку першої таблиці вставте нову таблицю (1 рядок, 5 

стовпців) з параметрами (ширина = 100%, прикордонна = 1, а всі інші 

залиште без змін). 

8) В осередках вставленої таблиці напишіть назви пунктів основної навігації 

(всього 5 пунктів): "Практична робота", "Самостійна робота", "Задати 

питання", "Тест", "Про автора". 

9) Виділіть всі ячейки нової таблиці та вкажіть їм параметри: W = 20% (так 

як у нас 5 чарунок), Bg # 9ED1FF. 

10) Нижче першої таблиці створіть другу таблицю (1 рядок, 2 стовпці) з 

параметрами (width=770 пикселей, CellPadding=5, Cellspacing=0, border=1) 



11) В першій клітинці новой таблиці напишіть пункти теорії: 

 

· Web-сторінка, Web-сайт, Web-сервер 

· Мови розмарки: HTML, XML, XHTML, WML 

· Мови сценаріїв. Технологія "клієнт-сервер" 

· Сценарії на стороні клієнта 

· Сценарії на стороні сервера. 

Задайте ширину для першої чарунки (width=200 px). Встановіть 

вирівнювання в клітинці за допомогою списку: Vert: Top. 

12) У другу клітинку другої таблиці вставте інформацію з файлу teor1.doc. 

13) Загальна структура нашого сайту готова, тепер можна приступити до її 

оформлення (дизайну). 

14) Тепер вам потрібно підібрати кольори для "кнопок" основного меню 

сайту. Як ви вже здогадалися, "кнопками" є чарунки вкладеної таблиці. 

15) Кольори для інших елементів сторінки підбирати самостійно. Пам'ятайте, 

що основний текст сторінки повинен добре читатися, а меню навігації 

відразу "кинутись в очі", як тільки користувач заходить на вашу сторінку. 

16) Збережіть дану сторінку під ім’ям index.htm. 

 

Шаблони 

1) Запустіть програму Dreamweaver MX. 

2) Відкрийте сторінку index.htm. Збережемо сторінку як шаблон. 

3) Виберіть пункт File > Save As Template… 

4) У розгорнутому списку Site вибери свій сайт. В поле Зберегти як ... введіть 

ім'я «shablon». Вся сторінка збережена як шаблон. Визначимо області для 

редагування. 

5) Видаліть весь текст у головній області сторінки (теорія). 

6) Виділіть тег <td>, визначивши клітинку, де знаходиться текст і оберіть 

пункти меню Insert> Templates Objects> Editable region. 

7) У вікні, яке зявилося введіть назву редагованої області, наприклад, text. 

8) Знову збереніть шаблон, вибрав File > Save. 

9) На питання про внесення сторінок, створених на основі цього шаблону 

відповісти «Так», т.я. у нас все одно ще немає таких сторінок. Створюємо 

нову сторінку на основі шаблону. 

10) Виберіть пункт File > New… 

11) У вікні, що зявилося виберіть вкладку Templates. 

12) В списку Templates For  виберіть свій сайт і ви побачите створений 

шаблон у сусідній області. Натисніть кнопку Create. На новій сторінці ви 

можете змінити тільки ту область, яку призначили в шаблоні редагованої. 

13) Вставте на цю сторінку інформацію з файлу prakt.doc. 

14) Збережіть сторінку як prakt.htm. 

15) Створіть ще одну сторінку на основі шаблону, як ми зробили вище. 

16) Додайте на цю сторінку інформацію про підтримку випускників з файлу 

samost.doc. 

17) Збережіть цю сторінку як samost.htm. 



18) Відкрийте шаблону сторінку - shablon.dwt. 

19) Внесіть в неї зміни. Наприклад, змініть колір для фону лівого стовпця. 

20) Збережіть шаблону сторінку (File > Save). 

21) На питання про внесення сторінок, створених на основі цього шаблону, 

відповісти «Так». Відкрийте сторінки prakt.htm, samost.htm. В них 

відобразились ті зміни, які ми внесли в шаблону сторінку. 

 

Самостійна робота студента 

 

1. Відредагуйте шаблон-сторінку так, щоб сторінка здавалася найбільш 

привабливою. 2. Створіть нові сторінки на основі шаблону. У вас повинні 

бути наступні сторінки: 

· Index.htm - «Теоретичні відомості» (інформація з файлу index.doc) 

· Teor1.htm - «Веб-сторінка, Веб-сайт, Веб-сервер» (інформація з файлу 

teor1.doc) 

· Teor2.htm - «Розкладки мови: HTML, XML, XHTML, WML» (інформація з 

файлу teor2.doc) 

· Teor3.htm - «Мови сценаріїв. Технологія "клієнт-сервер"» (інформація з 

файлу teor3.doc) 

· Teor4.htm - «Сценарії на стороні клієнта» (інформація з файлу teor4.doc) 

· Teor5.htm - «Сценарії на стороні сервера» (інформація з файлу teor5.doc) 

· Prakt.htm - «Практична робота» (інформація з файлу prakt.doc) 

· Samost.htm - «Самостійна робота» (інформація з файлу samost.doc) 

· Test.htm - «Тест» (інформація з файлу test.doc) 

Організуйте гіперпосилання між сторінками. 

 

 Зауваження. Якщо ви на шаблонній сторінці визначте гіперпосилання 

основному меню сайту, то дані гіперпосилання будуть працювати на всіх 

сторінках, створених на основі шаблону. 

 

  В файлі avtor.htm створіть таблицю (2 стовпці, 1 рядок). У ліву чарунку 

додайте свою фотографію (або будь-яке інше зображення); за допомогою 

зовнішнього редактора встановіть потрібні розміри; введіть альтернативний 

текст: «Тут повинна бути моя фотографія»; задайте вирівнювання в клітинці 

на власний розсуд. В правій клітинці у вигляді списку складіть головне меню 

Вашої сторінки (наприклад, "Коротка біографія", "Інформація про науково-

методичну діяльність", "Список опублікованих робіт"). 

           5 Висновки: В процесі виконання лабораторної роботи студент 

повинен навчитися створювати табличну структуру сайту  

 

 



6 Контрольні питання: 

6.1 Що визначає тег <tr>? 
6.2 Що задаєт атрибут cellpading? 

6.3 Що визначає наступна конструкція? 

<td bgcolor="#00ff00">Содержимое</td> 

6.4 Яка буде відстань між рамками чарунок у таблиці, якщо вона задана 

наступною конструкцією?  

<table cellpading="5" cellspacing="3"> 

6.5 Чи можна встановити ширину чарунки у відсотках, якщо ширина таблиці 

вказана в пікселях? 

6.6 Що відбудеться, якщо в таблицю розмістити зображення, що перевищує її 

розмір? 

6.7 Яке вертикальне вирівнювання за замовчуванням задається чарунці 

таблиці? 
6.8 Що означає прапорець No Wrap у палітрі властивостей? 
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3 Джозеф В.Ловери. Dreamweaver MX. Библия пользователя: пер. с англ./ 

Джозеф В.Ловери. М: Издательский дом «Вильямс», 2003. 1296 c.: ил. 

4 Лебедев С.В. Web-дизайн: учебное пособие для создания публикаций для 

Интернет / С.В. Лебедев. М.: Издательский дом «Альянс- пресс», 2004. 736 с. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Інструкція до виконання лабораторної роботи №41 

 

Тема: Робота с фреймами у Dreamweaver 

 

1 Мета роботи: Знайомство з  фреймовим дизайном сторінки.  

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Редактор Macromedia Dreamweaver 

2.4 Мультимедійний проектор 

 

3 Теоретичні відомості: 
Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Фреймова структура Web-сайту» 

 

4 Хід роботи: 

1. Знайомство з  frameset - сторінкою 

1. Створіть нову папку, в якій будуть розміщені файли сайту, створені за 

допомогою фреймової технології. Дайте їй ім’я Frame-site. 

2. У дану папку скопіюйте файли context.htm, author.htm, 2.gif 

3. Запустите програму Блокнот і напишіть наступний html-код: 

 

<html> 

< head> 

< title>Сторінка з фреймами</title> 

< /head> 

< frameset rows=‖*,25%‖> 

< frame src=‖context.htm‖> 

< frame src=‖author.htm‖> 

< /frameset> 

< /html> 

 

4. Виберіть пункти Файл> Сохранить. В діалоговому вікні виберіть папку 

Frame-site, а в полі Тип файлу виберіть Усі файли. 

5. У полі Ім'я файлу введіть frameset.htm і натисніть ОК. 

6. Завантажте дану сторінку в браузер. 

 

2. Створення  фреймової структури в DW 

1. Завантажте програму Macromedia Dreamweaver MX. 

2. В головному меню програм виберіть пункти Site> New Site. 

3. У діалоговому вікні виберіть вкладку Advanced. 

4. В полі Назва сайту напишіть назву сайту, яка буде ідентифікувати сайт у 

програмі Dreamweaver, наприклад, Site-Frame. 



5. В полі  Локальна коренева папка потрібно вказати папку на вашому 

жорсткому диску, в якій будуть розміщені файли нашого майбутнього сайту 

в технології фреймів. Для цього клацніть на значку папки праворуч від поля і 

у діалоговому вікні, яке з’явилося,  виберіть папку Frame-Site. 

6. Інші всі поля та категорії залиште без змін і натисніть кнопку ОК. 

7. Створіть нову сторінку з переліком всіх питань теорії (інформація взяти з 

файлу index.doc) і зберегти її під іменем oglav.htm. 

8. В панелі об’єктів виберіть вкладку Рамки. 

9. Активізуйте палітру Рамки. Для цього виберіть «Вікно»> «Інші»> 

«Фрейми». 

10. У панелі об’єктів (Insert) виділіть наступну фреймову структуру. 

11. У палітрі Frames виберіть лівий фрейм. 

12. У поле src палітри властивостей виберіть файл oglav.htm. 

13. У палітрі Frames виберіть правий фрейм. 

14. У поле src палітри властивостей виберіть файл teor1.htm. 

15. У вікні документа поставте курсор у верхній фрейм. 

16. Додайте у верхній фрейм таблиці (2 стовпця, 1 рядок, ширина = 100%). 

Якщо не пам’ятаєте, як вставити таблицю, зверніться до лаб. роботи  

"Таблиці") 

17. В першу вкладку таблиці додайте зображення логотипу з файлу wd.gif. 

18. У другу чарунку  напишіть «Web-дизайн: дистанційний курс». 

19. Розміри чарунок таблиці і верхнього фрейму підібрати на свій смак. 

20. Збережемо файл верхнього фрейму. Виберіть пункт Файл> Зберегти кадр 

як .... 

21. Введіть ім’я файлу top.htm. 

22. Виберіть будь-який фрейм в палітрі Рамки. 

23. Виберіть пункти меню: Файл> Зберегти набір фреймів як ... 

24. Введіть назву файла index.htm 

25. В лівому фреймі виберіть посилання на перший пункт теорії. 

26. У списку target виберіть mainFrame. 

27. В лівому фреймі виділіть посилання на другий пункт теорії. 

28. У списку target виберіть mainFrame. 

29. Виконайте аналогічні дії для всіх пунктів теорії. 

30. Перегляньте результат в браузері. Перед переглядом DW попереджає вас, 

що збереже внесені в окремих фреймах зміни. 

 

  

Самостійна робота студента 

Розробити фреймову структуру сайту. Створіть аналогічний сайт , але у 

фреймовій структурі. 

 

 

5 Висновки: В процесі виконання лабораторної роботи студент повинен 

навчитися створювати фреймову структуру сайту  



 

 

6 Контрольні питання: 

6.1 Скільки файлів необхідно для створення фреймової структури, 
яка складається з 2 фреймів? 
6.2 Чим Frameset-сторінка відрізняється від звичайної html-
сторінки? 
6.3 Чи можливо використовувати вкладені фрейми? 
6.4 Чи скасовують поля фрейму значення поля для сторінки, 
відображеної в фреймі? 
6.5 Де буде завантажуватися сторінка, якщо атрибут Target = "_ 
blank"? 
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Інструкція до виконання лабораторної роботи №42 

 

Тема: Робота з графічними зображеннями в Adobe Dreamweaver 

 

1 Мета роботи: Знайомство з  робою з графічними зображеннями в Adobe 

Dreamweaver.  

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Редактор Macromedia Dreamweaver 

2.4 Мультимедійний проектор 

 

3 Теоретичні відомості: 
Для виконання даної лабораторної роботи студентам необхідно ознайомитися з 

теоретичним матеріалом за темою «Робота з графічними зображеннями в Adobe 

Dreamweaver» 

 

4 Хід роботи: 

Оптимізація зображень 

1) Запустіть програму Adobe ImageReady 7. 

2) Відкрийте файл logo.jpeg з папки Лаб №6. 

3) Дане зображення містить в собі логотип навчального центру. Нам потрібно 

прибрати фон і ефект тіні. 

4) Виберіть інструмент Magic Wand Tool (Чарівна паличка). У палітрі властивостей 

цього інструмента (вона розташована прямо під головним меню програми) зніміть 

прапорець Contiguous. 

5) Клацніть покажчиком миші в будь-якому місці на зображенні логотипу, в 

результаті логотип повинен виділитися пунктирною лінією. 

6) Над зображенням логотипу натисніть праву кнопку миші. 

7) З контекстного меню виберіть пункт Select Inverse для інвертування області 

виділення. В результаті повинна виділитися вся область зображення, крім 

логотипу. 

8) Натисніть Delete, в результаті область навколо логотипу повинна зникнути і на її 

місці з'явиться картатий фон. 

9) Натисніть комбінацію клавіш CTRL + D, щоб зняти виділення. 

10) Відкрийте палітру Optimize (Window> Optimize). 

11) Оптимізація формату Gif 

1. У вікні зображення перейдіть на вкладку Optimized. 

2. У нижній частині вікна зображення ви побачите напис 8,076К / 4с. Цей напис 

означає, що розмір зображення дорівнює 8 КБ і час завантаження зображення 

становить 4 с. 

3. У палітрі Optimize в списку Optimized File Format виберіть формат Gif. Зверніть 

увагу, що розмір файлу істотно зменшився. 

4. У полі Colors зменшуйте кількість квітів. Це дозволить суттєво зменшити розмір 

файлу зображення. Зупиніться на значенні: 3. 



12) Виконаємо обрізку зображення, щоб видалити порожні простору близько 

логотипу. 

13) 5. Виберіть пункти головного меню Image> Trim. 

14) 6. У діалоговому вікні встановіть перемикач Based On (грунтуватися на) в 

положення Transparent Pixels (Прозорі пікселі). Натисніть ОК. 

15) Таким чином, розмір файлу зображення вийшов близько 1 Кб. 

16) 7. Збережемо дане зображення. Виберіть пункти меню File> Save Optimized As 

... 

17) 8. У діалоговому вікні збереження файлу виберіть папку вашого сайту і введіть 

ім'я файлу logo.gif. У спадному спіскеТіп файлу повинна стояти Image Only (Тільки 

зображення). 

Оптимізація формату Jpeg 

1) У програмі ImageReady відкрийте файл foto.jpeg з папки Лаб №6. Розмір даного 

файлу приблизно 150 Кб. Спробуємо його уменьшіть.Сначала оптимізуємо розмір 

зображення. 

2) Виберіть пункти меню Image> Image Size. 

3) Переконайтеся, що прапорець Constrain Proportions обраний. 

4) У полі Width поставте значення 300. У поле Height значення змінитися 

пропорціально. Натисніть кнопку ОК. 

5) Двічі клацніть на інструменті Zoom Tool, щоб встановити масштаб зображення 

рівним 100%. 

6) Перейдіть на вкладку Optimized та оцініть розмір зображення. Розмір файлу став 

приблизно 20 Кб. 

7) У палітрі Optimize в списку Optimized File Format встановіть JPEG. 

8) У палітрі Optimized переміщайте повзунок Quality вліво, зменшуючи якість 

зображення і тим самим збільшуючи ступінь стиснення. Встановіть повзунок на 

значенні 50. 

9) Розмір файлу став дорівнює приблизно 15 Кб, що цілком годиться для 

зображення такого розміру. 

10) Збережемо дане зображення. Виберіть пункти меню File> Save Optimized As ... 

11) У діалоговому вікні збереження файлу виберіть папку вашого сайту і введіть 

ім'я файлу foto.jpg. У списку Тип файлу повинна стояти Image Only (Тільки 

зображення). 

 

Вставка зображення на Web-сторінку 

1) Запустіть програму Dreamweaver MX 

2) Відкрийте файл avtor.htm. 

3) Підставте курсор в те місце сторінки, де б ви хотіли розмістити фотографію. 

4) У панелі об'єктів клацніть на піктограмі Image. 

5) У діалоговому вікні виберіть файл зображення: foto.jpg 

6) Натисніть кнопку OK. Фотографія повинна з'явитися на сторінці. 

7) 4. В панелі об'єктів клацніть на піктограмі Rollover Image (або виберіть пункти 

головного меню Insert> Interactive Images> Rollover Image) 

8) 5. У діалоговому вікні в полі Original Image за допомогою кнопки Browse 

виберіть файл нормального стану кнопки (button-up.gif). 

9) В полі Rollover image виберіть файл (button-over.gif) для стану при наведенні на 

кнопку покажчика. 

10) У поле Alternate Text вкажіть текст підказки для кнопки, наприклад, «підказка». 



11) У поле When Clicked, Go To URL виберіть сторінку, на яку буде відбуватися 

перехід при натисканні на даній кнопці. Наприклад, kursy.htm. 

12) Випробуйте роботу кнопки в браузері, попередньо зберігши сторінку. 

Підготовка GIF-анімації 

1) Запустіть програму Adobe ImageReady 7. 

2) Відкрийте файл logo.gif (оптимізоване зображення логотипу) 

3) Відкрийте палітру Animation (Window> Animation) 

4) У палітрі поки тільки один кадр анімації. Створіть ще два кадри, клацнувши два 

рази по кнопці Dublicate Current Frame. 

5) Активізуйте палітру Layers (Window> Layers). 

6) У палітрі Animation виділіть перший кадр і в палітрі Layers встановіть для нього 

бігунок Opacity в нульове значення. Тим самим ви робите шар абсолютно 

прозорим. 

7) Для другого кадру анімації в палітрі Layers встановіть Opacity в 100%, для 

третього кадру анімації значення Opacity вже буде 0%. 

8) Виділіть перший кадр анімації і клацніть на кнопці Tweens Animation Frames. 

9) У діалоговому вікні вкажіть наступні параметри: Tween with: Next Frame; Frames 

to Add: 5; Layers: All Layers; Parameters: Opacity. Натисніть кнопку OK. 

10) Виділіть 7 кадр і клацніть на кнопці Tweens Animation Frames. 

11) У діалоговому вікні вкажіть ті ж параметри, що ідля першого кадру: Tween 

with: Next Frame; Frames to Add: 5; Layers: All Layers; Parameters: Opacity. 

Натисніть кнопку OK. 

12) Натисніть кнопку Play / Stop Animation, щоб переглянути анімацію. 

13) У списку в лівому нижньому кутку палітри Animation виберіть кількість 

повторень анімаційної послідовності. Значення Onceпроігривает анімацію тільки 

один раз. 

14) Збережіть даний файл: File> Save Optimized As ... Дайте файлу ім'я logo-

anim.gif. 

Дане анімоване зображення ви можете використовувати на своїх Web-сторінках. 

 

САМОСТІЙНА РОБОТА СТУДЕНТА 

1) Оптимізуйте фотографію для розміщення на Web-сторінці (файл XXX.jpeg з 

папки Лаб №6.). Ширина зображення повинна бути дорівнює 300 пікселям. 

2) Створіть кнопки-ролловеров: "Практика", "Зроби сам", "Задати питання", "Тест", 

"Про автора". Додайте кнопки на сторінці menu.htm 

3) Створіть анімаційний Gif для зображення логотипу. Придумайте будь 

анімаційний ефект. 

4) Знайдіть визначення наступних термінів: дозвіл, колірна модель, Web-безпечна 

палітра. 

5) Вставте в файл avtor.htm свою фотографію. Змінюючи властивості зображення, 

добийтеся більш ефектного представлення Вашої фотографії (або іншого малюнка) 

в файлі. 

 

5 Висновки: В процесі виконання лабораторної роботи студент повинен 

навчитися працювати з зображеннями  

 



 

6 Контрольні питання: 

6.1 Який формат слід вибрати для подання фотознімку, що містить тисячі 

квітів, і розміщення його на сторінці? 

6.2 За рахунок чого відбувається стиснення в форматі JPEG? 

6.3 Яким інструментом проводять обрізку зображення в програмі Adobe 

ImageReady? 

6.4 Скільки квітів підтримує формат GIF? 

6.5 За рахунок чого можна зменшити розмір Gif-анімаційного зображення? 
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Інструкція до виконання лабораторної роботи №43 

 

Тема: Розробка веб-сайту у Adobe Dreamweaver 

 

1 Мета роботи: Використовуючи отримані навички роботи з редактором 

Adobe Dreamweaver  створити власний сайт. 

 

2 Матеріально-технічне та навчально-методичне забезпечення:  

2.1 Інструкція до виконання роботи 

2.2 Персональний комп'ютер, підключений до мережі Інтернет 

2.3 Редактор Macromedia Dreamweaver 

2.4 Мультимедійний проектор 

 

3 Теоретичні відомості: 

Для виконання даної лабораторної роботи студентам необхідно 

ознайомитися з теоретичним матеріалом за темою «Основи веб-майстерності. 

Створення сайтів за допомогою програми візуального редагування web-

сторінок Adobe DreamWeaver.» 
 

4 Хід роботи: 

1. Розробити фізичну і логічну структуру сайту відповідно до тематики (не 

менше 7 сторінок). Тематика вибирається згідно варіантам, представленим 

нижче в таблиці. Остання цифра номера залікової книжки є номером 

варіанту. При розробці фізичної структури сайту використовувати типову 

структуру. Тексти і зображення за варіантами розташовуються в папці clipart 

Dreamweaver. 

 

Варіанти завдань до лабораторної роботи 

№ Тематика 

1 Діловий сайт підприємства 

2 Сайт ЧПЕК 

3 Програма Photoshop для Web-дизайнера 

4 Сторінка міста 

5 Спортивний клуб 

6 Сайт оператора сотового зв’язку 

7 Сайт туристичного агентства 

8 Сайт дизайнера інтер’єру 

9 Сайт музею авіації 

 

2. Зареєструвати сайт в Dreamweaver MX. В параметрах врахувати, що сайт 

буде розташовуватися локально в папці C: / sites / variant <N>, де N - номер 

варіанту.  



3. Створити в Dreamweaver MX шаблон для сторінок сайту. У шаблоні 

потрібно помістити логотип і кнопки графічної навігації.  

 

5 Висновки: В процесі виконання лабораторної роботи студент повинен 

створити власний сайт  

 

 

6 Контрольні питання: 

6.1 Який формат слід вибрати для подання фотознімку, що містить тисячі 

квітів, і розміщення його на сторінці? 

6.2 За рахунок чого відбувається стиснення в форматі JPEG? 

6.3 Яким інструментом проводять обрізку зображення в програмі Adobe 

ImageReady? 

6.4 Скільки квітів підтримує формат GIF? 

6.5 За рахунок чого можна зменшити розмір Gif-анімаційного зображення? 

6.6  Записуючи на HTML абзац, Ви між двома словами поставили п'ять 

прогалин. Скільки прогалин Ви побачите в браузері? 
6.7 Як пов’язати гіперпосилання з текстовим фрагментом? 
6.8 Як вставити відеооб’єкт на веб-сторінку? Що може бути джерелом 
відео?  
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